Guide to Tracktion T7
The Only Book on the Tracktion T7 DAW!

Bill Edstrom

This book is for sale at http://leanpub.com/guide_to_tracktion_t7

This version was published on 2016-11-06

This is a Leanpub book. Leanpub empowers authors and publishers with the Lean Publishing process. Lean Publishing is the act of publishing an in-progress ebook using lightweight tools and many iterations to get reader feedback, pivot until you have the right book and build traction once you do.

© 2015 - 2016 Bill Edstrom
## CONTENTS

Moving On ................................................................. 15

### Chapter 4 - Audio Device Setup .................................. 16
   Audio Device Setup Setup on Mac ................................ 16
   Audio Device Setup in Windows ................................. 18
   Choosing the Audio Interface ................................. 19
   Setting the Sample Rate ..................................... 20
   Testing for Audio Playback .................................. 20
   About Latency ......................................................... 21
   Managing Latency .................................................. 22
   Calibrating Input Latency Compensation .................. 23
   Other Audio Device Settings ................................ 25
   Resetting to the Defaults ..................................... 27
   Moving On ............................................................ 27

### Chapter 5 - Basic Navigation .................................... 28
   Tabs and Menus ....................................................... 28
   Pop-up Help ........................................................... 29
   Roll-over Help ....................................................... 30
   Creating a Project ................................................ 30
   Opening the Edit .................................................. 31
   The Edit Tab ........................................................ 32
   Basic Navigation ................................................... 32
   Zooming In and Out ............................................. 33
   Positioning the Cursor ......................................... 33
   Changing the Tempo ............................................. 34
   Changing Tempo at a Specific Bar ......................... 35
   Offsetting and Scaling the Tempo Curve .................... 36
   Moving On ............................................................ 37

### Chapter 6 - The Settings Tab ................................... 38
   Audio Devices Page .............................................. 39
   MIDI Devices Page ............................................... 39
   Plugins Page ........................................................ 39
   General Behaviour Page ...................................... 39
   Other Settings ......................................................... 41
   Keyboard Shortcuts Page ....................................... 42
   Loop Database Page ............................................. 42
   Control Surfaces Page .......................................... 42
   Marketplace ........................................................ 42
   Moving On ............................................................ 43

### Chapter 7 - Getting Help ......................................... 44
   Pop-up Help ........................................................... 44
### CONTENTS

Roll-over Help ................................................................. 44
Quick Start Guide .............................................................. 44
Keyboard Shortcut List ....................................................... 44
Tracktion Videos ............................................................... 45
Tracktion Forums .............................................................. 46
Tracktion Support .............................................................. 46
Moving On .......................................................... 48

**Chapter 8 - The Edit Tab** ..................................................... 49

The Parts of a Tracktion Edit ................................................. 49
The Browser ................................................................. 50
The Arrangement ............................................................. 52
Timeline ................................................................. 53
The Track Section ............................................................ 56
Clips ................................................................. 57
The Mixer ................................................................. 59
The Controls Panel .......................................................... 60
The Menu Section ........................................................... 61
Properties Section ........................................................... 62
Master Section ............................................................... 62
Master Section Buttons ..................................................... 64
Moving On ................................................................. 65

**Chapter 9 - The Browser** ..................................................... 66

Browser Files Tab .......................................................... 66
Browser Presets Tab .......................................................... 68
Using Presets ................................................................. 70
Applying Presets ............................................................. 71
Tracks Tab ................................................................. 72
Search Tab ................................................................. 74
Notifications Tab .............................................................. 76
Markers Tab ................................................................. 77
Clipboard Tab ................................................................. 77
Moving On ................................................................. 78

**Chapter 10 - Using Markers** .................................................. 79

In-marker & Out-marker ..................................................... 80
Navigate Using the In-marker & Out-marker ................................ 81
Zooming to the In-marker/Out-marker .................................. 81
Looping Playback Over the Marked Region ................................ 81
Auto Punch and the Marked Region ....................................... 81
The Marker Track ............................................................. 82
Adding Markers ............................................................... 83
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker Clip Properties</td>
<td>84</td>
</tr>
<tr>
<td>Navigating by Markers</td>
<td>86</td>
</tr>
<tr>
<td>The Browser Markers Tab</td>
<td>86</td>
</tr>
<tr>
<td>Renumbering Markers</td>
<td>88</td>
</tr>
<tr>
<td>Adjust Markers (Wave File Markers)</td>
<td>88</td>
</tr>
<tr>
<td>Moving On</td>
<td>89</td>
</tr>
<tr>
<td>Chapter 11 - Selecting and Snapping</td>
<td>90</td>
</tr>
<tr>
<td>Selecting a Clip</td>
<td>90</td>
</tr>
<tr>
<td>Auditioning a Clip</td>
<td>90</td>
</tr>
<tr>
<td>Selecting Multiple Clips</td>
<td>91</td>
</tr>
<tr>
<td>Shift Selecting Clips</td>
<td>92</td>
</tr>
<tr>
<td>Deselecting Clips</td>
<td>92</td>
</tr>
<tr>
<td>Using Snap-to-Grid</td>
<td>92</td>
</tr>
<tr>
<td>Enable/Disable Snap-to-Grid</td>
<td>92</td>
</tr>
<tr>
<td>About Snap Resolution</td>
<td>93</td>
</tr>
<tr>
<td>Snapping Clips to the Grid</td>
<td>93</td>
</tr>
<tr>
<td>Snapping the Cursor to the Grid</td>
<td>94</td>
</tr>
<tr>
<td>Snapping Clips to Other Clips</td>
<td>94</td>
</tr>
<tr>
<td>Overriding Snap-to-Grid</td>
<td>95</td>
</tr>
<tr>
<td>Nudging Clips</td>
<td>95</td>
</tr>
<tr>
<td>Nudging Notes</td>
<td>95</td>
</tr>
<tr>
<td>Moving On</td>
<td>96</td>
</tr>
<tr>
<td>Chapter 12 - Audio Clips and Editing Audio</td>
<td>97</td>
</tr>
<tr>
<td>Parts of an Audio Clip</td>
<td>97</td>
</tr>
<tr>
<td>Moving Clips</td>
<td>99</td>
</tr>
<tr>
<td>Deleting Clips</td>
<td>100</td>
</tr>
<tr>
<td>Audio Clip Handles</td>
<td>100</td>
</tr>
<tr>
<td>Splitting a Clip</td>
<td>102</td>
</tr>
<tr>
<td>Duplicating Clips</td>
<td>102</td>
</tr>
<tr>
<td>Fade-in/Fade-out</td>
<td>103</td>
</tr>
<tr>
<td>Pitch Fade</td>
<td>104</td>
</tr>
<tr>
<td>Crossfades</td>
<td>104</td>
</tr>
<tr>
<td>Drag Crossfade</td>
<td>105</td>
</tr>
<tr>
<td>Edge Fades</td>
<td>105</td>
</tr>
<tr>
<td>Copy and Paste</td>
<td>106</td>
</tr>
<tr>
<td>Clip Gain, Mute, &amp; Pan</td>
<td>106</td>
</tr>
<tr>
<td>Reversing Audio Clips</td>
<td>107</td>
</tr>
<tr>
<td>Merging Clips to One Clip</td>
<td>107</td>
</tr>
<tr>
<td>Deleting a Section of Audio Removing Space</td>
<td>108</td>
</tr>
<tr>
<td>Edit with Melodyne</td>
<td>109</td>
</tr>
<tr>
<td>Moving On</td>
<td>111</td>
</tr>
</tbody>
</table>
CONTENTS

Chapter 13 - Working With Loops ................................................. 112
  Getting Loops Into Tracktion .............................................. 112
  Setting the Edit Tempo ...................................................... 112
  Dragging Loops to a Track .................................................. 113
  Dragging in Multiple Clips from the Browser ......................... 113
  Looping the Loop ............................................................ 113
  Duplicating Clips ............................................................. 114
  Loop Properties ............................................................... 115
  Moving On ...................................................................... 117

Chapter 14 - Keyboard Shortcuts ................................................. 118
  Keyboard Shortcuts Page ..................................................... 118
  Setting a Keyboard Shortcut ............................................... 119
  Changing a Keyboard Shortcut .......................................... 120
  Saving Keyboard Shortcuts to a File .................................... 120
  Loading Keyboard Shortcuts from a File ............................... 121
  Printing a List of Keyboard Shortcuts ................................. 121
  Moving On ..................................................................... 122

Chapter 15 - Recording Audio ..................................................... 123
  Configure the Input ......................................................... 123
  The Input Object ............................................................. 123
  Customizing Input Names Globally ...................................... 125
  Customizing Input Names for an Edit ................................ 125
  About MIDI Inputs .......................................................... 126
  Setting Up Inputs for Multi-track Recording ......................... 126
  Number of Inputs ............................................................ 126
  Enable a Track for Recording .......................................... 127
  Hit Record ........................................................................ 127
  Enable Recording for All Inputs at Once ............................. 128
  Input Meters .................................................................... 128
  Dragging the Input Object Track to Track ............................ 129
  Renaming a Track ............................................................. 129
  Recording Steps in Review ................................................ 129
  Working with the Click ...................................................... 130
  Enabling the Click Track ................................................... 130
  Listening on Headphones While Recording ......................... 133
  Live Input Monitoring ........................................................ 134
  If at First You Don’t Succeed .............................................. 135
  Abort Record and Delete the Take ...................................... 135
  Recording a Stereo Signal ................................................. 136
  Retrospective Record ......................................................... 136
  Safe-Record Mode ............................................................. 137
CONTENTS

Moving On .................................................. 138

Chapter 16 - Recording Overdubs ........................................... 139
  Set up the Drum Loop ........................................... 139
  Get Ready to Record ........................................... 140
  Record the Rhythm Guitar Part ..................................... 140
  Doubling the Rhythm Guitar ....................................... 141
  Overdub a Bassline ............................................... 142
  Rename Tracks .................................................. 143
  Adding Additional Tracks ......................................... 144
  Rearranging Tracks .............................................. 144
  Adjust the Mix .................................................. 145
  Moving on ................................................... 145

Chapter 17 - Clean-up Editing .............................................. 146
  Trimming ..................................................... 146
  Correcting Small Timing Problems .................................. 147
  Correcting Timing by Slip Editing .................................. 149
  Fade-outs ..................................................... 151
  Stretch an Ending Note .......................................... 152
  Fixing Clicks at the Edit Points ................................... 152
  Rendering to a Single Audio Clip ................................... 153
  Moving On ................................................... 154

Chapter 18 - Warp Time .................................................... 155
  Warp Time Mode ............................................... 155
  The Warp Time Editor .......................................... 156
  Working with Warp Points ....................................... 157
  Warp Points and Snapping ....................................... 158
  Limitations of Warp Time editing ................................ 158
  Time Stretch Algorithm ........................................ 158
  Moving On ................................................... 159

Chapter 19 - Loop Recording ............................................... 160
  Getting into Loop Recording Mode ................................ 160
  Loop Recording Step-by-Step ..................................... 160
  Selecting the Best Take .......................................... 161
  Unpacking Takes to Tracks ...................................... 162
  Moving on ................................................... 162

Chapter 20 - Comping ..................................................... 163
  Copy Your Edit ................................................ 163
  Comping Takes ............................................... 164
  Flatten Comp ................................................ 167
CONTENTS

Setting up a Comp Group ................................................. 168
Comping Tracks Using a Comp Group ................................. 169
Comp Group Editor ......................................................... 170
Moving On ......................................................................... 172

Chapter 21 - Using an Amp Simulator Plugin ......................... 173
Setting Up the Track ............................................................ 173
Recording with the Amp Sim ............................................... 178
Managing Latency ............................................................... 178
Speed of Sound Through Air .............................................. 179
Dialing in the Guitar Tone ................................................... 180
Using a Tuner Plugin .......................................................... 180
Moving On ......................................................................... 181

Chapter 22 - MIDI Setup ...................................................... 182
MIDI Drivers ..................................................................... 182
Set Up the MIDI Inputs ....................................................... 182
Naming MIDI Inputs/Outputs .............................................. 183
Disabling Unused MIDI Inputs ............................................ 183
Configuring the Track .......................................................... 183
Insert a Synth Plugin ........................................................... 184
Using a Virtual Keyboard .................................................... 185
Moving On ......................................................................... 187

Chapter 23 - MIDI Recording ................................................ 188
Setting up a Track ............................................................... 188
Recording a MIDI Performance ............................................ 188
Playing Back a MIDI Performance ....................................... 189
Piano Roll View ................................................................. 190
MIDI Record Modes - The Action Property .......................... 190
MIDI Input Quantize ............................................................ 192
Moving On ......................................................................... 192

Chapter 24 - MIDI Loop Recording ......................................... 193
Loop Recording in Merge Mode ............................................ 193
Recording to Prepare for MIDI Comping .............................. 194
Comping MIDI Takes .......................................................... 195
Flattening the Composite to a Single Clip ............................ 196
Moving On ......................................................................... 197

Chapter 25 - MIDI Editing ..................................................... 198
Trimming MIDI Clips ........................................................... 198
Moving MIDI Clips .............................................................. 198
Moving a MIDI Clip Track-to-Track ..................................... 199
CONTENTS

Text Plugin ................................................................. 267
Saving Presets ......................................................... 268
Moving On ............................................................... 268

Chapter 31 - Effects Bus Tracks ................................. 269
Create the Bus Track ................................................. 269
Adding the Effect Plugin ............................................. 269
Aux Return Plugin ..................................................... 270
Adding Aux Sends to the Channels ............................... 271
Adjusting the Send Level ............................................ 272
Assigning the Aux Bus ............................................... 272
Solo Isolate .............................................................. 273
Effects Bus Track Presets .......................................... 274
Moving On ............................................................. 275

Chapter 32 - Clip Effects ............................................. 276
Inserting Plugins on Clips ........................................... 276
Removing Clip Plugins .............................................. 276
Creative Uses .......................................................... 277
Echo Throw Example .................................................. 277
Moving On ............................................................. 277

Chapter 33 – Folder Tracks .......................................... 278
Creating a Folder Track ............................................... 278
Working with Folder Tracks ......................................... 278
The Folder Track VCA .................................................. 280
Editing With Folder Tracks .......................................... 282
Automating a Fade within a Folder Track ....................... 283
Moving On ............................................................. 284

Chapter 34 - Submix Tracks ......................................... 285
Creating a Submix Track .............................................. 285
Working with Submix Tracks ....................................... 286
Creating an Old School Submix Track ............................ 287
Moving On ............................................................. 288

Chapter 35 - Automation ............................................. 289
Activating Automation on a Track ............................... 289
Choosing What to Automate ........................................ 290
Adding Points to the Automation Curve ........................ 291
Automating Fade-ins and Fade-outs .............................. 292
Converting a Clip Fade-in or Fade-out to Automation ......... 292
Reading Automation .................................................... 293
Automation Curve Properties ...................................... 293
## CONTENTS

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Find Out What Automation is Active for a Track</td>
<td>295</td>
</tr>
<tr>
<td>Remap on Tempo Change</td>
<td>296</td>
</tr>
<tr>
<td>Writing Automation on the Fly</td>
<td>297</td>
</tr>
<tr>
<td>Automation Lock</td>
<td>298</td>
</tr>
<tr>
<td>Moving On</td>
<td>299</td>
</tr>
<tr>
<td><strong>Chapter 36 - Mixing Down</strong></td>
<td>300</td>
</tr>
<tr>
<td>Master Section Processing</td>
<td>300</td>
</tr>
<tr>
<td>Exporting to a WAV File</td>
<td>301</td>
</tr>
<tr>
<td>Locating the Exported File</td>
<td>302</td>
</tr>
<tr>
<td>Exporting to an MP3 File</td>
<td>303</td>
</tr>
<tr>
<td>Additional Render Properties</td>
<td>305</td>
</tr>
<tr>
<td>Moving On</td>
<td>308</td>
</tr>
<tr>
<td><strong>Chapter 37 - Macros</strong></td>
<td>309</td>
</tr>
<tr>
<td>Script Editor</td>
<td>309</td>
</tr>
<tr>
<td>Creating a Macro</td>
<td>309</td>
</tr>
<tr>
<td>Deleting a Macro</td>
<td>310</td>
</tr>
<tr>
<td>Programming a Macro</td>
<td>310</td>
</tr>
<tr>
<td>Running a Macro</td>
<td>311</td>
</tr>
<tr>
<td>Javascript Programming</td>
<td>312</td>
</tr>
<tr>
<td>Hover Tooltip</td>
<td>313</td>
</tr>
<tr>
<td>RTZ Macro Example</td>
<td>314</td>
</tr>
<tr>
<td>Merge Clips Macro Example</td>
<td>314</td>
</tr>
<tr>
<td>Importing and Exporting Macros</td>
<td>314</td>
</tr>
<tr>
<td>TSC Code Samples</td>
<td>314</td>
</tr>
<tr>
<td>My Code Samples</td>
<td>316</td>
</tr>
<tr>
<td>Moving On</td>
<td>317</td>
</tr>
<tr>
<td><strong>Chapter 38 - New in Tracktion T7</strong></td>
<td>318</td>
</tr>
<tr>
<td>New Interface Look</td>
<td>318</td>
</tr>
<tr>
<td>Compact Toolbar</td>
<td>320</td>
</tr>
<tr>
<td>Working with Properties in Compact Mode</td>
<td>321</td>
</tr>
<tr>
<td>Keyboard Shortcut to Toggle the Toolbar</td>
<td>321</td>
</tr>
<tr>
<td>Browser Position</td>
<td>322</td>
</tr>
<tr>
<td>Multiple Browser Panes</td>
<td>323</td>
</tr>
<tr>
<td>Synchronized Previews</td>
<td>324</td>
</tr>
<tr>
<td>Zoom Tool</td>
<td>326</td>
</tr>
<tr>
<td>Project Tab - Three Column View</td>
<td>327</td>
</tr>
<tr>
<td>Project Tab - Edit Previews</td>
<td>328</td>
</tr>
<tr>
<td>Project Tab - Get Demo Songs</td>
<td>330</td>
</tr>
<tr>
<td>Drag to Set In-marker &amp; Out-marker</td>
<td>330</td>
</tr>
<tr>
<td>Auto Show Panels</td>
<td>330</td>
</tr>
</tbody>
</table>
## Visual Plugin Selector
- Using the Visual Plugin Selector ........................................ 349
- Determining Plugin Technology ........................................ 349
- Customizing the Thumbnail Image .................................... 351
- Scanning to Capture Thumbnails .................................... 352
- Opening Visual Plugin Selector with a Shortcut .................. 353
- Moving On ....................................................................... 353

## Track LFOs
- Inserting a Track LFO ..................................................... 355
- Track LFO Properties .................................................... 355
- Other Properties ......................................................... 357
- Removing LFO Assignments .......................................... 358
- Video Tutorial .................................................................. 359
- Moving On ....................................................................... 359

## Clip Layer Effects
- Volume - Volume ........................................................... 360
- Volume - Fade ............................................................... 364
- Volume - Step ............................................................... 365
- Time/Pitch - Pitch Shift ............................................... 365
- Time/Pitch - Tape Stop/Start (Pitch Fade) ....................... 366
- Time/Pitch - Warp Time ............................................... 367
- Effects - Plugin Layer .................................................. 368
- Effects - Reverse Clip Layer ......................................... 369
- Mastering - Normalise Layer ....................................... 369
- Mastering - Mono Layer .................................................. 370
- Mastering - Phase Invert Layer .................................... 370
- Moving On ....................................................................... 371
CONTENTS

Appendix A - Video Links ............................................. 372
  Creating a Tempo Map ............................................. 373
  Punch In/Out on the fly ........................................... 373
  Tracktion Compressor Sidechain ................................. 373
  Track Tags .......................................................... 373
  Automation Improvements ......................................... 373
  Insert Plugin ........................................................ 373
  Creating a Submix ................................................. 373
  Basic Audio Editing ............................................... 373
  Warp Time .......................................................... 373
  Pitch Fade .......................................................... 373
  Comp Groups ...................................................... 373
  Merge Selected Clips ............................................. 373
  Step Clips Overview ............................................... 373
  Step Clips Velocity/Gate ......................................... 373
  Step Clips Randomize Each Step ................................ 373
  Step Clips Groove ................................................. 373
  Step Clips Route Channels to Different Synths ............... 373
  Drag to Set the In-marker and Out-marker ..................... 373
  Track LFOs Demonstration ........................................ 373
  Sync Preview with Multiple Browsers ............................ 373
  How to Invoke Melodyne .......................................... 373
  Automation Patterns and Ramps .................................. 373

Appendix B - Interview with Tracktion Creator Julian Storer ........ 374
Thank You!

Here is a big “Thank You!” to all who purchased the first edition of this book. Without the support, this book would not have been possible. I also appreciate the huge number of readers that purchased the book at retail price even though you could have paid the minimum. Tracktioneers are passionate about this software and the music they create with it. That passion keeps me motivated even when there are other demands for my time and attention.

Thank you to Woody, Dave, Dave, and Julian at TSC for being incredibly open and supportive. Huge thanks to Dave Rowland at TSC for answering my technical questions, responding to bug reports, and constantly working to make Tracktion better and better.
About This Book

Tracktion DAW Second Edition

This book is the second edition and geared toward Tracktion T7. If you are using T6 much of this content will still be relevant but you might be better served by the first edition of the book “Guide to Tracktion T6.”

While this book contains new content and images, many of the images and most of the text are carried over from the T6 book. Since the UI look has been updated for T7 there will be a slightly different appearance between your screen and some of the images in the book. Where necessary I have revised the older images.

DON’T PRINT WARNING!

The initial launch of any version of Tracktion is always just a starting point. During the first half of every year there are frequent revisions and additions. I suggest you don’t immediately print a hardcopy because you will just be frustrated when the next revision comes out the following day.

Note: Unless you absolutely must read from hardcopy, I don’t recommend printing this book.

This Book is Self Published

I wrote this book with no monetary advance from any publisher or manufacturer. The income needed to support this book comes entirely from the small amount I make from each sale.

Fundamentally, if you copy the files around, give them away, or post them online, you not only violate the copyright of the book, you jeopardize the ongoing development of the book. Also, you will only have access to the latest version of the book if you buy it. When new updates are released you will get notification and download links - only if you are a registered purchaser of the book.

About Lean Publishing

This book is published with the innovative Lean publishing methodology. Modern software is developed using an Agile methodology. With Agile small increments of features are developed in specific time period, tested and released. The result is quickly changing and evolving features.
With traditional book publishing, the book is developed, edited, copy edited, carefully proofread before being transferred to a fixed layout. That layout then goes into a queue for printing. Once in print, it is fixed and unchangeable until the next edition. This means the book is usually outdated before it is ever released for sale. As new features are added, the book gets further and further behind.

Lean publishing focuses on delivering the book much more quickly to readers so they can use the information. To do that, several steps of traditional publishing are condensed. This allows the author to get the book to interested readers even before it is complete or completely copy edited.

That brings me to the important point. This book is neither fully complete nor perfect. If you find errors, typos, or incomplete descriptions let me know. The beauty of the system is that you get the information quickly. The downside is that, much like the software it explains, it is an on-going work in process. I can make corrections and compile a new version of the book very quickly and make it available for download.

A Few Words About Tracktion

I was interested in Tracktion from the earliest versions even though I never used it as my main DAW. I thought it was really interesting because it didn’t try to look or act like hardware. Its left to right signal flow, racks, and one screen interface just seemed like a refreshing change. On the other hand, Tracktion has always been a bit quirky. The layout, features, and terminology are not always consistent. However, Tracktion has gained really interesting features that are unique and creative.

Tracktion has a legacy. It grew from Julian Storer’s initial product but then changed hands to Mackie. Mackie initially added enhancements like an effects suite but then halted further development. Tracktion lay in a dormant state with no development for years. It continued to be bundled with mixers, but users, myself included, thought it was dead. With no communication to the contrary, most moved on to other DAWs.

But Tracktion came back to life when Julian and a few partners re-acquired the rights to Tracktion and put it back on the market. They updated the code to support modern computers and released it as Tracktion 4. A year later, Tracktion 5 brought along numerous enhancements like Melodyne ARA and Step Clips.

But Tracktion needed more than a few new features. It needed and continues to need refactoring of the existing codebase to bring it up to modern standards. This work continues not just for major releases but in frequent iterative releases.

With that in mind, Tracktion T7 is a mix of new creative features along with under-the-hood refactoring. T7 builds on the significant work done to make T6 viable and competitive. The most obvious change is a new completely reworked look, color palette, and fonts. I said the same thing last year about T6 but now T7 gets the baton - T7 is by far the best version of Tracktion ever released.

Today, there are many choices for DAW software and most of them are really good. Why would you choose Tracktion? It takes a specific user that feels drawn to Tracktion’s unique way of doing things.
Some observers state that Tracktion is an easy-to-use beginners DAW. While it’s not hard to use, it can also be deep and technical. Further, Tracktion is not fully documented. This book documents how Tracktion works. Even so, there are big features of Tracktion that I just didn’t have time or space to cover. This is my fourth DAW book and I have learned that it is impossible to fully cover a DAW in a single volume.

I see the beauty in the Tracktion DAW. I have enjoyed helping to bring it back, attract new users, and do what I can to help improve it. The team at TSC have been very supportive of this effort. I’ve had numerous conversations with Woody via Skype about the vision for Tracktion. While writing the book, I logged dozens of bug reports to the Tracktion bug tracker which Dave Rowland quickly processed. Dave also made numerous changes to the wording of T6 features for consistency with the book explanations and even added my custom keyboard mapping to the software.

Back in January 2015 when I was just a few chapters into the T6 book, I met up with Woody, Dave, Julian and others from TSC out in Anaheim during the NAMM show. We had some great conversation about T6, audio hardware, instruments, code, music - along with a pint or two! They are a great group of smart, creative, if not slightly unconventional thinkers. Thanks guys for the inspiration and encouragement!
Chapter 1 - Introduction

Welcome to *Guide to Tracktion T7*. The goal of this book is to help you learn T7. If you are coming to T7 from another DAW or learning computer recording from the ground up, you will find this guide useful. This book will be particularly interesting to those who already have experience with the Tracktion DAW. Tracktion T7 has dozens of new and innovative features. This latest version streamlines the workflow while making the software more powerful than ever.

T7 runs on both Mac and PC including 64-bit versions of OS X and Windows. T7 is also one of the top mainstream DAWs that runs on Linux. All versions are maintained in parallel so the latest revision is almost identical across platforms.

T7 like its predecessors is unique in that it has a one screen user interface with a mixer channel integrated to the right of each track. There is no separate console view so you never need to flip back and forth between a track view and mixer view. This concept was pioneered with T1 more than a decade ago and seems modern even today.

T7 has a very flexible plugin architecture that includes native plugins, plugin racks, and third party plugins supporting VST, VST3 and AU.

**What's New in Tracktion T7**

Tracktion T7 has many new and exciting features. They both enhance the workflow and open up new creative potential. These changes have or will be incorporated into this new edition of the book. For a more in-depth look at the new features, jump to Chapter 38 - New in Tracktion T7.

- New UI Style and Color Schemes
- Clip Layer Effects
- Track LFOs
- New Compact Transport Bar
- Visual Plugin Selector
- Quick Zoom
- Easy Sidechaining for Plugins
- Grouped Clips
- Linked Clips
- Three Column Projects Tab
- Right-side Browser Option
- Automation Patterns
• Plugin Racks Side Panels
• Automatically Hide Panels
• First Run Tasks
• Automatic Edit Preview Rendering
• Integration with CloudBounce Mastering

What’s in the Book?

In this book you will learn:

• How to install and set up T7
• How to record audio to tracks
• How to record MIDI and use virtual instruments
• How to record with guitar amp simulators
• How to edit audio
• How to edit MIDI
• How to mix with the inline mixer section
• How to insert and use plugin effects
• How to mix down to Wave or MP3 files

Tip: I encourage you to go to the Tracktion website¹ and make sure that your installation of T7 is fully up-to-date.

Also, check out the Book Extras. You will find a keyboard shortcut cheat-sheet that you can print and reference.

What’s Not Covered in this Book?

Tracktion T7 is often promoted as an easy to use DAW. That tends to be true once you get the hang of it. But the more you learn, the more you realize how deep the feature set really is. I never really intended to write a manual for Tracktion. However, for lack of a manual, this book serves that function for many Tracktioners. To be honest up front, I have this list of things not covered in the book. This list might not be comprehensive, but these are the big ones:

• In depth coverage about Plugin Racks
• Using multi-output Synths

¹www.tracktion.com
• Control Surface Mapping
• Tracktion Sampler
• Video integration
• Melodyne ARA
• Project Templates
• Tracktion Archive format
• CPU Usage Meter

Many of the above topics are addressed in the videos at Groove3.com, on the Tracktion website, or my YouTube channel\(^2\). If this book is successful, some of these topics might make it to a future edition or a follow-up book on advanced topics. Remember to subscribe to my YouTube channel so you know when new Tracktion content is added.

I don’t attempt to cover fundamentals of recording like mic selection, recording technique, or the broad topics of mixing and mastering. There are plenty of other resources for that. This book is focused on how to operate Tracktion T7.

**Tracktion Videos**

I have also produced video series covering all the majority of new features in T7 that has been published by Groove3.com titled Tracktion T7 Update Explained\(^3\). The video series is 1 hour and 15 minutes of live walkthroughs of the new features covered in Chapters 38 through 41 of this book.

In conjunction with the first edition of this book, I produced a series of free videos that detailed new features in Tracktion T6. You can find those on my website BillEdstrom.com\(^4\).

I also produced a full Tracktion video tutorial video series - Tracktion 5 Explained\(^5\). Many of these videos are available for free on the Tracktion videos page\(^6\).

The full series is available for purchase and download at Groove 3, Inc\(^7\).

For in-depth coverage of the plugin racks feature, check out Tracktion Plugin Racks Explained\(^8\) also from Groove 3.

While the Groove 3 videos were produced for Tracktion T5, you will find the core workflows are still relevant. This book along with the videos mentioned above are your best companion as you learn Tracktion T7.

\(^2\)http://goo.gl/YnaOMd
\(^3\)https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained
\(^4\)http://billedstrom.com/tracktion-software
\(^5\)http://goo.gl/GKbdIM
\(^6\)http://www.tracktion.com/support/videos
\(^7\)http://goo.gl/GKbdIM
\(^8\)http://goo.gl/w6ffyW
Setting Tracktion Keyboard Shortcuts

This book uses an alternative keyboard shortcut layout that you will need to turn on to follow the examples. To do that follow these steps:

1. Navigate to the Settings tab, Keyboard Shortcuts page
2. Click *Reset to Defaults* at the bottom of the page
3. Select *Use alternative Tracktion key-mappings*
Settings Tab: Set the Keyboard Shortcuts to Match this Book

This set of keyboard shortcuts was carefully designed for efficient workflow and keeps the commands consistent between Mac and Windows. You may download printable keyboard templates and cheatsheet PDFs for the alternative key-mapping from the Leanpub store where you purchased this book.
Is Tracktion the Software or the Company?

Tracktion Software Corporation (TSC) is “Tracktion.” The DAW Software that Tracktion has published are T4, T5, T6, and T7. So, the proper way to refer to the DAW software is either “T7” or “Tracktion T7.”

While I am aware of that, I still tend to call the software “Tracktion.” You will find a mix of T7, Tracktion T7, and Tracktion used in this book. In any of those cases I am referring to the Tracktion DAW software.

Modifier Keys Conventions

The book uses the following abbreviations for modifier keys:

- Command - Cmd
- Control - Ctrl
- Option - Opt
- Alt - Alt

In most cases Cmd on Mac will translate to Ctrl on Windows. For the book, I present both using the convention Mac / PC like this: Cmd + C / Ctrl + C.

Here is another example:

Click to select the clip then copy it using Cmd + C / Ctrl + C. Next, position the cursor in the Arrangement where you want to place the copy and paste it using Cmd + V / Ctrl + V.

Note: Most Linux users will use the ‘Meta’ key in place of Alt. On a typical PC keyboard, Meta is usually the Windows key.

Assigning the Duplicate Command to the Keyboard

The Duplicate action is not mapped to the keyboard by default. To match the book examples, assign the ‘D’ key to duplicate. Here is how to do that:

1. Navigate to Settings tab, Keyboard shortcuts page
2. Locate the Duplicate command. It’s in the Editing Functions section
3. To the right of Duplicate, press the plus (+) icon
4. The New key-mapping dialog box appears
5. Press D key, then click OK

![Mapping Duplicate to the D Key]

**Moving On**

With those things set, your T7 installation will match the examples in this book. Get ready to learn all about Tracktion T7!
Chapter 2 - Installing Tracktion T7

Most likely, you already installed T7. If you haven’t yet or have any questions about installation, keep reading.

Your Tracktion Account

Go to www.tracktion.com⁹. Navigate to Account > My Account. If you haven’t yet purchased Tracktion, you can choose to download the demo or purchase a license. If you received a version of Tracktion when you purchased a mixer or audio interface, then you can upgrade at a nice discount. Regardless, create an account on the Tracktion site if you haven’t already done so.

Customer Login at Tracktion.com

After you log in, you will see your Tracktion licenses listed there. Click on My Downloadable Products and choose the version you want to install.

⁹https://marketplace.tracktion.com
Should I Install 32-bit or 64-bit?

On the Tracktion site, navigate to Account > Downloads. That opens a set of tabs where you can choose which version to download - 32-bit or 64-bit.

The sound quality is the same between the 32-bit and 64-bit versions of T7. The decision is about compatibility with your computer and plugins.

Tracktion T7 32-bit:

- Runs on either 32-bit or 64-bit operating systems
- Runs only 32-bit plugins
- Can access up to 4 GB of RAM

Tracktion T7 64-bit:

- Runs on ONLY 64-bit operating systems
- Runs only 64-bit plugins
- Can access more than 4 GB of RAM

The key point here is this. If you want to run older 32-bit plugins use the 32-bit installation of T7. If your computer has more than 4GB of RAM, then running the 64-bit version allows you to load more instances of large virtual instruments. For the examples in the book, I am running the 64-bit version.
Warning: If you use the 64-bit version, T7 will not recognize your 32-bit plugins. If you rely on 32-bit plugins, then stick with the 32-bit version of Tracktion.

Click on correct link to download the installer. This happens fast because the installer is only a bit over 10 MB which is pretty amazing!

The installation varies slightly between Mac and Windows so I will walk through both.

**Mac OS X Installation**

The installation file on Mac has a .dmg file extension. This is typical of most Mac installers. Double-click the file to open the disk image. You will see the T7 app right there.

Drag T7 to the applications folder which is conveniently aliased right next to it. That’s it, Tracktion T7 is installed. You still need to unlock it and we will get to that shortly.

**Windows Installation**

The installation file on Windows has a .exe file extension. This is typical of most Windows installers. Double-click the file to start the installation wizard. Step through the wizard to tell Tracktion where you want it to be installed. In most cases the defaults will work best. In flash it’s done.

**Linux Installation**

To date, I haven’t run T7 under Linux personally. The great thing is that current Linux builds are available and reportedly work very well.

There is a separate Linux section on the Accounts > Download page on the Tracktion website. There you will find the latest 64-bit build in the form of a Debian package (.deb). If you are running Ubuntu, you can just download the file and double click and install the package.

Note: If you are experienced with Linux and would like me to add more here, send me a note!

For more about running T7 on Linux, the best source I have found is the Tracktion Linux FAQ on KVR.

¹⁰http://goo.gl/XUNiwA
Running Tracktion for the First Time

To launch T7 on Mac, locate Tracktion in the applications folder and double click the icon. Another way is to type of few letters of of the word ‘Tracktion’ into Spotlight and select it from the search results.

In Windows, find T7 in the Start Menu. In either case, launch it and T7 will start up. The T7 window initially has two tabs - Projects and Settings. Later your songs, called ‘Edits’ in Tracktion, will load into additional tabs.

Tracktion T7 initially runs in demo mode. If you have a license it is quick and easy to unlock it:

1. Select the Help > About menu item at the lower left of the Projects tab. This loads the About box. You will see all kinds of information about T7.
2. Locate and click the Unlock button.
3. Enter the address and password you used when registering at the Tracktion website and click Register.

Tracktion T7 is now unlocked and ready to use on this computer.

Pop-up Help

As you start exploring T7, you will soon notice pop-up help. Pop-up help balloons appear as you move the mouse pointer over objects on the window. While somewhat helpful, these messages are also pretty annoying. I suggest turning pop-up help off. To do that, click Help > Turn off pop-up help. The help button is located in the lower left corner of the Projects tab. You can easily reverse that if you want pop-up help back.

Tip: If you ever want to see pop-up help with it disabled, point to the thing you’re interested in and hit F1.
Note: At the time of writing, the pop-up help messages had not been updated for a while. They might be incomplete or inaccurate.

Installing Melodyne Essential

Melodyne Essential is a terrific bonus for T7 users. It adds powerful pitch and time manipulation to T7 at no addition cost. Melodyne Essential is a separate installation and is provided under license from Celemony. Here are the basic steps to install and active it.

- Exit T7 if it is running
- Go to the Tracktion website and log in (Account > My Account)
- On your Account Page copy or make note of the Celemony - Melodyne Essential license code listed there (Account > MyAccount)
- Go to the Celemony website then click login. Log in or create a new account.
- Follow the website instruction to register Melodyne Essential, download it, and install it.

Tip: Make sure to install Melodyne using its installer defaults. Tracktion T7 is integrated with the ARA technology of Melodyne and should detected it on the next restart.

Note: T7 also works with the full Melodyne Editor. If you already have that on your system, just check to make sure it is the latest version.

Note: Melodyne is not available for Linux or the Linux version of T7.

For more information on getting Melodyne Essential up and running check out TSC’s Melodyne Configuration Tips & Tricks page.

Moving On

At some point you will want to scan your existing plugins and loop library. You can learn how to do that in Chapter 22 if you want to work ahead. However, that’s not necessary quite yet. Let’s move on to installing the demo Projects.

¹¹http://www.celemony.com
¹²http://goo.gl/1dntgM
¹³http://goo.gl/gvUY3X
Chapter 3 - Installing the Demo Projects

This chapter simply walks through the process of installing the Tracktion demo songs. The demos are cool because they give you something to experiment with as you learn the basics.

Establish a Tracktion Projects Folder

It’s a good idea decide where you want to keep your Tracktion projects on your system. I keep mine together on a separate external drive I use for music projects. I store all my Tracktion projects in a folder named ‘Tracktion.’ This makes it easy to find my projects and easy to back up.

It is also reasonable to create your Tracktion folder under the Documents folder on your system. So, decide on a location and create your Tracktion folder using Finder (Mac) or File Explorer (PC).

Project Tab - Get Demo Songs

The Menu at the lower left of the Project tab includes a button - Get Demo Songs. Click that for a quick way to download the demos.
Select the songs to download from the list, choose the destination folder then click *Download*. I suggest using your newly created Tracktion project folder as the destination. You also have the option to show only new songs meaning those you haven’t yet downloaded.

Demo song downloading will be handled in the background. You can use the Progress Meter in the upper right corner to see how the downloads are progressing.

When the downloads are finished, the demo songs will appear at the bottom of your Active Projects.

**Tip:** I like to reorganize the demos into a folder to keep them separate from my own projects.
Moving On

With Tracktion installed and a few demo files ready to play with, it’s time to move on to configuring your audio interface. That’s up next.
Chapter 4 - Audio Device Setup

To use Tracktion, it is essential to configure it to work with your audio interface. While Tracktion does work with internal audio, most users will use an external audio interface. Tracktion supports Core Audio on Mac. Tracktion supports ASIO and Windows Sound (WASAPI) on PCs.

Audio Device Page

**Warning:** To configure Tracktion for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup. The procedure to do this is covered in this chapter.

This chapter covers the essential steps to get your audio interface configured as an audio device in Tracktion. The steps are simple and important so you can hear playback.

**Audio Device Setup Setup on Mac**

Here is how this works in OS X.

1. Click on the Settings tab then select the Audio Devices page.
2. Select an output Device. Assuming you have necessary drivers installed and the device hooked up, it should appear as an option for the Output: property.

![Mac - Audio Device Output and Input Properties]

**Note:** With OS X, USB audio interfaces that follow USB Audio Class 1 (1998) or USB Audio Class 2 (2009) will function without installing any additional driver. In the product specs for such devices they often list “class compliant.”

1. Select an Input device

**Tip:** I strongly suggest that you select the same device for the output and the input. In this example I’m using a USB iTwo which is a simple 2 in / 2 out interface.

**Note:** On OS X, you can select the input device and output device separately.

![Audio Device Test Button on Mac]

**Test Button**
There is a convenient Test button next to the audio device parameter. Click it, to send a short test tone to the output. If you hear the tone you are pretty much good to go at this point.
Audio Device Setup in Windows

This is a walkthrough of the audio device settings for Windows. If you haven’t already, navigate to Settings tab > Audio Devices page.

Audio Device Type

Tracktion gives Windows users four choices for audio device type.

- Windows Audio
- Windows Audio (Exclusive)
- DirectSound
- ASIO

![Windows Audio Device Types]

So which to choose? Any of them might work with your computer but there are definite differences and best choices here.

ASIO

This is the best choice if you are using an external audio interface. You will need to install the manufacturer’s driver. The good news is will usually give you the best low latency performance for recording and playback. Many modern audio interfaces include a mixer app to control low latency mixing within the unit. When using ASIO, you just choose the device and it is set for both inputs and outputs.

Windows Audio

Use this if running Windows Vista/7/9/10 on your computer and using the internal sound on your machine. Great for using a laptop directly while traveling. This device type uses WASAPI (Windows Audio Session API) which offers nicely optimized access from applications software to audio I/O. Windows Audio will also function with USB Audio Class 1 interfaces.

Windows Audio (Exclusive Mode)

This is the same as Windows Audio but Tracktion will not allow any other application to use the audio interface while running. For the lowest latency and most critical applications choose this when using your internal sound.
Note: As of this writing, no version of Windows supports USB Audio Class 2 devices natively - not even Windows 10. This applies to most USB2 or USB3 interfaces. They might function okay because they usually default back to USB Audio Class 1. For best performance, install the manufacturer’s drivers and use ASIO if possible.

DirectSound

Choose this when using Windows XP with your internal sound. This is not a good choice for Windows Vista/7/8/10. For Windows 8 and 10, it is deprecated and might not work at all.

Tip: If you aren’t on Windows XP don’t use the DirectSound device type.

Choosing the Audio Interface

With the audio device type set, you can choose any audio interface connected to your computer or the internal sound. Select your device if it’s not already shown for the Device: property.
Control Panel

On some but not all audio interfaces, clicking the Control panel button will open the manufacturer’s driver control panel to set the buffer size. Many audio interfaces don’t allow you to set the buffer size or the sample rate through host software. If that is the case, locate the control panel software on your system, and open it. Set the Sample Rate and Audio buffer size there. In some cases, you will need to restart Tracktion for the change to take effect.

Setting the Sample Rate

The default for the sample rate is 44100 Hz which matches the sample rate for CDs. I would suggest choosing that unless you have a reason to choose a different sample rate.

Testing for Audio Playback

It is a good idea to test playback to make sure you get sound and a full stereo image. Here is one way to do that:
1. Go back to the Projects tab and select one of the demo tunes - Subways is a good choice.
2. Locate the Edit on the right (SubWays T4) and double-click to open it.
3. Click *Play* (spacebar) and you should hear music!

### About Latency

The process of mixing your tracks together, calculating digital effects, and triggering instrument samples takes time in any DAW. It is impossible for digital mixing to happen instantly. The amount
of time your computer needs to compute, process, mix and playback from input to output is called ‘latency.’ Latency is the amount of time you allow the computer think and is normally measured in milliseconds - from just a few to several hundred milliseconds.

During playback, latency is detected only as a delay between hitting play and hearing playback. This results in a barely detectible lag in the transport functions and doesn’t cause much trouble.

Latency during overdubbing is more of an issue. If you are hearing playback of existing tracks a bit late, then what you are recording is not going line up correctly because your timing reference is shifted - late or early. Even a few milliseconds will effect feel. At 30 or 60 milliseconds, the timing will seem off. This can have an impact on the feel of the recording or even make it the timing seem completely off.

For these reasons, DAWs have latency compensation. Following recording, the audio tracks are essentially shifted to compensate for latency in the A/D process, mixing, and plugin DSP processing.

**Managing Latency**

*Audio buffer size* by default is 512 samples (11.6 ms) on OS X and 256 samples (5.8 ms) on Windows. On modern Mac computers, you can usually run with the buffer size set to 256 as well.

![Note:](image)

*Note:* The choice of buffer size options available varies. It depends on what audio interface, connection type, and driver technology.

Let’s consider a latency of 11 ms. In reality, 11 ms is a very short period of time. In the real world if you are playing a MIDI controller into a virtual instrument, there will be an 11 ms lag between when you play a note and when you hear the note. It’s the same thing if you’re working with a virtual guitar amp or amp simulator. When you play a note the guitar you hear the sound 11 ms later. Sound travels through air at the rate of approximately one foot (0.34 meters) per millisecond. So this latency is like playing with your guitar amp or keyboard monitor 11 feet (3.4 meters) away. There is a delay but you might get by. At 6 ms delay, usually the delay is barely noticeable.

With computer recording, we alway aim to strike a balance between noticeable latency and getting clean playback. Why not just lower it all the way down? Because, the computer needs time to ‘think’ and produce the sounds and process effects. If we get too aggressive with lowering the buffer, the computer starts to complain in the form of pops, clicks, dropouts, and the like. So during recording you might keep this lower, during editing and mixing you can increase it.

![Tip:](image)

*Tip:* Try 256 samples when you get started. While your songs are simple, this should work fine on most modern systems. If you feel there is to much delay when playing virtual instruments, try even lower. If the audio starts to break up, try higher settings.
Note: When using Melodyne Essential for editing audio, you will need to increase the buffer size to at least 1024 samples to prevent getting a warning message and to have clean playback.

**Calibrating Input Latency Compensation**

If you use Tracktion for any overdubbing, **this is possibly the most important lesson in this book**. **Tracktion requires you to run Auto-Detect** using a loopback connection on your audio interface.

⚠️ **Warning:** This test sets up a deliberate feedback loop. Switch your speakers off during this test. You will be connecting an output to an input using a patch cord so be careful.

Here are the steps:

1. Turn off your monitor speakers!
2. Make sure any input monitoring knobs, buttons, or mixers are off or turned down.
3. Connect one output back to one of the inputs. To make it simple, connect the left output to input one.
4. Turn the gain up about halfway on the input.
5. In Tracktion go to Settings > Audio Devices.
6. In the Channels list click on one of the Inputs

![Channels:](image)

Select an Input

1. In the Properties section click *Auto-Detect*. 
1. Click **Run Test**. Tracktion will send a short test signal from the output to the input. It will calculate the delay between output and input.

1. Click **Apply** and Tracktion will copy the delay value to the Time Adjust property.
Applying the Auto-Detect Result to *Time Adjust*

For recordings to be aligned during overdubs, you must repeat this every time you make a change to the *Sample rate* or *Audio buffer size*. If you don’t, your recordings will be several milliseconds out of alignment with existing tracks.

**Tip:** You can keep a note of the *Time Adjust* values at different settings and enter it manually for the settings you commonly use.

**Warning:** To configure Tracktion for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in alignment with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup.

**Other Audio Device Settings**

We just covered the essential things to get going. There are more settings here that you might be curious about. To be complete, here is an explanation of each!

**CPU Cores to Use**

This can be set from one to the number available. Usually you leave this at the maximum cores...
available. The maximum is typically the number of hardware cores in your CPU times two. For example, if you run a four-core processor, the maximum cores will be reported as eight. If you are running some other software alongside Tracktion that needs more CPU power, then you can reduce this number to make Tracktion leave some cores open for other tasks CPU. Cases where this is necessary are rare except when debugging specific problems.

**Use 64-bit Maths When mixing Tracks**
I normally leave this on. If you have a nice fast computer you can leave that on. It gives you a little bit more headroom in the mix engine. You probably won’t notice much difference if it’s on or off. If you have a very old computer with limited CPU, leave it off. By default it’s off; I usually leave 64-bit maths turned on.

**Only Show Enabled Devices**
The Channels list on the Audio Devices page includes a check mark next to each input and output. Click that check mark and it turns to a red ‘X.’ This disables that hardware and after that Tracktion will no longer present it an option in other menus. Well, this setting Only Show Enabled Devices will hide disabled inputs or outputs when turned on. I usually leave it off.

**Max Monitoring Latency**
This is the maximum allowed latency when in low latency monitoring mode. If latency exceeds this, Tracktion will shut off some plugins. I suggest you leave this at the default 5 ms and don’t worry about it. It has no effect unless you engage low latency mode.

**Low Latency Buffer Size**
This is the alternative buffer size to use when in low latency mode. Leave this at the default and don’t worry about. It also has no effect unless you engage low latency mode.

Tip: If you are curious about low latency mode, click the ‘i’ next to the Max Monitoring Latency or Low Latency Buffer Size parameter. You enable low latency mode from the CPU usage window which is opened by clicking on the icon in the upper right corner of the Tracktion window header.

![CPU Usage Meter Icon](image)

**Internal Buffer Multiplier**
Another setting related to low latency mode. Usually just leave this set at 1X and forget it.
Resetting to the Defaults

If you are playing around with the values on this page and you just don’t know how they should be set, click Reset Audio Settings.

![Reset Audio Settings Dialog Box]

Leave the page at the defaults and press OK. This resets the page to the factory settings.

If you tick Reset input devices option, all the settings for input devices will get reset. Those include Input gain, Trigger level, Time adjust, and recording options.

If you tick Reset output devices then the output options are reset. Output options include Treat as stereo pair, Dithering Enabled, Left/Right Reversed and Alias parameters.

Moving On

Audio device setup is straightforward apart from running the Auto-Detect loopback test. Even so, you don’t need to fully understand everything on the Audio Devices page. Follow the guidelines in this chapter and you will be ready to move on!
Chapter 5 - Basic Navigation

This chapter is an overview of how to operate Tracktion. You will also learn how to set up Tracktion for an efficient workflow and how to change the tempo of your song.

Tabs and Menus

With Tracktion open, you can see the Projects tab and the Settings tab. Click on the tab name or icon to switch to that tab. Switch back and forth between those two tabs by clicking the tab you want or pressing F4.

Projects Tab & Settings Tab

Notice that there are no menus along top like other Mac and Windows programs. Menus are located at left side of the Controls panel in Menu section. The Menus are different depending on if you on the Projects tab or an Edit tab.

Menu Section in the Projects Tab
Chapter 5 - Basic Navigation

The only useful thing you will find in the normal menu location is the command to close Tracktion.

**Pop-up Help**

Pop-up help is helpful for the first few minutes, but gets old really fast. If you are using the alternative Tracktion key-mappings, you can see available pop-up help by pointing at an item on screen and pressing F1.

Disable pop-up help from the Menu section using *Help > Turn off pop-up help.*
Roll-over Help

In addition to pop-up help, there is roll-over help. Rollover help messages appear in the upper right for controls and objects. The messages appear automatically as you over over items on the screen.

![Example of Rollover Help](image)

Note: At the time of writing, I found both pop-up help and rollover help to be out of date with current terminologies and features.

Tip: If you find any help messages wrong or unclear, send a message and screenshot to support@tracktion.com.

Creating a Project

The very first step to produce a song in Tracktion is to create a project. Here is how:

1. Go to the Projects tab
2. Click New Project and the New Project dialog box appears
3. Fill in the Name
4. Select the Location
5. Click Create Project
The New Project Dialog Box

After clicking Create Project you see the contents of the project in a list to the right with the title All items in project: projectname. For now the most important entry in the “All Items” list follows the word “edit” - that file called an Edit. In our example, the Edit name is “SummerSong100 Edit 1.”

All Items List

N> Note: Creating a project creates a folder containing folders to hold the project media, a Project file (.tracktion) and an Edit file (songname. tractionedit). The folder, Project, and Edit all use the name you provided in the New Project dialog box.

Opening the Edit

An Edit is the workspace in Tracktion where you record, edit, and mix your songs. Double-click the Edit in the All Items list and it opens to a new tab. This type of tab carries the name of the Edit and
Edits and Revision Control: In Tracktion you can have as many Edits per Project as you want. This gives you a great system for revision control. At key milestones in your workflow, go back to the Project tab click Create a Copy. This copies the Edit to a new file. Rename the copy appropriately and resume work using the new Edit. You can return to the previous state of the Project at any point by opening an earlier Edit.

The Edit Tab

The Edit tab is where most of the action occurs while working in Tracktion. What other DAWs call a “project” or “song” Tracktion calls an Edit. In a way this is similar to the terminology used in many video editing programs. You have a collection of media that you organize into an Edit. In concept you can organize the same media into other Edits. In music production, having multiple edits gives you revision control and flexibility to have multiple mixes all contained within the project.

Basic Navigation

What you need to know to navigate an Edit:

Start and Stop Playback

The obvious way to play and stop is to use the Play/Stop button located on the transport in the Master Section. Alternatively, press Spacebar to toggle between start and stop.

Tip: By default the cursor will jump back to the start position when you stop playback. If you don’t like that and would like the cursor to stay at the stop position, there is a setting for that in the menu Options > Return cursor to start position when play stops. Turn that off, and the cursor won’t jump back on stop. Instead it will pause right at the point you hit stop.
**Zooming In and Out**

Here are some basic ways to control zooming:

- Use the Up and Down keys to zoom in and out
- Use the zoom controls in the lower right corner
- On the timeline just above the cursor, grab and drag up or down

As of T7 you can use the quick zoom feature:

- Hold Shift + Opt / Shift + Alt and drag to select an area. The pointer changes to a magnifying glass. When you release, the view zooms in to your selection.
- To step back from that zoom level, once again hold Shift + Opt / Shift + Alt and click in the arrangement.
- T7 remembers the zoom levels so you can zoom in repeatedly. Then, press Shift + Opt / Shift + Alt click to zoom back out.

Tip: Quick zoom can really speed things up. Give it a try!

**Positioning the Cursor**

The cursor position is used as the playback start time and is also used to reference many of Tracktion’s editing functions. In other DAWs it is called a playhead, now time, or playback cursor. In Tracktion, I simply call it the ‘cursor.’

There are numerous ways to position the cursor. Here are the main ones:

- On the timeline just above the cursor, grab and drag it left or right
- Opt-click / Alt-click the timeline and the cursor will jump to that spot
- Click in the background of the track area
- Use the left and right arrow keys to move the cursor backward and forward
Tip: You can change the way clicking on the Timeline works by selecting Options > Timeline drag action > Drag to position transport. With this set, when you click in the timeline, the cursor jumps to that position. If you drag in the timeline the cursor follows as well.

Note: In this mode, to drag zoom, you need to hold down Opt / Alt. Since you can still zoom in and out with the mouse wheel or the up and down arrow keys, this mode is fast becoming my favorite way to get around in Tracktion.

Changing the Tempo

Tempo in Tracktion is managed using the Tempo track at the top of the screen. You can hide or show the Tempo track using the Tempo button at the upper right.

Show or Hide the Tempo Track with the Tempo Button

The Tempo is represented as a line in the Tempo track. This line is called the “Tempo Curve.” For a fixed tempo tune it will appear as a line set to a beats-per-minute (BPM) value.

Fixed BPM Tempo Curve

For tunes with tempo changes it might appear with step ups or step downs in tempo, or even gradual tempo changes represented as curves (thus the name Tempo Curve). In other software this is often called a “tempo map.”

Varying BPM Tempo Curve

To change the tempo of your Edit:

1. Click the tempo BMP readout in the Master section. The Properties section will show the Tempo properties
2. Adjust the BPM parameter to the desired tempo. Either click and type it in, or drag the slider.
3. Alternatively, open the tempo track and drag the tempo curve line up and down.

**Note:** Setting the tempo this way changes the tempo only for the segment of the tempo curve that is under the current cursor position.

**Video Clip:** To learn how to use the tempo track to map tempo changes to an existing recording, Check out my video on [Creating a Tempo Map](https://w-edstrom.wistia.com/medias/687engt5ar)

### Changing Tempo at a Specific Bar

To change the tempo at a specific bar, use the action *Insert tempo change at cursor* (Opt + T / Alt + T). Here are the steps:

---

1https://w-edstrom.wistia.com/medias/687engt5ar
1. Position the cursor where you want the tempo change to occur
2. Right-click on the timeline, and select Insert tempo change at cursor
3. In the Properties section, adjust the BPM parameter to the new tempo.
4. To see the results of the tempo change, open the tempo track to see the step up or down on the Tempo Curve

Note: The Tempo Curve can also be adjusted with more detail in the Tempo track in much the same way as automation. Click to add points (nodes) to the curve and drag them to shape your tempo changes along with an adjustable Curvature.

Removing Tempo Changes
   Click on any tempo point, to select it. In Properties, click Delete > Delete this tempo setting.

Removing all Tempo Changes
   Click on the Tempo curve line. In Properties, click Delete points from curve > Delete all points from the curve.

Offsetting and Scaling the Tempo Curve

Displace Curve and Scale Curve Controls
**Displace Tempo Curve**
Click anywhere on the Tempo Curve. In Properties, drag left or right over Displace Curve to move the entire tempo curve up or down.

**Scale Curve**
Select the Tempo Curve, then drag left or right over Scale Curve to reduce or emphasize the amount of tempo variation across the entire Edit.

**Moving On**
That was a basic introduction to the operation of Tracktion. You can now operate the transport; you can open the demo files; you can create a new blank project; and you can adjust the playback volume and tempo.

That is enough to start exploring Tracktion. Stay tuned, there is a lot more to come!
Chapter 6 - The Settings Tab

The Settings tab is organized into pages for configuring global preferences. Click one of the page headers along the left to select a page. The settings for that page appear on the right and a short description of the page appears in the lower left. In this chapter, you will learn what each page is about.

Tip: Here are two useful keyboard shortcuts: Press F2 to jump directly to the Setting tab. Press F3 to flip between Settings and your Edit.
Audio Devices Page

Use this page to select your audio device, configure inputs and outputs, and manage latency. Learn all about the Audio Devices page in Chapter 4.

Note: The Auto-Detect feature for inputs is also accessed from this page. This is essential to getting your overdubs to properly sync to existing tracks. Pay particular attention to that discussion in Chapter 4.

MIDI Devices Page

Use the MIDI Devices page to configure external MIDI keyboards, MIDI ports, or MIDI instruments to communicate with Tracktion. You can also configure your computer keyboard to act as a virtual MIDI keyboard from this page. The MIDI Devices page is covered in more detail in Chapter 22.

Plugins Page

While Tracktion includes some basic effects and virtual instruments, it also hosts third-party VST plugins in Windows and VST and AU plugins on Mac. To use third-party plugins you need first to tell scan for them.

To do that, click Scanning and Sorting then select from one of the plugin formats to scan. You need to repeat the scan for each of the plugin formats that you want to use. Read more about plugin scanning in Chapter 28.

General Behaviour Page

There are lots of settings and actions available on the General Behaviour page. These give you many ways to customize Tracktion to match your preferences and the types of projects you work on.
Here is a rundown of the essential settings on the General Behavior page:

**Username**
- Customize Tracktion with your name, band name, or studio. This gets saved with Project and Edits.

**Import/Export User Settings**
- Use *Export User Settings* to save most of the preferences on the Settings tab to a file. You can name this and save it anywhere on your system. The user settings file will always have a `.trksettings` file extension. You can restore settings by clicking *Import User Settings* and loading the file.
Tip: Many Tracktion settings can be saved to text files making it easy to restore them to another computer or just save them in case you need to reinstall the software. To keep exported settings organized and easy to back up, I create a set of folders under the main Tracktion folder to hold them.

Audio Clip Import
I suggest you set Audio Clip Import to Always copy file. When you import audio files into a Project, Tracktion can either reference the original file or copy the file to the Project folder. I suggest you set Tracktion to always copy imported files. This makes it far less likely the the audio will get separated from the project. It also makes it easier to back up your projects because all the media will be contained within the Project folder structure. The only reason to choose either option is if you have very limited drive space.

Auto-Detect Tempos
Auto-Detect Tempos determines if Tracktion will attempt to set the tempo of imported audio automatically. I usually set this to Always detect tempo. This aids when using time stretching and matching tempos of different loops. If you don’t plan to do any time stretching or tempo changes, then leave this set to Never detect tempo.

Track Resizing
When you double-click a track header (the track name) in T7 the vertical track height toggles to a larger size. You have three choices for how the resizing works. You pick the best choice using the property Track Resizing. I suggest trying each modes and choosing the one that works best for you. I usually leave it set to Double click toggles between small and medium height.

Rename Mode
I suggest you set Rename Mode to Only rename a source file if it is in the project folder. This option avoids renaming a file accidentally. Honestly, this setting won’t matter if you set Audio Clip Import as suggested above.

Other Settings
There are several other settings like Meter Response, Peak Hold, and Solo Behavior. We will cover those in context in later chapters.
Keyboard Shortcuts Page

The Keyboard Shortcuts page is used to configure keyboard shortcuts for dozens of actions. You can click the View as HTML button at the bottom to generate an HTML version of the keyboard shortcuts list. You can search it or print it as a reference. You can also learn a lot about what is possible with Tracktion by looking through shortcuts list and trying them out. Keyboard Shortcuts are covered in detail in Chapter 14.¹⁵

The Keyboard Shortcuts page also includes the Script Editor for creating macros. Macros and the Script Editor are covered in Chapter 37 (chapter-37).

Loop Database Page

This page is used if you want Traction 7 to index your existing loop file folders. To do that, enter the path to your loop libraries and select one of the scan options. Following the scan, the loops will appear in the search results on the Browser Search tab. Once indexed, you can assign tags to loops to organize them further.

Note: Having Traction index your loops is entirely optional. If you already have loops organized into folders, you can simply bookmark your loop folders in the Browser Files tab. The downside of indexing your loops is that you get a longer list of results when using the Browser Search tab. This can make it a bit harder to see relevant results when searching for plugins.

Control Surfaces Page

Use this page to setup external control surfaces. These are typically units that control the transport or provide knobs and faders that you can later assign to on-screen controls.

Marketplace

The Marketplace page allows you to set the destination paths for plugins so that anything you buy from the Tracktion Marketplace can be installed automatically after purchase. You can launch right into the Tracktion Marketplace shop by clicking Show Marketplace Account Settings.

¹⁵chapter-14
Marketplace loads right inside Tracktion assuming you have a working Internet connection. There you can buy Tracktion add-ons like Master Mix, BioTek, or the Micro Synth pack (FM Synth & Analog Synth) along with third-party plugins by various manufacturers.

**Moving On**

Now you should have a better understanding of the General Behaviours page of the Settings tab.
Chapter 7 - Getting Help

This chapter is a summary of the various ways to get help when working with Tracktion.

**Pop-up Help**

The first source of help is pop-up help. While useful at times, you will quickly find that it is both annoying and out of date. Turn off pop-up help with Options > Help > Turn off pop-up help. Press F1 to view pop-up help for the item under the pointer. Refer to Chapter 5¹⁶ for an illustrated guide to pop-up help.

**Roll-over Help**

Roll-over messages appear in the upper right for items under the pointer. These messages give you a description of the object under the mouse pointer.

**Quick Start Guide**

Starting with T7, Tracktion includes a Quick Start PDF file. Access this brief printable guide from the Help menu.

**Keyboard Shortcut List**

Studying the keyboard shortcut list, is a great way to get more familiar with Tracktion. Navigate to the Settings tab, Keyboard Shortcuts page. Here you will see all the assignable actions grouped by category.

¹⁶pop-up-help
For a searchable list click View as HTML to load the current list in your web browser. From here you can search it with Cmd + F / Ctrl + F or print it out.

### Tracktion Shortcut Keys

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Flip between edit/project screens</td>
<td>F3</td>
</tr>
<tr>
<td>Go to project screen</td>
<td></td>
</tr>
<tr>
<td>Go to edit screen</td>
<td></td>
</tr>
<tr>
<td>Go to settings screen</td>
<td>F2</td>
</tr>
<tr>
<td>Show colour-scheme editor window</td>
<td></td>
</tr>
<tr>
<td>Save the current edit</td>
<td>command + S</td>
</tr>
<tr>
<td>Save the current edit as</td>
<td>shift + command + S</td>
</tr>
<tr>
<td>Quit the application</td>
<td>command + Q</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Help Functions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Tracktion's help documentation</td>
<td></td>
</tr>
<tr>
<td>Enable/Disable the popup help</td>
<td></td>
</tr>
<tr>
<td>Show popup help for whatever the mouse is currently over</td>
<td>F1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transport Controls</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playing</td>
<td>spacebar</td>
</tr>
<tr>
<td>Start playing</td>
<td></td>
</tr>
</tbody>
</table>

HTML View of Keyboard Shortcuts Assignments

### Tracktion Videos

The Tracktion videos page[^17] has a nice selection of training videos. My series Tracktion T7 Update Explained is available from Groove 3, Inc[^18] along with other Tracktion videos. Groove 3 is a deep resource for all things music production.

Also checkout my YouTube channel[^19] for various free videos demonstrating Tracktion features.

The book you are reading “Guide to Tracktion” includes links to videos many of which are only available here. Check out [Appendix A][appendix-a] for a complete list of videos lined from within this book.

[^17]: http://www.tracktion.com/support/videos
[^18]: http://goo.gl/GKbdIM
[^19]: http://goo.gl/hywdxh
**Tracktion Forums**

The long term official forum for Tracktion Software is hosted at KVR. This is the most active Tracktion forum that exists. Here you can interact with the other users, TSC staff, and developers.

There is also a growing private Tracktion Users Group on FaceBook. If you use FaceBook it’s a great idea to request to be added to the group. I post updates as do other Tracktion users. The TSC team are also members of that group.

Also check out the Tracktion Software official Facebook page for updates, news about Tracktion, promo offers, and profiles of Tracktion artists - “Tracktioneers.”

**Tracktion Support**

In large part, your success with getting issues resolved, requesting features, and reporting bugs, depends on knowing the tricks when filling out the request form.

[Tracktion Request Form](https://tracktion.zendesk.com/hc/en-us/requests/new)

---

²⁰[http://goo.gl/YaygV6](http://goo.gl/YaygV6)
²¹kvraudio.com
²²[https://www.facebook.com/groups/Tracktion/](https://www.facebook.com/groups/Tracktion/)
²³[http://goo.gl/Hv3Xjr](http://goo.gl/Hv3Xjr)
Tracktion Request Form

Request Form Checklist:

- Use “FR:” in the title for feature request
- Use “BR:” Bug Report in the title for bug reports
- Include the Tracktion version number (from the Tracktion About box)
- Include your operating system and version
- Note your system specs like processor type and the amount of RAM
- List the steps to recreate the bug
- Attach the log file (*Help > Show the Tracktion log file*)
- Attach or link to screenshot or screen video
- Report one issue at a time
Follow these same guidelines when posting bugs and feature requests to the KVR Tracktion Software forum²⁵.

**Moving On**

Those are the key ways to get help when learning and using Tracktion. Next let’s get into more detail on using Tracktion!

²⁵http://goo.gl/YaygV6
Chapter 8 - The Edit Tab

In this chapter you will learn the layout of the Edit tab. The Edit tab is where most of the action occurs during recording, editing, and producing your song. This chapter is important because will learn the terminology for the Tracktion interface and objects used throughout the rest of this book.

**Note:** The keyboard shortcuts used in the chapter are based on the alternative key mappings under *Settings > Keyboard Shortcuts > Reset to Defaults > Use alternative Tracktion key-mappings*. I’ve already mentioned this several times and this might not be the last! If you want to follow along with the keyboard shortcuts used in this book, load the alternative key-mappings.

The Parts of a Tracktion Edit

The Edit tab is made up of four main parts - the Browser, the Arrangement, the Mixer, and the Controls panel.
The Browser

The Tracktion Browser resides along the left side of the Edit. You can open or close it by clicking its icon or by pressing B. The Browser includes a collection of tabs giving you quick access to media, plugins, messages, and markers.

Tip: Starting with T7, you can move the Browser to the top or right side of the Edit by dragging its icon to the appropriate edge of the screen.
Here is a short description of each Browser tab:

**Files**  
The Files tab gives you quick access to the audio files used in the project and the project folder structure. It also gives you quick access to common locations and drives on your system. Most important however is the ability to bookmark folders for quick access. Using bookmarks is the primary way I access my loops library. Audio files and loops can be easily auditioned from the Files tab as well.

**Presets**  
Plugin, instrument, rack, and track presets are all searchable from the Presets tab. The tag field at the top gives you a quick way to filter by tags. Drag any presets you find to the arrangement. Right-click to rename a preset or update the tags.

**Tracks**  
Use the Tracks tab to filter tracks in the arrangement by tag. First you need to tag them by selecting one or more tracks and setting tags in Properties.

**Search**  
The unified Search tab, allows you to search for loops, presets, or plugins in one interface. The tag field dynamically updates to show the relevant tags for filtering.

**Notifications**  
Use this for a history of Tracktion notifications. There are many notifications that happen related to Tracktion Marketplace purchases and plug-in installation. Clear individual notifications by clicking the ‘X’ on the message. You can jump right to the plugin referenced in the message by clicking the arrow icon. Press Clear All to clear the list of notifications.

**Markers**  
Use the Markers tab to add bars & beats or timecode markers to the Marker track. Navigate to
any marker by simply clicking on the marker name. You can also quickly delete the selected marker, change its name or marker type in Properties.

**Clipboard**

Use the Clipboard tab to see what is currently in the clipboard. Put selected items from an edit or project on the clipboard by pressing Cmd + C / Ctrl + C. Then, drag clipboard contents to the arrangement from the Browser Clipboard tab. The clipboard can contain clips, plugins, or racks. It is particularly useful when copying items out of other projects on the Projects tab.

For much more about the Browser check out *Chapter 9 - The Browser*.

Tip: Resize the Browser by dragging the right edge left or right. This is particularly helpful when working with the Search tab which has numerous search columns that might be hidden.

**The Arrangement**

The Arrangement is made up of the Timeline, Track Headers & Inputs, Tracks, and the Mixer.
Timeline

The Timeline acts as a ruler measuring the time of the edit. While it is commonly set to show the bars and beats of your song, it can also show seconds and milliseconds or seconds and frames with a simple right-click selection.

The Timeline is related to several other onscreen features:

In-marker & Out-marker

The range between between the In-marker and the Out-marker defines what is called the “marked region” in Traktion. In other DAWs this is called often called the “loop” or “cycle.” The marked region defines looped playback, loop recording, and many of Traktion’s editing options. The keyboard shortcuts are I to position the In-marker and O to position the Out-marker.
**Tempo Track**

The Tempo track appears below the timeline when open. Here you define the tempo and tempo changes. Open and close the Tempo track using F9.

**Marker Track**

There are actually two marker tracks that can be opened below the Timeline. One is for bars & beats markers such as song sections. The other is for absolute time in terms of hours:minutes:seconds and milliseconds. Cycle through the options with F10.

**The Clip Object**

Above the right side of the Timeline you find the Clip object. Some Tracktion users call the Clip object a “clip dragger” or “clip maker.” All of the terms are descriptive of how it works. Drag it to a track to create an empty clip of any of the four types - MIDI clip, Audio clip, Edit clip, or Step clip.
The Plugin Object
Drag the plugin object to the mixer section of any track to insert an audio effect plugin or virtual instrument. When you drop the Plugin object, you get a menu of all available plugins and instruments. You can control the organization of the menu from the Settings tab Plugins page. Refer to Chapter 29 - Using Plugins for much more about inserting and using plugins.

Show/Hide Buttons
Several areas of the Edit tab can be opened for use or closed to declutter the screen. Here are the buttons to control those filled by the corresponding keyboard shortcuts.

Show Hide Buttons. A, Show/Hide the Tempo track. B, Show/Hide the Inputs. C, Show/Hide the Mixer, D, Show/Hide the Controls Panel, E, Show/Hide the Marker Track
• Show/Hide Tempo Track (F9)
• Show/Hide Marker Track (F10)
• Show/Hide Inputs Section (Shift + F12)
• Show/Hide Mixer Section (M)
• Show/Hide Controls Panel (F11)

The Track Section

Tracks appears as parallel lanes that contain and organize clips of audio and MIDI in time. Signal flow follows from left to right from Inputs, to Clips for recording, to Mixer and any plugins, then on to the Master Section. There is really only one kind of track in Tracktion. Tracks can hold any kind of clip - Audio clips, MIDI clips, Step clips, or Edit clips. To create a new Track simply press T.

Track Headers
The leftmost column of the Arrangement forms a list of track headers. Select a track by clicking directly on the track name within the header. Additional track properties including the Name became available in Properties. To rename a Track, simple edit the name property. Tracks can be reordered by grabbing any track from the header and dragging it to a new location.

Inputs
Inputs appear as right facing rectangular arrows. Click on an input for a menu of options that includes a selection of available inputs. Use the menu to set up a track for recording. Additional input options are available in Properties. You can even drag an input to another track to continue recording.
Tip: Resize tracks using the zoom tools in the lower right corner of the arrangement.

Clips

You can drag in audio files and loops to build your Edit, or record them directly. The same goes for MIDI clips. Step clips are a unique in-line step sequencer. Step clips are variation on MIDI Clips. While Edit clips allow you embed an entirely different Edit into your song as single clip. Selection an of the kinds of clips to access more properties and actions in Properties.

Audio Clips

Audio clips are created during recording or can be dragged in from the Browser or desktop. Audio clips are one of the key elements of a Tracktion arrangement. Tracktion gives you a rich set of tools to work with Audio clips to split them, combine them, reverse them, or change the pitch, timing, or speed. You can also edit Audio clips with Melodyne to adjust the intonation of recorded notes. T7 gives you Clip Layer Effects for even more options to manipulate audio clips. See Chapter 41 - Clip Layer Effects to learn about this new type of audio processing.

MIDI Clips

MIDI clips are the Tracktion container for MIDI performance notes. The clips have many of the same editing features as Audio clips. Expand MIDI clips vertically to see the full in-line piano roll MIDI editor. The MIDI editor comes with a full set of tools for editing, entering, and modifying MIDI notes.
Step Clips

Step clips are a unique type of inline step sequencer that gives you amazing flexibility to enter MIDI notes on a grid. Step clips are ideal for programming drum beats and rhythms, they can also be used for baselines, synth leads or just about anything else. Some Tracktion users program complete compositions entirely with Step clips.

Edit Clips

Edit clips are another unique Tracktion concept. You can embed and entire Edit into a clip. You can also use Edit clips to separate out all your drum programming to another Edit as an aid when doing complex drum programming. Use Edit Clips to compose songs in blocks - develop the verse, chorus, and bridge in separate Edits and bring them together in another Edit. Teachers use it when recording several students singing over the same underlying track. It is a very unique feature and uses are still being discovered!

Edit clips behave in the arrangement just like Audio Clips. How can you tell the difference? They have an additional tab in the Properties panel to manage the link to the underlying Edit.
The Mixer

Tracktion’s Mixer is one of its unique, defining features. For each track, signal flows from left to right - Input to Track, Track to Mixer, Mixer to Master. The Mixer is where you arrange plugins to create whatever channel strip you need for the track. If you have MIDI clips on the track then insert virtual instrument as a sound source. If you need to EQ a vocal, drop in an EQ.

The Volume & Pan and Level Meter plugins are installed by default however you can remove, reorder, or even add more instance of them. You will find the following things on every track by default:

Mixer Default Setup: Volume & Pan Plugin, Level Meter Plugin, Solo Button, Mute Button

Volume & Pan Plugin
This acts as like the channel fader and pan controls on a conventional mixer. When you click either element, a larger version pops up allowing you to easily adjust level or panning. When selected, the full set of properties appear in Properties.

Level Meter Plugin
The level meter shows the level of audio on the track. You can add additional instances or
put the meter anywhere in the track using drag and drop. You can change the meter response between Peak, RMS, and Sum & difference from the right-click menu or from Properties.

**Mute**

The *Mute* button mutes and un-mutes the track. You can also mute by selecting a plugin and then right-click. The keyboard shortcut for mute is Shift + M.

**Solo**

The *Solo* button silences all other tracks so you can hear one track at a time. *Settings > General Behavior > Solo Behavior* allows you to customize exactly how *Solo* works. Choose from *Cumulative* or *Exclusive* modes. From the right-click menu you can choose *Solo Isolate* which allows the track to continue to play if another track is soloed. This is particularly useful if a track is configured as an effects bus.

![Mute/Solo Right-Click Menu](image)

**Tip:** Right-click on either *Mute* or *Solo* to access a menu. From here you can reset all the solo and mute states for all tracks.

---

**The Controls Panel**

Making up roughly the lower third of the Edit tab, the Controls panel is made up of three main parts - the Menu section, the Properties section, and the Master section.
A full set of menus related to the Edit are available in the Menu Section. Of particular importance are the Export, Click Track, Snapping, and Options menus. In this book, I make numerous references to the Menu section using a path syntax separated by greater-than symbols. For example, “to set a one bar count-in choose Click Track > Pre-record count-in length > Use a 1 bar count-in.”
Properties Section

What is shown in Properties depends on what object you have selected. Each track, input, clip, plugin, rack, and automation point has its own set of properties. Click to select any object and Properties will automatically switch to show values and actions for whatever you have selected. This is a key concept when using Tracktion is core to its design.

Master Section

The Master section contains cursor position information, the Transport, Master plugins, Master volume control, and a set of global control buttons.
Cursor Position Info
At the top of the Master section, notice three key pieces of information about the current cursor position - the tempo, the time signature, and the location counter. Click the tempo display to see tempo properties. Click the time signature for time signature properties. Click and edit any part of the location counter to move the cursor to that location. You can also drag any of the components of the location up and down to move the cursor. The location counter format will change to match what you have set for the Timeline.

The Transport
The Transport is made up of a set of eight buttons that include all the usual suspects - Play/Stop, Record, RTZ, Rewind, and Fast Forward. In addition, there are buttons for Automation Read, Automation Write, and Panic. The Panic button restarts Tracktion’s audio engine. All of these can be assigned to keyboard shortcuts for fast access.

Master Plugins Area
The Master section also contains a plugin area to insert final processing like compression and limiting. With no plugins installed, it will display (Drop Master Plugins Here). Drag plugins from the Browser or the Plugin object here or right-click to add them.

Master Section Buttons
The Master section includes eight buttons to access commonly used global on/off functions. More on these buttons in a moment.
Master Level
The Master level provides the final volume adjustment for the entire mix. The corresponding pan control provides control of the balance between the left and right signals. For most applications the Pan control will remain centered.

Master Meter
The Master meter shows the final output level. Right-click the meter to set the meter mode or reset any overload indicators.

Master Section Buttons
The Master section buttons include some of the most used functions in Tracktion. This is a description of what these buttons are for along with the shortcut used to toggle the button.

Loop
Loop (L) turns looping between the In-marker and Out-marker on and off. This is for both playback and loop recording.

Click
Click (C) turns the metronome click on and off.

Auto Lock
Auto Lock is short for “Automation Lock.” As the name implies, this button locks automation to clips. When on, as you move clips around the automation curves follows along.

Punch
With Punch (P) tuned on, Tracktion will only record when the cursor is between the In-marker and the Out-marker.

Snap
Snap (Q) button turns snap-to-grid on and off.

Scroll
With Scroll (S) turned on, Tracktion pans the screen to keep the cursor on screen during playback and recording.
MIDI Learn
Click *MIDI Learn* to enter MIDI Learn mode. In this mode you can easily assign external knobs and faders to on-screen controls.

MTC
With *MTC* enabled, Tracktion will chase sync to incoming MIDI Time Code. Unless you are still syncing to tape or hardware sequencers, leave *MTC* off.

Moving On

That was a broad overview of sections, controls, and buttons on the Edit tab. Next, we start to break all this down so you can have fun making music with Tracktion.
Chapter 9 - The Browser

The Tracktion Browser provides quick access to files, loops, plugins, and presets. It allows previewing loops, filtering of your Tracks by tags, and bookmarks to your favorite folders. When you locate media files and plugins in the Browser, you add them to the Edit using drag and drop. The Browser also has tabs for notifications and the clipboard. In this chapter you will learn about each of the tabs.

Tip: Remember, you can open and close the Browser (B) with the Browser icon. You can also resize the Browser tab by dragging the right edge right or left.

Browser Files Tab

The Browser Files tab allows you to find audio files on your system to include in your project. You can also preview audio files and set bookmarks. After you export mix downs of your song, you can easily find them in the Files tab as well.

Browser Files Tab Controls

Here are controls at the top of the files tab.
Browser Files Tab Menu

In use, the Files tab shows a list of files. Click the Files menu button to choose what to list. The menu is divided into sections. These aren’t labeled in the software, but the graphic here shows what each section does.

Creating Bookmarks

To create a bookmark to a favorite file location, navigate in the Files tab to any drive and folder on your system. When you locate a frequently used folder, open the Files tab menu and select *Bookmark current folder*.

**Tip:** Using bookmarks is a great way to access your loop library if you already have it organized by folders. For me this is often a more direct way to get to certain loopset than searching in the Search tab.

Removing Bookmarks

To remove a bookmark, navigate to that folder, click the Files menu icon, and select *Delete bookmark for current folder*. Notice that the delete option will only be available when the current folder has been bookmarked.

**Tip:** A quick way to located exported mixes of your song is to use the Browser Files tab. From the Files menu, select *Project folder > Exported*. By default all your exported files go into this subfolder of the parent project folder. To get to the resulting file directly on your system, right click any file and select *Open the folder containing this file*...
Tip. Quickly Locate Exported Mixes in Project folder > Exported

Browser Files Info

Information about the selected file shows in the Files tab footer. This includes the sample rate, bit depth, stereo or mono, length, number of beats, BPM, and time signature. The info varies depending on what meta data is included with the file.

Auditioning Files

Click any audio file in the files list and use the Play/Stop button along with the Audition level to preview it. By default, audio files start to play immediately when you select them. You can turn that off by deselecting Auto-Play. With Loop enabled, files play continuously until you press stop or select a different one. You can also see a thumbnail of the waveform along with a moving playhead line during the audition.

Browser Presets Tab

The Presets tab allows you to search for presets for plugins, tracks, Step clips, and Plugin racks. It also allows you to filter the results using the tag field. The Presets has has a preview feature so you
can audition presets before dragging them to your song. Tags allow you to categorize and organize presets to your liking.

**Saving Presets**

For the Presets tab to be useful, you need to save presets. Here is a quick summary for the most common types.

**Preset Line in Properties Section**

**Plugins**

For instrument or effects plugins, select the plugin in the mixer, then click *Save* in the *Preset* line in Properties. This will load the Preset Details dialog box where you can add a name, description, and tags. After you enter the information, click *OK* to save the preset.

**Plugin Racks**

To create a preset for a Plugin rack, open the window for it (usually by double-clicking) then select *Save* from the *Preset* line. This opens the Preset Details dialog box to complete the process.

**Step Clips**

Select the Step clip by clicking on its header. In Properties, click *Create Preset*. You can choose to include or exclude patterns. Choosing either opens the Preset Details dialog box to complete the process.

**Tip:** If you exclude patterns, a Step clip will use the default *Step Length* and *Number of Steps*. I suggest always choosing *Include patterns*. If you want to create a blank template, just clear all the notes, before saving.

**Tracks**

To save track presets, right-click on the Track header then click *Save Preset*. You will then choose between saving the *Whole track* or part of the track - *Track inputs*, *Track outputs*, *Track plugins*. I almost always use *Whole track* however you might want to use *Track plugins* for a convenient way to save a channel strip configuration for quick recall.
Using Presets

It is pretty obvious that you click the tags to filter presets and search for them by name using the Search field. Once you find a preset to work with, drag it to the appropriate section of the arrangement. Here are some other important features.

Renaming a Preset

Right-click any preset in the list and select *Edit Preset*. This opens the *Preset Details* dialog box. Here you can update the name, description, and tags.
Deleting a Preset
Right-click a preset and select *Delete Preset* to remove it permanently.

Export a Preset
To export a preset to share with another Tracktion user or transfer to another computer, right-click the preset and select *Export Preset*. The resulting file contains a description of the preset and has the `.trkpreset` file extension.

Importing a Preset
The easiest way to import a preset file is to drag it from your system and drop it on the Tracktion browser. You can also load a preset by right-clicking an existing preset and selecting *Import Preset*.

**Applying Presets**

To use a preset, drag it to the appropriate object in the arrangement - track, clip, or the mixer. There are other ways to work with presets. Here is rundown:

**The Apply Button**
To quickly audition Track or effects plugins, turn on *Apply* in the Presets tab footer. Next, select a track to use to try out the presets and start playback. Click on any preset you want to try for that track and it will be instantly applied. Select various presets to quickly audition. When you disable *Apply*, use *Undo* (Cmd + Z / Ctrl + Z) to remove any plugins applied this way.
Using Part of Preset

Rack and Track presets are made up of several components (e.g. plugins, instruments, mixer plugin setups). Click the triangle to the left of this type of preset to expand the view to show all the components. Now you can drag any of those components to your arrangement.

Auditioning Instrument Presets

Select the instrument preset you want to audition. Make sure Preview is enabled at the bottom of the Presets tab. Click Inputs and enable the MIDI controller or keyboard to use to audition the sound. Play notes on the keyboard or pads to audition the sound. You can also audition Instrument presets, by selecting a track that contains MIDI clips and playing it while Apply is enabled.

Tracks Tab

The Tracks tab works in conjunction with track tagging. Once tracks are tagged you can filter which tracks to view from the Tracks tab by enabling Show Only Tagged Tracks and then clicking on the tags for the tracks to view. All tracks that don’t include the tags are hidden.

The most common scenario is to tag tracks of a similar kind like “drums”, “guitars”, or “vocals.” Then you can filter by those types.
Tagging Tracks
To add tags, select one or more tracks in the arrangement, and type the tags into the Tag field in Properties. You can enter as many tags as you like separated by commas.

Note: Tags are case sensitive, so “GTR” is a different tag than “gtr.”

Filtering by Tags
To filter the view of track by tags, enable Show Only Tagged Tracks at the bottom of the Tracks tab. Click a tag to show only tracks that include that tag. You can click several tags to show additional tracks. If no tags are selected, then all tracks are shown. If you turn off Show Only Tagged Tracks, then all tracks are shown.

Removing Tags
You can remove a tag from a single track by editing the Tag property in Properties for that track. You can remove a tag from all tracks by right-clicking the tag in the tag field of the Tracks tab and selecting Remove Tag. A dialog box will appear to confirm the deletion. Click OK and the tag will be removed from all tracks.
Search Tab

The Search tab allows searching by keyword and filtering by tags for loops, presets, and plugins. This unified search also gives you all the same preview functions offered in the Presets tab for auditioning loops.

Searching

To search for a file, simply start typing into the Search box. The results will immediately appear in the results list. Searching and the results list include the Name, Tags, Category, and Manufacturer organized into columns. You can sort by any column by clicking on its header. You can rearrange the columns by dragging them. Search terms are not case sensitive.

Search Results List

Tip: If you can’t see all the search list columns, expand the width of the Browser by dragging the right edge.

What to Search For?

You can further refine searches by selecting which type of things to include. Click the search loop icon and select from Loops, Presets, and Plugins. Notice that the tag field will adjust to include only the appropriate tags for the types of items enabled.

Browser, Search Tab Filters

Tag Field

To filter by tags, click any combination of tags. The logic for the selection is “and.” What I mean is this. If you select both “Drums” and “Mallets” tags, the results list will only show items tagged with both Drums and Mallets.
Setting Tags

You can set or change the tags for one or more items in the results list with a right-click. The exact process is a bit different between loops, presets, and plugins. For Plugins and Presets, you right-click and select Set Tags. A single line field opens for editing where you and type in or edit the tags. Separate the tags with commas.

For loops, the same right-click and Set Tags opens the larger Tag dialog box. From there you can see available tags, type in new ones, or edit the existing ones.

Edit Preset Name

Right-click to open the Preset Details dialog box which presents Name, Description, and Tags fields that you can edit and save.

Audition

Select a loop in your search results and press the Play/Stop button along with the Audition level to preview it. By default, loops play immediately when you select them. You can turn that off by deselecting Auto-Play. With Loop enabled, files play continuously until you press stop or select a different one. The preview also features a nice waveform thumbnail to give you a visual reference to the loop content.
Using Search Results

Anything you find and want to use, drag from the search results to the arrangement. Track loops to tracks, drag plugins to the mixer or Audio clips. Drag instrument presets to the mixer. Drag track presets to tracks.

Indexing Your Loop Library

If you want Tracktion to be able to search for loops, you need to index your loop library. Do that from Settings > Loop Database > Scan for Loops. You will see options on that page to enter paths to your loops.

Note: If you don’t want to use Tracktion to search your loop library, then you don’t need to have it scan and index your files. You can simply create bookmarks to your loop library folders on the Files tab.

Notifications Tab

Tracktion shows notifications when new plugins are added, certain background processes complete, and for confirmation of purchases through the Tracktion marketplace. These might appear briefly in the operating system but the Notifications tab keeps the history of these messages. Scroll through the list using the mouse wheel or the scroll bar along the right side. Here are a few things you can do with the notifications that appear in the list:

Show the Installed Plugin

Click the arrow on the message to jump directly to that plugin on the Search tab.
**Removing a Notification**

Each notification has an “X” in the upper right corner to remove it from the list.

**Clearing All Notifications**

Click *Clear All* at the bottom of the Notifications tab to clear all notifications.

---

**Markers Tab**

Use the Markers tab to add Bars & Beats or Timecode markers to the Marker track. You can also use it navigate to any marker by double-clicking on the marker name. You can also quickly delete the selected marker or change its name in Properties.

![Browser, Markers Tab](image)

We have complete coverage of Markers and the Markers tab in *Chapter 10 - Using Markers*.

---

**Clipboard Tab**

The Clipboard tab shows the most recent item copied or cut. Copies are typically done using Cmd + C / Ctrl + C while cuts are done using Cmd + X / Ctrl + X. There are also on screen buttons for copy and cut depending on the object and context.

To use the last item copied or cut you typically use Cmd + V / Ctrl + V. Alternatively you can go to the clipboard tab and drag items onto the arrangement. It is particularly useful when you want to copy elements from other projects on the Projects tab, then drag or paste them into a different Edit. You can also copy and paste between Edits.
Here are few things to know about the clipboard:

**Adding Items to the Clipboard**
The best way is to use the keyboard shortcut to copy a selection of clips (Cmd + C / Ctrl + C). The shortcut for “cut” will also work (Cmd + X / Ctrl + X). These commands are also usually available from right-click menus.

**Dragging Clipboard Items to the Arrangement**
When you drag items from the clipboard you get all or nothing. However before dragging, you can remove the items you don’t want by right-clicking and selecting *Remove item from clipboard*.

**Clearing the Clipboard**
To remove all items from the clipboard. Right-click any item and select *Clear clipboard*. Why would you do this? I am not sure why you ever need to do that!

**Moving On**

Reading about all the features of the Browser should give you more insight into the capabilities of Tracktion. It will make even more sense after you get familiar with the core workflows of recording, editing, and mixing.
Chapter 10 - Using Markers

In this chapter, you will learn about using markers in Tracktion. There are four different kinds of markers in Tracktion:

**In-marker and Out-marker**
Together these define the “marked region” - that is the region for looped playback and loop recording.

**Bars & Beats markers (B&B Markers)**
Bars & Beats markers can be used to identify song sections, give you a visual guide to the song, and provide quick navigation to different parts of your song. They are arranged as clips on the Marker track. Bars & Beats markers appear with a musical note icon on the Marker track. They also appear as narrow pointers on the Timeline when the Marker track is closed.

**Timecode Markers (TC Markers)**
Timecode markers mark a specific time offset into the Edit. TC markers are not dependent on tempo changes. They can aid navigation especially when working with video. TC markers appear as clips with a clock icon on the Marker track. They appear as rounded pointers on the Timeline if the Marker track is closed.
Chapter 10 - Using Markers

Timecode Marker on the Marker Track

Timecode Marker on the Timeline (with Marker track closed)

Note: In Tracktion the term ‘marked region’ means the range of an edit that occurs between the In-marker and the Out-marker.

Wave File Markers
You can add yellow arrows directly to Wave files that then appear on Audio clips. These are the least useful type of markers. More about them near the end of this chapter.

Wave File Markers

In-marker & Out-marker

Position the In-marker and Out-marker by dragging the I and O flags along the Timeline. The In-marker and Out-marker together define the range over which playback will loop when the Loop button in engaged in the Master section. They also define what is called the “marked region” used for numerous editing actions.

The In-marker & Out-marker

Pressing I will locate the In-marker to the cursor position. Pressing O locates the the Out-marker to the cursor position.

You can alternatively “draw” in the range between the In-marker and Out-marker. Double-click on the Timeline and start dragging right. Double-click positions the In-marker at the starting point. As you drag right, the Out-marker comes along to set the out point when you lift the mouse button.

Tip: To set the marked region over a selection of clips and press A. This also works for Marker clips making it a great way to set the In-marker and Out-marker over a song section.
Navigate Using the In-marker & Out-marker

You can quickly navigate to the In-marker or Out-marker using the square bracket keys. Press [ to locate the cursor to the In-marker; Press ] to locate the cursor to the Out-marker.

Zooming to the In-marker/Out-marker

When you have a marked region set between the In-marker and Out-marker you can quickly zoom in to that region. To do that, right-click the Timeline and select *Zoom to show the marked region* or simply to press F7.

![Zoom options](image)

Right-click the Timeline, Zoom to In-marker/Out-marker

Looping Playback Over the Marked Region

To continuously repeat playback over a section of your tune, set the In-marker and Out-marker to define the loop range. Turn on looped playback by engaging the *Loop* button (L). Playback will repeat that section over and over until you stop playback.

![Loop button](image)

Enabling Loop Playback

**Note:** When *Loop* is enabled, playback will only play within the marked region. If the cursor is located earlier than the In-marker or after the Out-marker when you press *Play*, it will jump to the In-marker and play from there.

Auto Punch and the Marked Region

To use Auto Punch, first set the In-marker and Out-marker over the range where you want to punch in. Enable the *Punch* button (P) in the Master section. Make sure *Loop* is turned off. Now enable a track for recording, position the cursor before the In-marker and press *Record* on the Transport.
Even though the track is armed for recording, no recording will happen until the cursor gets to the In-marker.

**Enabling Auto Punch Recording**

Tip: Auto punch recording means that recording is only allowed between the In-marker and Out-marker. Also, punch recording only works when *Loop* is off.

**The Marker Track**

Let’s take a closer look at the Marker track. You can open and close the Marker track with the Marker track show/hide button.

The Marker track can contain either Bars & Beats markers or Timecode markers. If you don’t like to see the types mixed together on the same track, there is an additional split mode that shows each type on separate lanes.

To access that mode, select the Marker track by clicking the header. Then in Properties, de-select *Use a single track for all types of marker*. In this mode, the Marker track has two lanes. The top lane shows Timecode Markers and the bottom lane shows Bars & Beats Markers.
Marker Track Properties Setup for Split Mode

**Note:** F10 is my assignment for the keyboard action *Toggle the marker view mode*. Pressing F10 cycles through the three marker track states - hidden, normal, and split mode.

**Tip:** You can click on any blank space in the Marker track to instantly position the cursor.

## Adding Markers

There are various ways to add markers to the Marker track:

### Drag the Clip Object

Drag the Clip object to the Marker track and choose which type of Marker to create. This creates a Marker clip you can drag and resize. It has left and right trim handles to adjust the length. You can also drag a marker by its header and move it around. If the Marker track is in split mode, the type of marker (B&B or TC) is determined by which lane you drop the Clip object on.

### Press Return

The Return key (Enter on PCs) has several functions related to Marker navigation during playback. At the most basic level, pressing Return adds a new Marker at the cursor position. The type of Marker clip matches the most recently added Marker. If a Marker clip is selected, it adds one of that type. Markers added with Return, use the next available sequential Marker number.

### Right-click the Marker Track Header

Right-click the Marker track header and choose which type of marker to add at the cursor position.
Chapter 10 - Using Markers

Marker Track Properties Buttons
Click the Marker track header to select it, then look in Properties. There you will find the buttons New Bars & Beats Marker and New Absolute TC Marker.

Browser Markers Tab Add Button
You can add either kind of Marker Clip using the selections on the Browser, Markers tab.

Marker Clip Properties
Marker clips behave like other clips in several ways. You can adjust the length using the trim handles, you can split them, drag them, duplicate them, or nudge them. They also contain several properties that I will breakdown here.
Number

Marker numbers are issued sequentially as you add Marker clips. You can edit the *Number* property if you want. If you change *Number* to one that is already in use, then the other clip will be assigned the next available number. Marker numbers can be used for quick navigation during playback.

Tip: If you feel compelled to renumber all your Markers to get them into a nice sequential order, you might want to skip some numbers to make it easier to insert new Markers. For example, if I have a lot of markers in the song, I re-number them by 5s.

Type

*Type* allows you choose which type of Marker clip you want - *Bars & Beats* or *Absolute*. Bars & Beats markers adjust to the tempo changes in the song. Timecode markers are fixed to a specific time offset into the Edit and are not affected by tempo changes.

Note: Timecode markers are also called “absolute markers”, “TC markers”, or “absolute timecode markers” within Traktion. All those terms refer to the same thing. For this book, I usually call them Timecode markers.

Name

The *Name* property sets the name shown on the Marker clip. By default it will be “New Marker.” Most users rename it based on song section. For example: Intro, Verse, Chorus, Bridge, or Outro.

Start

The *Start* property shows the bar, beat and tick start time for B&B markers. For Timecode markers it shows Hours/Minutes/Seconds/Milliseconds. For either type, you can edit *Start* directly to move the marker to a different location.

Length

Similarly, *Length* shows B&B marker length in Bars/Beats/Ticks format. For Timecode markers, it shows length as Hours/Minutes/Seconds/Milliseconds. Edit the *Length* property and the Marker clip length will change to match.

End

*End* values are in the same format as the *Start* property. Edit it to change the ending time. When you change the *End* value, *Length* gets adjusted to match. *Start* always remains the same. If you edit *End* to fall before *Start*, it will be set to match the *Start* time. In that case, *Length* gets set to zero.
Colour

Choose from one of the nice colors. This sets all selected Marker clips to the color you choose.

Tip: You can change a Marker clip from Bars & Beats to Timecode using nudge. Press F10 until the Marker track split mode is showing. Select the marker clip to convert and press Shift-up or Shift-down to nudge the clip to the other lane.

Navigating by Markers

Once you have Markers set up, you can quickly navigate using the Marker number and the Return key. Just type in a Marker number like ‘5’ or ‘11’ and hit Return (‘Enter’ on PCs). As you type the number you will see it appear in green in the upper right of the Tracktion window. When you see the number, you have about two seconds hit Return before the number disappears.

![Marker Number As It Appears Momentarily](image)

If you enter a number that doesn’t have a matching Marker, then Tracktion will insert a marker with that number at the cursor. Also, if you just press Return, a Marker clips is inserted at the cursor position.

Undo (Cmd + Z / Ctrl + Z) removes a marker if you didn’t intend to insert it.

Tip: The Number + Return approach to navigation works during playback but also works when Tracktion is idle. If it doesn’t seem to be working when playback is idle, click the header of the Marker track or select any marker and try again.

The Browser Markers Tab

Use the Browser Markers tab to add Bars & Beats or Timecode markers to the Marker track. You can also use it navigate to any marker by double-clicking on the marker name in the list. You can also quickly delete the selected marker or change its name in Properties.
Select marker clips
Single-click a marker in the list to select it.

Navigate to a marker clip
Double-click on a marker in the list to jump to that position. This works during playback too.

Rename a marker
Click a marker to select it. Then, edit the Name property in Properties.

Add a Marker
Click Add at the bottom of the Markers tab. Select from the two types: Absolute timecode marker and Bars & Beats Marker.

Delete a Marker
Select a marker in the list and click Delete or just press Delete on your keyboard. Undo (Cmd + Z / Ctrl + Z) restores a deleted marker.

Change a Marker from one Type to the Other
Select the Marker and edit the Type property in Properties. Or drag it from the TC Marker track to the B & B Marker track or vice-versa.
Renumbering Markers

It is really easy to get your marker numbers out of order. There is an easy trick to renumber them. Open the Markers tab in the Browser. Select all the markers and edit the Number property. For example if it shows “1” with all the markers selected change it to “2.” The markers instantly renumber starting from “2.” If you really want them numbered starting from one, then just do it again, changing the Number property back to one.

Adjust Markers (Wave File Markers)

There is another type of marker in Tracktion. It’s confusing because they are also called “markers.” They appear to mark spots in a clip but actually are stored in the underlying Wave files. You work with these markers from the Adjust Markers actions in Audio clip properties. You also add and remove them by dragging the marker object in Audio clip properties View Source Info.

Tip: I recommend you not spend much time working with the “adjust markers” type of markers. This is a legacy feature that is not well implemented or particularly useful.
Moving On

Markers can be extremely useful in the context of recording and editing. Not only do they keep your project organized by then provide easy navigation into important locations within the Edit.
Chapter 11 - Selecting and Snapping

In this chapter, we start working with clips. The examples focus on Audio Clips and MIDI Clips. Keep in mind that most of these techniques also apply to Step clips, Edit clips, and markers.

First, you’ll learn how to select clips and groups of clips. Then, you will learn about the snap-to-grid functions. Snap-to-grid makes it easy to align clips to the bars and beats of your song. Let’s get started with selecting clips.

Selecting a Clip

To select a clip, simply click on the clip. The clip is highlighted and its properties appear in Properties.

![A Selected Clip](image)

Auditioning a Clip

To audition a clip, double-click and you will hear it play back starting at the spot where you double-clicked. Click within the clip to jump to a new spot as playback continues. Click anywhere outside the clip and the auditioning will stop. Moving pointers above and below the clip indicate the playback position.

![Audio Clip Being Auditioned](image)

Auditioning essentially solos the clip - everything else within the Edit is muted in this mode.
Selecting Multiple Clips

To select more than one clip, hold down Cmd / Ctrl then click on each clip that you want to add to the selection.

Once you have multiple clips selected, you can do operations on them as a group, such as moving them by dragging, duplicating, or deleting them. We’ll cover more about clip editing operations in Chapter 12 - Basic Audio Editing. To clear a multiple selection, simply press the Esc key.

Another way to make a multiple selection is to use the lasso tool. Here’s how that works:

1. Hold down Opt / Alt until you see a plus cursor.
2. Now as you drag, the cursor draws a yellow box.
3. Anything the yellow box touches gets selected.

Tip: You can further customize a multiple selection by holding down Cmd / Ctrl then click any clip you want to de-select.
**Shift Selecting Clips**

Tracktion also supports Shift-select. This is a quick way to select a contiguous range of clips. Here’s how:

1. Select the first clip.
2. Hold down Shift and select the last clip. This will select the first clip, the last clip, and all the clips in between.

Shift-select works for clips on a single track and even across multiple tracks.

Tip: Shift-select also works for many other kinds of Tracktion objects including Browser lists and tracks.

**Deselecting Clips**

You can always press Esc to deselect everything.

Tip: Pressing Esc also works to clear selections of other objects in Tracktion like plugins and tracks.

**Using Snap-to-Grid**

Snap-to-grid makes aligning clips and notes to musical time accurate and efficient. Working with this powerful feature is core to using Tracktion for editing audio and MIDI.

**Enable/Disable Snap-to-Grid**

To toggle snap-to-grid on or off, click on the *Snap* button (Q) in the Master section. When snap-to-grid is enabled the *Snap* button appears highlighted.
Pressing Q also toggles Snap on and off. You can also control the snapping state from the menu section - Snapping > Enable snapping.

Tip: Remember the keyboard shortcut Q is short for quantize. Snap-to-grid is a form of quantizing. If you don’t like that shortcut you can always remap it to another key.

### About Snap Resolution

The snap resolution is dependent on the zoom level. If you’re zoomed way out, the snap resolution might be one bar. The more you zoom in, the snap resolution gets finer and finer.

Tip: You can always see what your current snap resolution is by hovering the mouse pointer over the Timeline. A tooltip appears showing, Snap resolution bar, Snap resolution beat, or Half beat for example.

### Snapping Clips to the Grid

As you drag a clip, it snaps to the grid increments. If you want to see exactly where it’s snapping, look at the Start parameter in Properties. Snap-to-grid makes it easy to align a clip to a bar or beat of the music.

Note: Snap-to-grid is an alignment of the beginning of a clip to a grid line. Notice that snapping also applies to editing functions like trimming.
Snapping the Cursor to the Grid

Snapping may affect how the cursor is positioned depending on another setting. Turn on Snapping > Snap cursor movement and the cursor position will snap to the grid. Remember that the snap resolution is determined by the zoom level.

![Snapping the Cursor to the Grid](image)

To test this, zoom out so that the snap resolution is “Beat.” Now move the cursor around and it will obviously snap to the nearest beat.

Tip: To get clear indication of exactly where the cursor is, look at the time display in the Master section.

Snapping Clips to Other Clips

Another snap behavior is to Snap clips to neighbors. With Snap clips to neighbors off, clips snap to the grid normally. However, with Snapping > Snap clips to neighbors turned on, clips snap to other clips. It seems as if they are magnetically attracted to each other. This is useful for any editing where you want to arrange clips end-to-end. I use this when editing voiceover tracks.

![Snap Clips to Neighbours Option](image)

Tip: A problem with Snap clips to neighbors is that you need to have snapping enabled for it work. To snap clips to other clips with with snap-to-grid disabled, just hold down Opt / Alt as you drag. This is really the best way to arrange clips end to end!
Chapter 11 - Selecting and Snapping

Overriding Snap-to-Grid

Temporarily override snap-to-grid by holding down Cmd / Ctrl. Using this modifier you can freely position clips without first turning off Snap.

Nudging Clips

To move clips using the keyboard, select a clip then press Shift + Right Arrow or Shift + Left Arrow. The nudge action moves the clip by one grid increment. You can also move clips track to track using nudge. To nudge clips track to track, use Shift + Up Arrow and Shift + Down Arrow.

I often use nudging when moving large selections of clips over to add a song section or make room for an intro.

Note: Nudging works the same whether snapping is on or off. The nudge move is by the grid increment.

Nudging Notes

Snapping is useful when working with Audio clips but even more so when working with MIDI notes. We cover MIDI editing in Chapter 25 however here is a preview while we are on the topic of nudging.

![The Tracktion MIDI Editor](image)

Double-click on the header of a MIDI clip. It goes into the large view so you can see the MIDI editor. MIDI notes work much like clips, in that they respect the snap resolution. You can drag a note to snap by the current grid increment - bar, for example. You can nudge notes forward or backward in time by the grid increment as well. To do that, hold Shift while pressing the Left Arrow or Right Arrow.
Tip: Remember the keyboard shortcut Q to toggle Snap on and off.

Moving On

Now that you’ve learned how to get around in Tracktion, it’s time to start having fun manipulating audio. We’ll jump into that in the next chapter.
Chapter 12 - Audio Clips and Editing Audio

In this chapter, you are going to learn how to work with Audio clips. You will learn how to work with the integrated editing handles that are part of each Audio clip. Let’s get started.

Parts of an Audio Clip

Notice that an Audio clip has several parts. It has a header that includes trim and slip handles. It has a body that contains the waveform thumbnail and fade handles.

Header

Move Audio clips by dragging from the header. The header includes the trim handles (hollow), slip handles (solid), and other tools.
The Audio clip body features the waveform thumbnail, fade handles, and the clip name.

Audio clips can host plugins directly, so you might see a one or more plugins right on the clip body. Learn more about that in Chapter 32 - Clip Effects.
Properties

Like most other object in Tracktion, Audio Clips have lots of additional properties and controls in Properties.

Audio Clip Properties

Note: If you accidentally move or edit an Audio clip, you can always press Undo (Cmd + Z / Ctrl + Z) at the top of the Menu section.

Moving Clips

As you move the mouse pointer over the Audio clip header, it changes to a grabbing hand. Use that to drag the clip forward or backward in time. If Snap is on, the beginning of the clip will snap by grid increments.

Note: As we discussed previously, the grid resolution depends on the zoom level.

You can also drag Audio clips from track to track. With snap enabled, track-to-track drags will usually stay in sync. However, with snap turned off, it is easy move the clip slightly off time. To prevent that, hold down Shift as you drag track to track. The Shift key, constrains the timing of track to track drag moves.
Tip: Another way to move a clip track-to-track without changing the timing is to use nudge. Select the clip the hold down Shift and press Up Arrow or Down Arrow to nudge it to another track.

Deleting Clips

The easiest way to delete a clip is to selected it and press Delete or Backspace. The cut (Cmd + X / Ctrl + X) keyboard action does the same thing. If you need yet another way to delete, locate and click the convenient Delete button in Properties.

Audio Clip Properties Delete button

Tip: As you work with clips sometimes you just want clear the selection. The fastest way is to just hit Esc.

Audio Clip Handles

Each Audio clip header includes six handles that you use for trimming, slipping, stretching. These are represented as four arrows and two boxes.

Trimming

Hollow left and right arrows on both of the upper corners of the clip are trim handles. Grab a trim handle and drag left or right to trim the start or end of the the clip. Notice that trimming this way directly changes the Start and End values in Properties. With Snap turned on, trimming snaps to the grid. To trim freely, hold down Cmd / Ctrl as you drag or turn Snap off.
**Chapter 12 - Audio Clips and Editing Audio**

**Audio Clip Trim Handles**

**Slip Editing**
Slip editing means moving the waveform within the clip without altering its *Start*, *Length*, or *End* values. Drag the solid box shaped handle left or right to slip edit. You can override snap-to-grid during slip editing by holding down *Cmd* / *Ctrl*.

**Audio Clip Slip Handle**

**Reframing**
The hollow box shaped handle allows reframing the clip. Drag it left or right and the clip moves but the waveform doesn’t. It essentially allows you to reframe the audio without affecting its timing. I actually haven’t found a good use for this in my day to day editing, however you might!

**Slip Trimming**
The solid left and right arrow handles are for slip trimming. You really need to try these to get how they work. Try dragging the left solid arrow. Notice that it moves the clip *Start* while keeping the *End* planted. Now try the right solid arrow. Moving that one, moves the *End* while keeping the the *Start* planted. Now that sounds a lot like trimming, right? The difference is that the underlying waveform slips relative to the end that is not moving. I know that is not clear, so try them out. In reality, I rarely use these.

**Tip:** With *Snap* on, hold down *Cmd* / *Ctrl* as you drag to temporarily override snapping for most editing operations.
Splitting a Clip

Splitting Audio clips, is essential for audio editing. Here is the quickest way:

1. Select the clip
2. Position the cursor where you want to make the split
3. Press slash (/)

![Audio Clip, Right after Split](image)

Tip: If you want to make numerous splits, you can keep holding down the left mouse button as you drag the cursor and press slash (/) - never lifting the mouse button.

Audio Clip Properties also has Split Clips actions. Look to the far right of in Properties and find the Split Clips button. You will find options to slip at the cursor along with options to split at the in-marker or out-marker. Keep in mind that these actions will only affect selected clips.

![Audio Clip Properties, Split Clips Actions](image)

Duplicating Clips

To duplicate one or more clips, select the clip and press D. That will copy the clip and paste it right after the original clip. Duplicate works like copy and paste, all in one action.

---

26[https://w-edstrom.wistia.com/medias/qr0fax85zn](https://w-edstrom.wistia.com/medias/qr0fax85zn)
Note: Duplicate is one of my favorite editing tools. I used it constantly!

Tip: If you want to use a different key for the duplicate action, you can change it in Settings tab > Keyboard Shortcuts > Editing Functions: Duplicate.

Fade-in/Fade-out

In the upper corners of the Audio clip body, notice the fade handles. Each is shaped like a tiny box with a diagonally line through it. Grab a fade handle and pull it inward. This action draws a fade-in or fade-out.

Audio Clip Fades

Video Clip: Fade-in/Fade-out Demo²

By default you get a linear fade but you will see that there are other fade types available in Properties for the clip. For more control, directly edit the Fade In and Fade Out numerical values in Properties.

²http://vimeo.com/user356034/fades
Pitch Fade

Right click on the fade handle, and you can select between a volume fade and pitch fade. Pitch fade gives you a very cool tape stop effect or tape run-up effect. The fade graphic is shaded darker than for volume fades.

Note: You will definitely want to experiment with pitch fade! This is just about the simplest implementation of this effect I have seen.

Here is a video tutorial I produced demonstrating pitch fade:

Pitch Fade Video Tutorial²⁸

Crossfades

A crossfade is fading out one Audio Clip while fading in another. Some controls in Tracktion are labeled “X-Fade” when referring to crossfade. Here are the steps to create a crossfade:

1. Drag a clip so that it it overlaps another one somewhat.
2. Press X on the keyboard.

²⁸https://w-edstrom.wistia.com/medias/o2ff37pkn1
Crossfaded Audio Clips

That’s it - a crossfade. It’s a fade-out that overlaps the fade-in of the next clip. You can adjust the fade shapes using the buttons in Properties just like any other fade.

**Note:** Keep in mind that the fade shape buttons only operate on the selected clip. You will need to select the clip on the appropriate side of the crossfade for the fade shape buttons to work.

### Drag Crossfade

The Settings tab, General Behaviour page has a setting labeled *Default Drag X-Fade*. It has two possible settings - *On by default* or *Off by default*. When set to *On by Default*, the simple act of dragging a clip so that it overlaps another clip will create a crossfade. I usually set it to *On by Default*. Other DAWs call this “auto-crossfade.”

**Note:** In Tracktion, *Drag-X Fade* is actually a property of each Audio clip. When you change *Default Drag X-Fade* it will only take effect for new clips you create or add to the Edit.

### Edge Fades

When editing, sometimes you need to apply short fades to both edges of an Audio Clip to avoid popping. This is especially true if you split a clip in the middle of a note. The solution is add as short fade-in and fade-out to the clip. Tracktion calls those “edge fades.”
The good news is that you can instantly add edge fades by clicking *Apply Edge Fade* in Properties. This applies 7 ms fades to the start and end of all selected clips.

**Copy and Paste**

Typical cut, copy, and paste commands also work with Audio clips:

- Cut (Cmd + X / Ctrl + X)
- Copy (Cmd + C / Ctrl + C)
- Paste (Cmd + V / Ctrl + V)

**Clip Gain, Mute, & Pan**

I find that adjusting the gain of an Audio clip is a great tool for mixing. Just split out one phrase or even one note and tweak the gain level. Tracktion has not only clip gain but also clip mute and pan — all available in Properties. When working with stereo Audio clips, *Pan* works as a balance control.

**Gain**

Drag the slider left or right to adjust the Gain value. Alternatively, click the slider and type in a value directly. The gain change is reflected right away in the height of the waveform thumbnail on the clip.
Mute
Click the Mute icon to silence the clip. The waveform thumbnail will dim to gray.

Pan (Mono Clips)
Drag the Pan slider left or right to adjust the stereo placement of the clip. You can also click and type in values directly. Full left is -1.00, centered is 0, and full right is 1.00.

Pan (Stereo Clips)
With stereo Audio clips, Pan acts as a balance control. What that means is that as you slide it more right the left side gets quieter. Slide it left and the right side gets quieter. At the extreme left and right positions the opposite side is silent. The really cool thing about this is that the waveform thumbnail updates dynamically show to show the effect.

Active Channels (Stereo Clips)
For stereo clips you can turn off either the left or right channels using the Active Channels buttons in Properties. When you click Left, for example, it toggles the left side off. But it’s not just muting the left side, it switches the clip to a mono version of the right side material. The great thing is that the waveform thumbnail updates to show this instantly.

Reversing Audio Clips
Another cool thing you can do is reverse a clip so the audio plays backwards. Simply click the Reverse button in Properties. The waveform thumbnail reverses and the sound will be backwards on playback.

Merging Clips to One Clip
Following editing, I often want to combine several clips back into a single one. To do that, select all the clips using shift select or lasso selection. Then choose Render Clips > Merge the selected clips in Properties.
In a few moments, Tracktion combines them into a single contiguous clip. There are many ways to merge, render, and export that we will touch on later.

![Merge Clips, Before and After](image)

Here is video demo of merging clips:

[Merge Selected Clips Video Demo](https://w-edstrom.wistia.com/medias/5h6bn8h3vg)

### Deleting a Section of Audio Removing Space

You can easily delete a section of audio from one or more clips and remove the space between clips. While it’s not entirely obvious how to do this, it is easy if you follow these steps:

1. Set the in-marker and out-marker over the section you want to delete.
2. Select all the clips on all tracks (Cmd + A / Ctrl + A)
3. In Properties choose *Delete > Delete marked region of selected clips, and move up any selected clips* (Cmd + J / Ctrl + J).

Delete a Section Removing the Space

**Edit with Melodyne**

Since T6, Tracktion includes the incredible Celemony Melodyne ARA technology for pitch and time manipulation. A Melodyne Essential license is included and you should have received information on how to install it with your Tracktion order.

Here is how to invoke Melodyne on an Audio clip:

1. Select an Audio clip.

Change *Stretch Property to Melodyne*
1. In Properties change the *Stretch* property to *Melodyne*. The word Melodyne appears at the center of the clip.

![Audio Clip with Melodyne Invoked](image)

Audio Clip with Melodyne Invoked

1. Click the word “Melodyne” at the center of the clip to open the Melodyne UI.

![The Melodyne UI](image)

The Melodyne UI

1. Edit pitch and time by manipulating the note “blobs” in the Melodyne UI. Note that the transport and loop is synchronized between Tracktion and Melodyne as you edit.
Tip: To learn all about Melodyne click Help > Manual within the Melodyne UI. Skip the section on Loading, Transferring and Saving. All of that is handled automatically by ARA.

Here is how to remove Melodyne from a clip:

1. Select an Audio clip that is using Melodyne.
2. In Properties change the Stretch property to No Time-Stretching or Elastic Pro. Melodyne is removed from the clip.

Video Clip: Here is a video clip that explains how to invoke Melodyne in Tracktion.

Moving On

Those are the simple but powerful tools in for editing Audio clips in Tracktion. We didn’t even cover time stretching, Warp Time. But, these are the fundamentals. Let’s move on to looping Audio clips - in the next chapter.

³⁰https://youtu.be/N3T8G-qF4zQ
Chapter 13 - Working With Loops

In this chapter we introduce the looping capabilities of Tracktion. You can drag in files from your loop library as Audio clips and repeat them with the Duplicate (D) action or switch any Audio clip into looping mode and roll out repetitions over as many bars as you want. This makes it easy for example to extend a short loop into a beat to play over the full length of a song. Loops have a special tab in Properties and we will explore that in this chapter as well.

Getting Loops Into Tracktion

There are four ways to copy loops into an Edit.

1. Use the Browser Files tab and navigate to wherever you have audio files and loops on your system. Drag loops you find there to tracks in the Edit. As you drag in loops they appear as an outline until you drop them.
2. Use the Browser Search tab and search for loops and then drag them into your Edit. The Browser also gives you the ability to preview loops to help you select the right one for the song.
3. Simply drag them from you computer desktop drop them onto tracks.
4. From the menu section, select Import > Import an audio or MIDI file. Navigate to a file on your system and click open. The Select a file to import dialog box even includes a basic file audition function with Auto-play.

Setting the Edit Tempo

If you know the tempo of the loop you might want to set the tempo of your Edit to that tempo before dragging the loop in. That will give you the most natural results.

Changing the Tempo

Here is how to change the tempo:
1. Click on the BPM setting in the Master section. Properties will show the BPM value.
2. Click on the BPM value and type in the new tempo.

**Dragging Loops to a Track**

As you drag a file to a track you’ll see an outline of the Audio clip before you drop it. Position the beginning of the clip right where you want it on the track and just drop it. If it’s not in the right place, grab the Audio clip from the header and drag it into place.

After dropping a loop, notice that the cursor jumps to the end of the loop. The reason is this to position the view and cursor ready to drop in the next one as you build up a track.

**Tip:** If you don’t like having the cursor jump to the end when dropping in loops, hold down Opt / Alt as you drag. This prevents the cursor from jumping to the end.

If Snap is on, loops you drag in will snap to the grid.

**Dragging in Multiple Clips from the Browser**

To drag in several clips at once, make a multiple selection in the Browser and drag the selected loops to a track. They will be arranged on the track end-to-end.

**Tip:** To drop a selection of clips to parallel tracks, hold down Cmd / Ctrl as you drag and Tracktion asks if you want to put them on one track or separate tracks. This is great when working with multitrack drum loops. It even creates additional tracks if there aren’t enough available.

![Add multiple files](image)

**Dragging Loops to Separate Tracks**

**Looping the Loop**

Audio clips have an L icon on the header. Click the L to toggle looping mode for that clip. Once the clip is in looping mode it will immediately appear to be twice as long. Enabling looping gives you one repeat right away.
Audio Clip Loop Mode

To repeat the clip, drag the right trim handle and roll out as many repeats as you want. You will see a white repeat divider at the start of each repetition. The underlying audio wave file is not duplicated, it is just being replayed over and over. All other editing operations work the same as any other loop. To stop looping, click the L icon gain to toggle looping off. That returns the clip to a single cycle.

There is another way to activate clip looping. Select the clip then click *Loop this Clip* in Properties. From there you can select the number of times to loop. This is an alternative to dragging the right trim handle to roll out repetitions.

The nice thing about looping is it doesn’t take up any additional space in the project. You can loop just about any clip. You could take a four bar drum loop and separate out one or two bars of the main groove then loop it. That can give you the starting point for a song. Roll it out across the entire song, and you’ve got something more inspiring than a click to play against.

**Duplicating Clips**

Another way to repeat a clip is to duplicate it. It is simple. Select a clip and press D. Duplicate is the equivalent of copy followed by paste. The duplicate clip is placed immediately after the selected clip.
Duplicating a Clip

This is the best approach if you plan to edit the audio in a unique way for that section of the song.

Loop Properties

Notice that Properties has a second tab labeled Loop Properties. This tab appears whenever you select an Audio clip. These properties are related to the underlying wave file. Tweaks to these properties affect how the Audio clip will respond to tempo, pitch, and time stretching. Here is a description of the most essential properties on the Loop Properties tab:

Auto-Pitch

With Auto-Pitch enabled, Tracktion will change the pitch of the clip appropriately to match key change events in the Tempo track. This only works if you have a Root Note set for the file - more on that in a moment.

Auto-Tempo

With Auto-Tempo ticked, the Audio clip will be automatically stretched to match the song tempo and tempo changes in the Tempo track. For Auto-Tempo to work, you need to make sure you have the Root Tempo set for the file and Stretch set to an appropriate algorithm.

Warp Time

With Warp Time enabled the waveform view to the right becomes a Warp Time editor. You can add warp points and do fine timing adjustments. This powerful feature was new in T6 and is covered in detail in Chapter 18 - Warp Time.
Time Signature
Edit Time Signature values to set the time signature of the file.

Root Tempo
Root Tempo is the original tempo of the loop file. Tracktion uses this to know how much to stretch the file to sync it to the Edit tempo. If Root Tempo is not recorded along with the loop file, you can set it here. Files created within Tracktion will automatically have the Root Tempo set to match the Edit tempo.

Beats
The Beats parameter is the number of beats in the file. Using Beats and Root Tempo Tracktion calculates the length of the loop file in musical terms.

Pitch Offset
If you just want to pitch the file up or down, enter an offset value for Pitch Offset.

Stretch
Stretch sets time stretching algorithm used for this loop file. Usually you will want to use Elastique (Monophonic) for lead vocals and solo instruments. Use Elastique Pro for everything else. Melodyne is typical selected used for pitch correction.

Waveform View
The waveform view allow you to play the file. You can also adjust the in and out loop points by dragging the purple lines inward. There is a convenient level control here as well. This view is replaced by the zoomable Warp Time editor when Warp Time is enabled.

Loop Start/End
This button contains a few quick tools to set the start and end loop points of the underlying wave files to match the current Audio clip start and end points.

Beat Points
Beat Points are a type of marker that shows where the transients are to assist with time stretching. This concept is very similar to how acidized files work. With the latest Elastique Pro stretching algorithms manually manipulating the beat points is not necessary. I wouldn’t spend much time working with Beat Points. I expect that this functionality will get merged with Warp Time in the future.

Add to Library
If you create an Audio clip loop and might want to reuse it in other projects, click Add to Library then give it a name and tags.

Note: When you use Add to Library, the loop file will be saved to the User Loops Path folder as designated on the Loop Database page of the Settings tab.
Tip: If you want more control when adding loops to your library, try Export > Render to a File. If you choose, Only Render Selected Clips you get much more control over its properties and where to put the resulting file.

Moving On

There’s a lot more you can do with clip looping, loop files, and loop libraries in Tracktion, but those are the fundamentals.
Chapter 14 - Keyboard Shortcuts

In this chapter you will learn how to customize the keyboard shortcuts in Tracktion. In Chapter 1 I covered how to change the default keyboard mapping. In short, go to the Settings tab and select the Keyboard Shortcuts page. Then near the bottom of the page click Reset to Defaults, and choose Use alternative Tracktion key-mappings.

**Note:** The alternative Tracktion key-mapping is used for all examples in this book.

**Keyboard Shortcuts Page**

The Keyboard Shortcuts page on the Settings tab shows all of the key-mappings. You can easily change those to your liking or match them to a DAW you are already comfortable with.

Tracktion allows you to have more than one shortcut tied to a single action. This is really helpful if you want to have a way to do something on your laptop but then take advantage of the extended keypad when you’re on a desktop computer.
Setting a Keyboard Shortcut

Let’s take a look at an example. To start recording you click the Record button in the transport or press keyboard shortcut R. When working on a computer that has a full size keyboard, I prefer to start recording by hitting the asterisk (*) key on the keypad.

Here’s how to set that up:

1. To the far right of each action there’s a plus icon. To create or add a keyboard shortcut to an action, click the corresponding plus icon. The New Key-mapping dialogue box opens up.
2. Type the key or key combination that you want to trigger this action. The key or key combination will be identified in the dialogue box and it will also show you if there’s a conflict with an existing mapping. For our example, press asterisk (*) and then click OK.

Now, both R and the keypad asterisk (*) are assigned to the Record action. Back in the Edit test this by turning *Record on and off using either R or asterisk (*).
Note: Keyboard mappings are global. Any changes you make will be active for all your Edits.

**Changing a Keyboard Shortcut**

To change an existing shortcut, click directly on the key-mapping at the far right of the action. Choose between *Change this key-mapping* and *Remove this key-mapping*. If you choose the *Remove* option, the key-mapping disappears. If you choose the *Change* option the *New key-mapping* dialog appears and you can enter a new assignment.

![Click to Change or Remove a Key-mapping](image)

**Saving Keyboard Shortcuts to a File**

Once you have your keyboard shortcuts set up the way you want, you can save the entire key-mapping to a file - a very good idea. If you run Tracktion on a different computer, you can just import the file and have all your familiar assignments ready to go.

![Save Key-Mappings Button](image)

To save your shortcuts setup, click *Save Key-Mappings* and Tracktion presents a dialogue box requesting a file name and path. You can store the key-mapping file anywhere you like. Tracktion key-mapping files have the `.tracktionkeys` extension.
Save Key-Mappings Dialog Box

Tip: I created a ‘settings’ folder under my main Tracktion folder to hold such files. I suggest naming the key-mapping files with a version number at the end. That gives you the ability to easily roll back to a previous version if ever change your mind about a new keyboard layout.

Loading Keyboard Shortcuts from a File

If you’re working on a new installation or move to a new computer you can load your custom key-mapping file. Go to the Keyboard Shortcuts page on the Settings tab and click Load Key-Mappings. Find your exported key-mapping file then click Open. All your key-mappings are restored.

Printing a List of Keyboard Shortcuts

If you want to print a list of all your current keyboard shortcuts, click View as HTML at the bottom of the Keyboard Shortcuts page. This loads a nicely formatted, searchable view of all the current key-mappings into your browser. From there you can search it or print it using normal web browser features.
Moving On

At this point you should have a good handle on how to customize the keyboard shortcuts in Tracktion. Since T6, Tracktion offers powerful macro scripting you can use to further customize keyboard shortcuts. For more about that, see Chapter 37 - Macros.
Chapter 15 - Recording Audio

Now it’s time to learn how to record your own instrument or vocal tracks into Tracktion. First, you will learn how to configure track inputs for recording. Then, you will learn how to use Tracktion’s built-in metronome to provide a reference click to keep your recordings in time.

Configure the Input

We covered audio device setup back in Chapter 4 - Audio Device Setup. Refer back that chapter if you have any questions about setting up your audio interface.

I will restate the warning here. Before recording with Tracktion you need to use the Auto-Detect feature to establish proper recording sync between playback tracks and newly recorded tracks. This essential step, calibrates the timing offset so that system latency doesn’t throw off the timing of your overdubs. Re-run Auto-Detect test anytime you change your interface hardware or buffer setting. The Auto-Detect procedure is explained in detail in Chapter 4.

**Warning:** To configure Tracktion for recording you must use the Auto-Detect feature along with a hardware loopback. If you don’t then your overdubbed tracks will not be in sync with existing tracks. While this is not difficult, it is essential to do this manual step anytime you change the Audio Device Setup.

The Input Object

At the far left of every track, you will find the input section. Each track has an input object that looks like a rectangular arrow pointing right.

![Track Input Object](image)

**Tip:** If you don’t see the input objects, click the Show/Hide Inputs (Shift + F12) button at the top right corner of the Edit tab.
Show/Hide Inputs Button

Click on an input object to see a menu of options. From the menu, select which hardware input to use for recording to this track. You can set it to No input or select any input from your audio interface. In this case it’s set to Input 1.

Input Menu

When you select an input, the input object shows the input name, a real-time input meter, and the record arm “R” button. Also, a full set of input properties appears in Properties.
Customizing Input Names Globally

If you are happy with the default input names that’s great, however, you can customize them with friendlier names using the Alias property.

To change your hardware input alias names globally, go the Settings tab, Audio Devices page. Select an input in the Channels list and edit the Alias name in Properties.

Customizing Input Names for an Edit

There is another way to rename inputs, but only for the current Edit. In the Edit, select an input and notice the Alias name in the Properties section. Change this to customize the input name for that particular song. I often use this to indicate the mic used in the session.
About MIDI Inputs

Notice that on the input menu, you can choose MIDI interface inputs. There’s really no difference between an audio and a MIDI track. A track can contain Audio clips or MIDI clips. You just need to set the input appropriately and insert the correct kind of plugins.

In essence a track behaves like an audio track if you set an audio input; it works like a MIDI track if you set a MIDI input and insert a virtual instrument plugin.

Setting Up Inputs for Multi-track Recording

It’s very convenient assign all inputs to consecutive tracks using Assign all inputs to consecutive tracks from the inputs menu. It does exactly what the name declares, allowing you to quickly set up for multi-track recording. This is great if you’re setting up to record a show through a digital mixer with a lot of inputs.

Number of Inputs

This feature is something uniquely Tracktion. You can set up more than one input on a single track. Why? Well why not, I suppose. You can have up to four inputs assigned to a track.
Assign up to Four Inputs to One Track!

Now, if you record with more than one input armed, you will get a separate clip for each. This results in stack of audio clips which is not really convenient.

The best use I have found for this is to have several recording chains configured and ready to go when auditioning mikes and preamps. Just arm the input you want to try and away you go. It makes it super efficient to switch to a different mic/preamp combination by simply arming the desired input.

Enable a Track for Recording

To enable (arm) a track for recording, click the R symbol on the input object. The R illuminates to indicate that the track has been armed for recording.

Test the input signal. If you’re using a microphone or a guitar, play a note or have the singer sing something. You should see the meter moving on the input while testing. If not, check your input level on the hardware and make sure phantom power is on if necessary for the mic.

Tip: Once recording has started you can still click R to enable and disable recording on the fly. This allows you to do manual punch-in and punch-out style recording. This was new as of T6. Here is a video I created that explains Punch In/Out on the Fly.³¹

Hit Record

With the input setup done, recording is a matter of clicking Record (R) on the Transport. While recording, Tracktion draws the waveform on the track. To stop recording press Spacebar.

³¹https://w-edstrom.wistia.com/medias/wgjyszl1i6
Recording always starts at the cursor position. There are several ways and options to stop recording which I will explain in a bit.

**Enable Recording for All Inputs at Once**

If you are doing multitrack recording with many inputs you can arm all the tracks at once from the input menu using the option Enable/Disable all devices for recording (Cmd + R / Ctrl + R). You can even use this on the fly during recording to start and stop recording without stopping the transport.

**Input Meters**

Click on an input to select it. Notice the large meter along the bottom edge of the Properties section. This gives you a nice reference for setting up the input level.

![Large Input Meter at the Bottom of Properties](image)

**Tip:** As a rule of thumb, you want to set input level to hover around the middle of the range shown on this meter. The input level is adjusted using the gain controls on your audio interface or preamp.

If you’re doing multi-track recording and you want to see large meters for all the tracks at once, press F12. Tracktion will go into “big meters” mode. This superimposes a very large meter onto each track.

![Big Meters Mode](image)

**Note:** The big meters obscure your view of clips on the tracks so you will want to toggle it off (F12) when not recording.
Drag the Input Object Track to Track

Here’s a really interesting and unique thing about the input objects. You can drag the input object from track to track. Say you recorded something on track one, and now you want to record something else using the same microphone onto track two. Simply, grab the input object and drag it from track one to track two. The set up is done instantly.

![Dragging and Input to other Track](image)

**Note:** Dragging the input track to track is really one of the cooler aspects of Tracktion. Once you start using this feature you will miss it when you record with any other DAW!

Renaming a Track

To rename a track, click directly on the track name, then edit the Name property in the Properties section. A really quick way to do this is to click Name, press Tab, and start typing. As soon as you tab off the Name property or click elsewhere in Tracktion, the new track name will be set.

The reason I point this out now, is that it pays to stay organized during recording. Keeping your tracks and inputs properly labeled is a big part of that.

Recording Steps in Review

Here is a review of all the steps needed to test your recording setup:

1. Arm the track or tracks for recording by clicking ‘R’ on the track input.
2. Make sure Loop is turned off in the Master section.

**Note:** Tracktion supports loop recording but we’ll get into that in a later chapter.
1. Make sure the cursor is rewound to beginning by clicking Return-to-zero (Home) in the Master section.
2. Verify that Click (C) is turned off (for now) in the Master section.
3. Click Record (R) in the Master section. Play something into the input using your instrument or your voice depending on the kind of input selected.

   **Note:** As you record, you’ll see the meters and you’ll also see the waveform start to draw on the Audio clip.

   1. Press Spacebar to stop recording.
   2. To hear what you recorded, click rewind then press Spacebar to play. You should be able to hear what you just recorded.

   **Tip:** If your recorded take just isn’t really going well, you can press Abort or Abort & Restart on the transport. These options only appear during recording.

   ![Abort and Abort & Restart During Recording](image)

### Working with the Click

While recording, it’s often very helpful to have an audible timing reference. Tracktion has a built-in metronome that offers a steady click for just this purpose.

### Enabling the Click Track

To enable the metronome click, turn on Click (C) in the Master section. That turns it on but the setup is in the Click Track Menu. Here are explanations for the options:
Enable Click  
Another way to enable or disable click is to open the Click Track menu and select Turn on click track or Turn off click track. That does the very same thing as pressing C or clicking the Click button in the Master section.

Click Volume  
Adjust the volume of the click using the Click Track > Volume slider. There are also Low volume (-14dB), Medium volume (-4.4dB), and Full volume (0dB) presets available.

Note: Curiously, Full volume is not actually full. The Volume slider goes to +3db. That’s three more than Full volume if you are keeping score.

Count-in  
While recording you can have the click start a bit before the cursor position. This gives you or the artist time to get into the groove before performing. Enable the count-in from Click Track > Pre-record count-in length. Select from none, one bar, two bar, or two beats for the count-in length.

With count-in enabled you will hear the click during recording. If the cursor is at the beginning of the Edit, you will hear the count-in then the cursor will start moving. If the cursor is not at the start, it will actually jump back by the count-in length and play from there. I would call that pre-roll.
Count-in Options

Click During Playback
If you want to hear the click during playback, make sure to leave Click Track > Only click during recording disabled. The wording on this option is a bit backwards.

Emphasize Bars
To clearly hear the downbeat of each bar, enable Click Track > Use loud clicks to emphasize bars. With that enabled, Tracktion uses a different sound for the first beat of each bar.

Click Sound
To change what sounds are used for the click, select Click Track > Change Click Settings. This opens the Click Track Settings dialog box. From here, you can change the samples used to make the click sound. Just select the audio files for the normal and emphasized beats. If you leave the File properties blank, you will get the default sounds.

Configuring the Click Sound

Not too many people still do this, but it’s possible to use an external MIDI sound module for your click sound. If you are inclined to do that, you can set the MIDI note numbers in the Click Track Settings dialog box.

Click Output Device
If you want to redirect your click so it’s not coming through your main speakers, look at the click output device options (Click Track > Output device for click). Normally and by default this is set to Default audio output. You can pick any audio output on your system or even any MIDI output. If you select a MIDI output, it should be a sound module of some sort. When
using MIDI for the click, you can set the click sound note numbers as explained in the previous section.

Using a click is an essential reference tool for studio recording. It is great to have a synchronized click built-in and ready to go.

**Listening on Headphones While Recording**

Ideally, you will monitor what you’re recording through headphones and set up the level and mix on your audio interface outside of Tracktion. Most audio interfaces give you the ability to mix your live input with the playback from previous tracks. You use the mixer on the audio interface to balance the live input sound with the sound being played back by Tracktion.

Simple audio interfaces have a mix knob that allows you to mix between the inputs (your mic) and playback (previously recorded tracks). For example, when recording a vocal leave the mix knob just about in the middle. Half of what you hear is the live input off your mic, the other half is what’s being played back from Tracktion.

Now many audio interfaces don’t have a specific knob on the front panel to control the mixer level. They have an app that you run alongside Tracktion that features a virtual mixer. That app comes from the audio interface manufacturer. It allows you to set up the monitor mix in your headphones...
separately from what’s happening in the recording software. I can’t really generalize more than that. Audio interface control apps vary widely in capabilities and complexity.

Live Input Monitoring

At the risk of seeming fickle, there are situations where you need to use live input monitoring through Tracktion rather than through your interface. The two main use case for that that are when playing through virtual instruments or virtual guitar amps while recording. I will cover the details later in the book. But here are a few points for those curious about such things.

Step 1. Disable Hardware Monitoring
To try live monitoring through Tracktion, first set up a track and arm it for recording. Now, play something into the input using a mic, guitar, or other instrument. At this point you shouldn’t really hear anything through Tracktion to your headphones or speakers.

Step 2. Enable Live Input Monitor
Now make sure the input is selected and look for the Live Input Monitoring option in Properties. Click to enable it. You should hear the input going through Tracktion and back out to your speakers (or headphones).

The downside is latency. You might possibly notice a delay between when you play a note and when you hear it. It’s a time lag between you sing and when you hear it in your headphones. At high buffer settings it will sound like an annoying delay slap or echo. At lower buffer settings it might sound like a hollowness if you are singing with headphones on. When playing an instrument, you might not hear any problem at all.

To really hear the effect of latency, try turning the buffer size up - to 1024 or even more. Then as you play you’ll hear a noticeable delay between when you sing, speak or play a note and when you hear it.

Note: Latency delay is more of a problem for singers than it is for somebody playing guitar or another instrument. The sound of your voice is coupled through your skull right into your ear with zero latency. When combined with your voice slightly delayed through the interface and software the result might seem hollow or “phasey.” This won’t be recorded but might throw you off during recording.

Why then would you ever use live input monitoring? You need it for guitar amp simulators and for virtual instruments. For normal vocal and instrument recording, it’s a lot better to use your audio interface to provide zero latency monitoring.
If at First You Don’t Succeed

With a track armed, hit Record and record away. Press Record a second time (or Spacebar) to stop recording. If you don’t like what you’ve recorded select the Audio clip and press Delete or Backspace. Rewind and try again! You can alternatively press Undo (Cmd + Z / Ctrl + Z) to undo the last recording take.

Tip: When working on my own songs, I liberally delete bad takes. However, when working with someone with talent, I am much more careful to keep all takes. It is pretty easy to mute the audio clips from failed takes and organize them into a folder track. You never know when you might need a word or phrase later.

Abort Record and Delete the Take

If you are impatient to delete a failed recording take, then you will love this one - Abort recording and delete the take. I have that assigned to F4. With a single keystroke you cancel the take, throw it out, rewind to the beginning, and get set to try again. The Abort button on the transport does the same thing. I suggest you stay away from this when recording with clients.

Note: For my own recording I am waiting for Tracktion to implement “Abort Next Take and Delete It.” ³²

There is a variation on this - Abort recording, delete take, and restart. That does the same thing but then drops right back into recording. I don’t use this because I think following an abort it’s usually best to take a breath and think about what you are about to do. This action appears on the transport during recording as the button * *.

³²This was intended to be funny.
Recording a Stereo Signal

If you are recording a pair of microphones or a stereo source like a keyboard, you can treat two adjacent inputs as a stereo pair. This is done in the Settings tab, Audio Devices page. Click on an input then enable *Treat as Stereo Pair* in Properties.

Now instead of two inputs you have one stereo input. That will appear over in the Edit when you select inputs for a track. The pairs are always created with the odd numbered input on the left and the even numbered input on the right.

When you record from a stereo input you’ll wind up with a stereo clip showing both the left and the right waveforms.

Retrospective Record

There are times where you wish you were recording because a practice take was so amazing? Or maybe singer sings a pickup just before the downbeat. Retrospective record actually keeps a recording buffer running for any track that has an input set up.

To enable this feature, from the Menu choose *Option > Retrospective record* and select the buffer size. I find that the 30-second buffer is usually enough to safe-guard against chopped off picks or endings. For live shows or recording speeches I set it to 5 or 10 minutes.
To recover lost audio just click the retrospective record icon in the upper right corner of the Tracktion window. The buffered audio will be added as Audio clips to the appropriate tracks. If you click the icon while the transport is still running, the audio will be synched to the timeline. If you click the icon with the transport stopped, the audio will be placed at the cursor. In that case you will need to manually align the clip to the track.

Retrospective record doesn’t consume much CPU and is a great safeguard against losing important audio or a killer take.

**Safe-Record Mode**

When recording shows, doing long recordings, or if you ever need to leave your computer unattended while it’s recording, consider enabling Safe-Record *(Options > Safe-Record mode)*.

In safe-record mode, you starting recording in the normal way. However, as soon as recording starts, Tracktion shows a the Safe Record modal dialog box. You can’t do anything in Tracktion including stop the recording without entering the four key shortcut.

Here is how to get out of safe-record mode:

OS X: Shift + Opt + Cmd + R  
Windows: Shift + Alt + Ctrl + R

Those are the defaults, but you can change those to any other crazy key combination you want.
Moving On

That was a lot of information about recording audio in Tracktion. In the next chapter we will continue on with overdub recording.
Chapter 16 - Recording Overdubs

In this chapter we walk through an example of recording a simple song. In the previous chapter, I explained how to use the Click feature to hear a metronome tempo reference while recording. In this chapter we will use a drum loop instead. Later you will learn the steps to overdub guitars and bass to create a simple tune.

Tip: For overdub recording, you typically do all the recording wearing headphones with your main speakers off. This prevents bleed from one track to the next for cleaner mixing later on. If you are engineering for another artist, then you will need to split the headphone signal so both of you can wear headphones during the process.

Here are the tracks we will have by the end of the chapter:

- Track 1 - Drum Loop
- Track 2 - Acoustic Guitar
- Track 3 - Acoustic Guitar - Double
- Track 4 - Bass

Set up the Drum Loop

1. First, set the desired tempo. Click on the tempo (e.g. 77 bpm) in the Master section. Then click on the BPM value in Properties and type in the tempo.

   ![Click BPM to Edit Tempo](Image)

2. Drag in a loop from the Browser. I am using a two bar loop. This will create an Audio clip. I used Track 1 for the loop which I renamed to “DrumLoop.”

   ![Start With a 2-Bar Drum Loop](Image)
Tip: If the loop doesn’t align to the bars correctly, hold Opt / Alt and drag the right trim arrow until it does.

1. Click the L icon on the Audio clip to convert it to looping mode. Now drag the right trim handle to roll out as many copies of the loop as you want.

![Roll Out Repeats of the Drum Loop](image)

Get Ready to Record

1. Set up the input. In this example, my drum loop is on the first track, I used the second track for recording the acoustic guitar rhythm part. I selected Input 1 where my mic is connected. Phantom power is enabled on the interface since I am using a condenser mic.

![Configure the Input](image)

1. We won’t use loop recording, so make sure the Loop button is turned off in the Transport section.
2. Turn off Click because we are using the drum loop track for the timing reference.
3. Let’s use a two bar count-in. To set that up, select Click Track > Prerecord count-in length > Use 2-bar count-in.

Record the Rhythm Guitar Part

1. Use your audio interface mix knob or app to balance the level of the guitar mic with the level of the drum loop track. On the guitar mic input, make sure Live Input Monitoring is turned off.
2. Next, arm the track for recording by clicking the R icon on the input. When you try this you will see the metering on the input moving if you play a chord.

3. Test the input level by playing at the loudest level you plan to use for the track. Adjust the level using the gain control on the audio interface.

4. Verify that the cursor is at the beginning of the edit. If not, press Home.

5. Press Record (R) on the Transport to start recording. Now record a take of your song. At the end hit Spacebar to stop recording.

![Recording the Guitar Part](image)

**Tip:** If recording doesn’t go as planned, delete the Audio clip and try again. I went over several ways to do this in Chapter 15.

**Note:** If you hear some kind of weird phasing as you play your instrument, then it probably means you have Live Input Monitoring enabled while also monitoring through your audio interface. Disable Live Input Monitoring.

### Doubling the Rhythm Guitar

1. Following recording the initial rhythm guitar part, rewind and play it back. Use the Volume & Pan plugins in the mixer section to balance the signal with the drum loop.

2. To double the rhythm guitar, drag the Input object to the the next track. Now track 3 is immediately ready to go for recording an overdub.

**Tip:** You might want to lower the original track 3 to 6 dB using the Volume & Pan plugin to better balance the recorded track with your live mic.

1. Rewind then click Record in the Transport.
1. After recording, play back and balance the new recording with the original guitar track. To get a wide stereo effect from the doubled part, pan the tracks to opposite sides using the Pan slider from the Volume & Pan plugin.

**Overdub a Bassline**

When I wrote this, I recorded the bass by connecting it directly to the audio interface - no amp, no mic.

**High Impedance Inputs.** Identify which input on your interface supports a direct 1/4” high impedance input. This is often indicated by the guitar, gtr, or hi-z. Sometime you need to engage a switch or button for the high impedance mode. Your bass or electric guitar will sound better if you have the hi-z mode enabled.

1. Connect your bass to the interface using a normal 1/4” to 1/4” guitar cord. For my setup, I selected Input 2 which has a high impedance switch.
Engage High Impedance Mode on Your Audio Interface

1. From this point, recording works exactly the same as with a mic. Select the correct input and adjust the input level. Make sure the bass has a good level but is not activating the clip LED on the interface using the gain knob on the audio interface.

2. Arm the input for recording if it’s not already. Adjust the levels of the existing tracks so that you can hear the tracks. At the same time, you want to hear what you are playing on the bass.

3. Rewind and hit Record. If the take doesn’t go well, stop, press Undo and try again.

Overedubbed Bass Line

Tip: If you get a good take but think you can do better, don’t delete the clip. You can drag the input to another track and try again. Just mute the original track or clip so that you don’t hear it while recording the next take. The first take might wind up being the best take!

Rename Tracks

As you record overdubs, it’s good idea to stay organized. One key is to name the tracks appropriately. Click directly on the track name then edit the Name property.
Tip: It can get annoying when renaming several tracks. You keep mousing between the track and the Properties section. To avoid all the extra mouse mileage, click the track name then press Tab. Tab puts the focus directly on the Name property ready for typing.

Adding Additional Tracks

If you get to this point and you do not have enough tracks in your project, you can easily add tracks. There are several ways to do that.

1. **Press T.** Select any existing track and press T. That creates a new track directly below the selected one.
2. **Right-click.** Right-click in any blank space or on any track and select *Create new track.*
3. **Track Menu.** Another way is to select *Tracks > Create a new track.* using the Tracks menu. Or, select *Tracks > Create several new tracks* to add up to sixteen new tracks in one go.

Tip: Like most things in Tracktion, you can undo creating tracks using the *Undo* button (Cmd + Z / Ctrl + Z). To remove a track from your project, select it and hit Delete or Backspace.

Rearranging Tracks

To rearrange the tracks, drag the track from the track name area and drop it in the new position. As you drag the track, a glowing bar will appear between tracks showing you the target for your drop. When that bar is in the right spot, let go of the drag and the track will be repositioned.
Adjust the Mix

At this point you can adjust the levels of all the recorded track or continue to record and overdub vocals, keyboards, or other instruments. As you add more tracks, you will need to reduce the level of each to avoid overloading the master level.

Tip: If you temporarily overload the master meter, you can reset the overload indicators using the backslash key (\).

Moving on

That was a walk-through of overdubbing. At this point, you should be getting familiar with basic recording in Tracktion and have a handle on how to work with tracks in Tracktion.
Chapter 17 - Clean-up Editing

After you have some basic tracks recorded, you can use the Tracktion editing tools to clean up the clips and fix small problems with the takes. We covered Audio clip editing in Chapter 12. In this chapter I will show you a few practical examples of how to use them.

**Note:** Sometimes it is easier to make timing edits if you move the part you’re working on near the drum part. That way you can see the timing of your notes compared to the timing of the essential rhythmic elements of the song.

### Trimming

The trim handles are a great way to clean up the beginning and ending of recording takes. Trim the beginning to keep the track silent until the part actually comes in. Then trim the end to silence any extra noise that happens after the song is done.

To use the trim handle just grab and drag. If you leave *Snap* on, trimming will snap to the grid. With *Snap* turned off, you can trim freely.

**Tip:** You can temporarily override snapping by holding Cmd / Ctrl while trimming.

You can also trim multiple Audio clips at the same time. Just select several clips using Opt-drag / Alt-drag and then adjust the lengths using the trim handles on any of the select clips.
Correcting Small Timing Problems

Bass Note Timing is Early

Look at this example baseline compared to the drum loop. One of the bass notes is early. Ideally, you would re-record this part. If that’s not an option you can easily correct small issues like this. The strategy is to separate the out-of-time note to its own Audio clip, then move it slightly.

1. Turn off Snap.
2. Select the Audio clip you want to fix.
3. Position the cursor just at the beginning of the note that needs fixing and press slash (/) to split the clip.

Split the Beginning of the Note

1. Position the cursor just after the note and press slash (/) again. The bad note is now separated to its own Audio clip.
Chapter 17 - Clean-up Editing

1. Click to select the single note. Trim the clip to shorten it a bit.

Note: I like to do this with Snap turned off. This sort of editing doesn’t need to be absolutely perfect. I generally want to correct something that is obviously wrong but not every single note.
1. Complete the edit by trimming and crossfading into the other notes.

The Completed Correction

Splitting & Selecting. Right after you split a clip, you’ll notice that the two resulting clips are both selected. If you trim, slip or move a clip the action will apply to all selected clips. That might not be what you want. To select a single clip, just click one of the clips. At any time, you may hit Escape to de-select everything.

Correcting Timing by Slip Editing

Another way to correct timing is with slip editing. With this approach you “slip” the waveform within the Audio clip rather than moving the clip. The key to this approach is to put the initial split exactly where you want to the note to start.

1. Turn Snap off
2. Zoom in enough to see where the note should start and select the clip to fix.
3. Position the cursor at the exact spot you wish the note had started and press slash ( / ) to split the clip.

Split the Clip Where the Note Should Start
1. If the note was early, trim back the previous clip to get rid of the extra bit.

Trim Back the Extra Bit From the Previous Clip

1. Position the cursor at the end of the note and press slash to split it again. The bad note will will have a separate Audio clip.

Split After the Note

1. Select only the note you want to adjust. Grab and drag the slip handle (solid box). The waveform will slip within the window of the Audio clip. Align the waveform so it starts just after the leading edge of the clip.

Drag the Slip Edit Handle to Adjust Timing Within the Clip
1. Clean up the edges with trimming and crossfading.

The Completed Edit

Note: If you have automatic crossfade turned on then as you move one clip to overlap another, a crossfade will be created automatically. See Chapter 12 for more about crossfades.

Fade-outs

You can also adjust the fade-outs at the end of takes simply by using the fade handle and dragging it to the left for each track appropriately.

Remember, you can adjust the shape of the fade-out by selecting one of the four preset shapes in the Properties section.
Stretch an Ending Note

If a note at the ending isn’t held out long enough, you can apply a time stretch quite easily. Re-recording the take would be preferable, but if that’s not an option, here’s how you can do a quick time stretch to lengthen an ending note.

1. First, separate out the note that you want to stretch using split as in the other examples.
2. Hold Opt /Alt and drag the right trim handle to extend the note to the desired length.

![Image: Hold Opt / Alt While Trimming to Stretch a Clip]

1. Audition the playback to make sure that it sounds clean. The more you stretch it the more chance you have to degrade the audio quality, but you might be surprised at how well this really works.

**Note:** Besides just simply cleaning up the takes, you can do detailed editing on Audio clips to completely change the timing or even the arrangement. While writing songs, I use these tools to compose bass lines that tightly lock in with the drums. I do this by adjusting the timing, removing notes, or shortening notes. It all depends on the nature of your music production. When I am writing a song, I used these tools to try many different ideas.

Fixing Clicks at the Edit Points

When you do this type of editing, you might occasionally hear a click at the beginning or ending of a clip. This occurs when you split across a waveform that’s actually got some energy present. You can easily correct those by putting a very tiny fade at the beginning of the clip.
You could zoom way in and add tiny fades to the beginning and ending of each clip. The easier way is to select the clip and click *Apply Edge Fade* in Properties. This instantly puts 7 ms fades at the beginning and ending of all selected clips.

Rendering to a Single Audio Clip

If clean-up editing leaves your track looking like a shredded mess, you can quickly render all the clips back to a single clip. Here is how to do that:

1. Select all the clips you want to combine to one clip. One way to do that is to click the first clip, hold down Shift, then click on the last one.

1. In Properties select *Render Clips > Merge the selected clips*. In Tracktion 6, merging is a single command, which is a great enhancement to the workflow.
Moving On

Those are some of the basic techniques you can use to clean up your recorded tracks. Use these techniques to trim clips, apply fade-outs, make minor timing adjustments, and then render all the changes to a single clip.
Chapter 18 - Warp Time

Warp Time is an audio editing option that was introduced in T6. Rather than needing to split out notes to move them as discussed in the previous chapter, you can drag Warp points to bend and stretch audio into time. Apart from simply correcting timing problems, you can apply it creatively to compositions and loops to alter the feel of recorded audio.

The implementation is actually very simple. You can get up and running with Warp Time very quickly.

Tip: Since T7, Warp time is also available as one of the Clip Layer Layer effects as described in Chapter 41

Warp Time Mode

Here is how to switch into the Warp Time mode:

1. Select an audio clip
2. In Properties, go to the Loop Properties tab
3. Enable the Warp Time option

Enable Warp Time Mode

The waveform view on the Loop Properties tab switches to the zoomable Warp Time editor.
The Warp Time Editor

The Warp Time Editor is working on the underlying audio in the clip so there might be much more audio shown than you see on the Audio clip. This will usually be the case if you have trimmed the Audio clip beforehand.

Tip: If you want the Warp Time editor view to exactly match the waveform on the selected Audio clip, render the clip using Render Clip > Flatten the selected clip. This will create a new underlying file. After that, what you see and hear in the Warp Time editor will match what you see and hear in the Audio clip.

Zooming In & Out

To zoom the waveform, use the mouse scroll wheel. On many laptops you can use a two finger up/down gesture in place of a scroll wheel. On Mac laptops you can also use a two finger left or right gesture to slide the waveform left and right.

Warp Points

Click on the timeline to add a Warp point. When you drag a Warp point left or right, time is stretched or compressed between that point and next surrounding Warp points.

Tip: You can add a Warp point and drag in a single action. Just click on the timeline, hold and start dragging. The waveform will stretch until you stop dragging.
Removing Warp Points

Shift-click any existing Warp Point to remove it. Right-click any existing Warp point for options to rename it or remove all Warp points.

![Warp Point Right Click Menu](image)

Working with Warp Points

By default, the Warp Time editor will always have starting and ending Warp points. If you add a Warp point and move it, the audio will be stretched between the beginning and ending of the wave.

![Before Warping](image)

![Dragging a Warp Point to the Left](image)
Dragging a Warp Point to the Right

To correct audio timing over a constrained area, you can think about a three point technique. You typically want to add Warp points just before the beginning of notes or percussive hits. That would be just before a transient. If you do that then stretching occurs over the note not in the middle of it.

With the three point technique, you insert Warp points before and after the note you want to alter to lock down the timing. Then add a Warp point right at the transient you want to change and drag it into to time.

**Warp Points and Snapping**

As you drag Warp points, you will notice they snap to the grid. The snap grid for Warp points is based on the zoom level of the Warp Time editor, not the zoom level of the Edit.

To override snapping when adjusting Warp points, hold down Cmd / Ctrl as you drag the points.

**Limitations of Warp Time editing**

Warp Time editing works best for single track parts. If you use it on multitrack drum parts, you will find it seriously affects the phase alignment of multi-miked drum kits. This is the same for other instruments that are recorded with multiple mics.

You can use Warp Time on stereo tracks. If you have two mono tracks, first render them to a stereo track before using Warp Time.

**Time Stretch Algorithm**

By default Warp Time uses Elastique Pro but you can switch it use any of the other modes if you want. There is very little benefit in selecting other modes since Tracktion does the actual stretching offline.
Most of the time, Elastique Pro will give you the best results. If you have specialized needs, you can experiment with the other Elastique options under the spanner icon.

Note: If the Stretch property is set to “Melodyne” or “No Time-Stretching,” Traktion still uses the Elastique Pro algorithm for Warp Time.

### Moving On

I created a video demo of Warp Time that you might find interesting:

Warp Time Video Demo

Warp Time, the standard editing tools, and Melodyne give you amazing potential to manipulate the timing of your Audio clips.

---

33https://w-edstrom.wistia.com/medias/8klw4eess4
Chapter 19 - Loop Recording

Loop recording is a really cool way to quickly record multiple takes of a part onto a single track. Following loop recording, you can easily pick the best take and make it active so that it is the one you hear during playback.

Loop recording also sets you up to use the track comping tools that are built into Tracktion. Comping allows you to go phrase by phrase through the different takes and choose the best parts and create a composite best take. We cover comping in detail in Chapter 20.

Getting into Loop Recording Mode

Getting into loop recording in Tracktion is simple - enable Loop (L) in the Transport. Now when you click Record, recording will only occur between the In-marker and Out-marker. The transport will “loop” between the In-marker and Out-marker allowing you to automatically record take after take until you hit Stop.

Turn on Loop for loop recording mode

Loop Recording Step-by-Step

1. Set the In-marker and the Out-marker over the range that you would like to do the loop recording. To set the In-marker, position the cursor and press I. To set the Out-marker, position the cursor at the end of the loop and press O.

Set the In-marker & Out-marker

>Note: The Click count-in works for loop recording. If you want a running start for each take, set Click Track > Pre-record count-in length to one or two bars.
1. Configure the input and check your levels just like we did for standard recording.

![Configure the Input for Recording](image)

1. Click *Record (R)* on the transport to start recording.

While recording when the cursor hits the Out-marker, Tracktion will automatically loop back for the next take. You can do as many takes as you like. I usually do five or six, but you could record 20 takes or more if you feel like it.

**Selecting the Best Take**

After loop recording, you will have a number of takes stacked within the Audio clip. The very last take you recorded is what you will hear during playback. That is called the “active take.” To select a different take for the active take, click the plus (+) sign in the lower right corner of the clip. You will see a list of all takes there. Pick the one you want to promote to the active take. You can audition all the takes and make your favorite one the active take.

![Choosing the Active Take](image)

**Tip:** With your takes recorded this way, it is perfectly set up for comping, which we will cover in the next chapter.
Unpacking Takes to Tracks

If you want to work with your loop recorded takes as separate audio tracks, it is easy to unpack the takes to tracks. To do that, click the plus (+) sign and then select *Unpack to new tracks*.

That instantly converts an Audio clip full of takes to a series of tracks containing separate Audio clips. Now you can use normal audio editing to move them around, chop them up, or arrange them into a song.

Moving on

The secret to loop recording is to set the In-marker and Out-marker over the section you want to record, make sure *Loop* is turned on, and then record like you normally would. Loop recording also sets you up for comping which is up next! Turn the page.
Chapter 20 - Comping

In this chapter, we’re going to go over the cool comping features in Tracktion. Comping is an editing technique where you select the best phrases from numerous takes to build a composite or “comp.” The idea is to create the best possible take. Engineers have been doing this for years, but Traction makes it much easier than the traditional methods.

Comping typically starts with takes recorded in Loop mode. I covered that in Chapter 19 - Loop Recording.

Loop recording you used to be a prerequisite for doing comping. Starting with T6, Tracktion also allows you build composites from any collection of tracks using the new Comp Groups feature. More on that later in the chapter.

Copy Your Edit

Before you start comping, it is a good to create a copy of the Edit. This is so you can return to the raw takes if you want to do the composite a different way.

Note: I am assuming that you already recorded using the technique in the previous chapter. If not, go back to Chapter 19 and get some takes recorded!

1. When you finish loop recording, make sure to save the Edit with Save > Save edit (Cmd + S / ctrl + S).
2. Go to the Projects tab and select the correct Edit. In the Controls panel, click Create a Copy.
3. I like to keep the Edits organized by adding a revision number. Do this by clicking on each Edit, then editing the Name property.
4. On the original Edit, add a comment that says, “This version is before comping” or similar.
5. Close the tab for the original Edit and open the new copied version.

Strategically creating copies of your Edits and naming them in a logical way, works like a revision control system. You can always roll back if something goes wrong or if you just change your mind.
**Comping Takes**

Now that everything is setup, it’s time to get to the creative, fun part of the process.

1. Select the Audio clip that contains the takes you want to comp.

1. Click on the plus (+) icon in the lower right corner of the clip and select *Show takes*. That expands the clip to show all of the individual takes. If you play back over this section of the Edit, you will hear the very last take you did during loop recording.
1. To build a composite take, click and drag a range over a phrase from any take. That phrase is instantly promoted to the active take. This drag-to-select action is called “swiping.”

Tip: While comping, sometimes it’s helpful to have the cursor return where you started playback whenever you stop playback. Do that by enabling Options > Return cursor to start position when play stops. This makes it easier to audition phrase by phrase without needing to constantly reposition the cursor.

1. Continue swiping and auditioning to build up the composite. If you want to switch a selected phrase to a different take, just click another take. The selection instantly moves to that take.
1. If the swipe selection doesn’t fully enclose a phrase, adjust either edge of the selection by simply dragging the edge to trim it.

Note: While comping sometimes you’ll use a little bit from every take. Other times you’ll predominantly use one take and just fix a couple of bad phrases.

Once you finished, click the plus (+) icon and select *Hide takes*. At that point, you’re finished comping!
Tip: After comping, it is a great time to create another copy of the Edit and add a note that this was saved after comping. This gives you the option to roll back if you ever want to make some changes.

**Flatten Comp**

If you feel compelled to remove the underlying takes from the Edit, click the plus (+) icon on the clip and select *Flatten current comp*. This gives you the option to delete the source files. Keep in mind that this operation is permanent.

Tip: Don’t flatten the comp without first saving a copy of the Edit. Also, I would not recommend selecting the option to delete the source files. This will remove them for your other saved Edits.
Setting up a Comp Group

T6 introduced *Comp Groups* that allow you to use swipe comping with any group of tracks. This works similarly to the techniques described above for comping takes. The difference is that you first add the tracks involved to a Comp Group.

Select Tracks to Comp

Select all the tracks you want use to build the composite. These are typically recorded as various takes of a lead vocal or solo instrument. However you can use any collection of tracks you want.

Create a Comp Group

In Properties, open the *Comp Group* menu and select *Add group*. This opens the *Comp Group Name* dialog box. The name will default to *Comp Group 1* which is fine. You can change it to something more descriptive if you want. Click *OK*.
Add a Track to a Comp Group
Any tracks pre-selected at the time you created *Comp Group 1* are automatically added as you create the Comp Group. To add another track to *Comp Group 1*, select the track, open the *Comp Group* menu and select *Comp Group 1*.

Removing a Track from a Comp Group
To take a track out of a comp group, first, select the track. In the *Comp Group* menu, select *None*.

Comping Tracks Using a Comp Group
With some tracks added to a Comp Group, it is easy to start comping.

1. Select one of the tracks then in the *Comp Group* menu select *Show Editor > Edit track comps*. This puts the tracks in comp mode.
1. Now you can start swiping to select phrases from any of the tracks. On playback only the selected phrases are played back.

![Swiping Phrases to Create a Composite](image)

1. You can adjust the window of your selection by dragging either edge of range. This works very similarly to comping takes which we covered earlier in the chapter.

   **Tip:** If you want to have good control over the silent parts of a comp, it helps to add a blank track to the Comp Group. For the parts you want to silence just swipe over that range on the blank track.

**Comp Group Editor**

Here are few more things to know about the Comp Group Editor.

**Show Track Comps**

When you enable comp group editing using `Show Editor > Edit track comps`, another option, `Show track comps` is also turned on. This enables the color coding of the swipe selections on the tracks. You can turn this on separately if you want. This way you can see the comp selections but leave `Edit comp groups` turned off so you don’t accidentally change them.
Show Track Comps

**Render Comp**

When you have the composite complete, you can render the result to single track. The *Comp Group* menu gives you two options for this. *Render and replace comp group* replaces all the comp group tracks with the resulting track. *Render comp group to a new track* leaves the existing tracks in place and adds a new track with the composite.

**Add, Rename, Remove**

These options on the *Comp Group* menu give you all the features need to manage your comp groups.
Comp Group Management Features

One interesting thing about comp groups is that you can have as many of them active in the Edit as you want. There are many uses beside typical comping. I often comp silence with tom tracks instead of gating. Comping is also fast way to mash up two beats or two different songs.

**Moving On**

The comping features in Tracktion are very easy to use. As you are learning Tracktion make sure to explore these powerful features.
Chapter 21 - Using an Amp Simulator Plugin

In this chapter, you will learn how to use an amp simulator plugin while recording direct with an electric guitar in Tracktion. Out of the box, Tracktion doesn’t include an amp simulator plugin. However, most of the third party amp simulator plugins will work. If you don’t have any of these, there is a great sounding free amp sim plugin from Voxengo called Boogex. I used that when preparing this chapter. You can download it from [Voxengo.com](http://www.voxengo.com/product/boogex/).

Free Boogex Amp Simulator from Voxengo

Setting Up the Track

Here is the setup:

1. Connect your guitar to the high impedance input on your audio interface as described in Chapter 16. If your interface doesn’t have a guitar input then use a suitable preamp.

[^34]: http://www.voxengo.com/product/boogex/
Connect Your Guitar to your Interface

1. Create a new track, select the input, and arm it for recording.
1. Make sure that direct monitoring of your signal though the audio interface is turned all the way down or disabled. To make this work you need to monitor 100% of your guitar signal through Tracktion.
1. Select the input and turn on *Live Input Monitoring*. At this point you should be able to hear your dry unprocessed guitar signal.
1. Open the Browser and go to the Search tab, and type in a few characters of the name of your amp simulator plugin. Drag the plugin to the mixer section.

1. If the UI window for the plugin didn’t open, double click it. If you have Live Input Monitoring enabled you should hear sound through the plugin when you play. Select a preset and it should sound like you are playing through a guitar amp, maybe even amps, effects, cabinets, whatever your plugin simulates.

Tip: To bypass the plugin just click on the plugin to select it and press F. You can also enable or disable it using the Enabled control in Properties. The shortcut F will enable or disable any selected plugins.
Recording with the Amp Sim

At this point, recording works the same as before.

1. Record-enable the track, make sure the cursor is at the beginning.
2. Click Record in the Transport. If you want to do loop recording then have Loop on and then you can record several takes in a quick succession.
3. Once you have actually recorded the part, you can still tweak the sound.

A big advantage of recording this way is the ability to tweak the sound after the fact. You can also record using an endless variety of guitar rigs that you don’t own. Plus, you can do this without disturbing the neighbors!

An important but subtle advantage is when you go to edit your guitar tracks. Edits that occur before the amp and distortion sounds more natural and are way less apparent when you edit a fully processed guitar part.

Guitar & Impedance

Guitars connect to your audio interface through a quarter-inch, unbalanced connection. This is a high impedance connection. It might not be super important to understand what that means electrically. You will get a better tone and feel if connect to a proper high impedance input. It’s just the nature of guitar pickups. Going into a standard input loads them down and you lose articulation and punch. On most audio interfaces, the first one or two channels of the interface have guitar inputs. Many times there is a switch or button to enable high impedance on those channels, meaning that it will accept high impedance pickup like a guitar or bass. So while your guitar might actually work through a normal low impedance input, it is going to give you better picking dynamics and tone if you go through the high impedance input and have the high impedance mode engaged.

Managing Latency

When working with guitar amp simulators, latency can be a factor. If you have the Audio buffer size set too high, you get a big delay between when you play and when you hear a note. If you set it
too low the you might get pops and clicks if the computer doesn’t have adequate time to process the sound. The challenge is to find a good setting the feels responsive but still has perfect sound quality. Latency is determined by *Audio Buffer Size* parameter. Here is how to set that:

1. Navigate to the Settings tab, Audio Devices page.
2. Locate the *Audio buffer size* setting. The value shows a number of samples followed by a calculated latency delay.
3. Enter an *Audio Buffer Size* value. Values around 256 or lower tend to work pretty well depending on what else is going on in the Edit.

### Speed of Sound Through Air

Here is some background on the impact of the buffer size. In this example a buffer setting of 256 samples offers 5.8 ms of latency.

What this means is that when you play a note on your guitar, you are going to hear the sound about 5.8 ms later. Now the speed sound through air is about 1 ms per foot (1ms per .3 meters). A 5 ms delay would be similar to playing your guitar amp if it were 5.8 feet (1.8 meters) away from your ears. You would need to add in the actual distance from your monitor speakers as well. If your speakers are two or three feet away, it might be like having your amplifier nine feet away. Most guitar players can deal with latency delay in that range. It’s similar to the distance you would be standing from your guitar amp on stage. If it starts getting much longer than that, then you are going to hear a noticeable lag and that will affect the feel and potential impact your playing.

As another example, if you have your *Audio buffer size* set to 1024 samples that gives you 23 ms of delay, That is going to give you the feeling of playing with your amplifier 23 feet (7 meters) from your ears. That is going to be really hard to work with.

Why not just set the buffer size as low as it will possibly go? That could affect the performance of the computer. If you get the buffer size too low, especially if you have a lot of other plugins and other virtual instruments going, the playback might halt or it might not sound clean.

> **Note:** It’s always a balancing act between setting the buffer size as low as possible to get the latency down while keeping it high enough to have clean, solid playback. I usually leave it set at 256 samples for my computer that works very well. When mixing, I increase it to approximately 1024 mostly because that is required for Melodyne ARA.
Dialing in the Guitar Tone

You can dial in your ideal guitar tone using the controls on the amp simulator. Flip through the presets or start with a preset and tweak the controls until you get what you like. Keep in mind, one of the powerful things about recording guitar this way is you don’t really have to commit to the sound at this point. Just dial in something that’s inspiring so that you can get a good performance. You can always come back and tweak the amp settings later.

Using a Tuner Plugin

If you are recording direct with a guitar or bass, you might want to add tuner plugin before the amp sim. Tracktion does not include a native tuner, but if you have a tuner plug-in, you can just drop it into the effects section of the mixer for the track. That will give you a quick and easy way to tune up.

Tip: If you don’t have a tuner plugin, consider downloading one as part the the MFreeEffectsBundle from Melda Production.\(^\text{35}\)

Assuming you have a tuner plugin available, here is how to get it going:

\(^\text{35}\)[http://www.meldaproduction.com/plugins/product.php?id=MFreeEffectsBundle]
1. Open the Browser, go to the Search tab. Make sure Plugins is selected from the search options drop down menu. Type in a few characters of the name of your tuner plugin. The plug-in will show up in the search list.

2. Drag the tuner and drop it in the plug-ins area of the track. Normally, as soon as you drop it, the user interface window will pop open. If not double click the plugin to open the UI.

3. Play a note on your guitar. If the tuner does not respond make sure to arm the track for recording and enable Live Input Monitoring. This is necessary for the signal to flow through the track to the mixer section and to the tuner plug-in.

Tip: To keep the plugin open, click the pin icon in the upper right corner.

When you are finished with tuning, click the red X in the upper left corner of the tuner to hide its user interface.

Note: In earlier versions of Tracktion, Live Input Monitoring was called “End to end monitoring.” It has been renamed to reduce confusion about this feature.

Moving On

You can always record in the traditional way by miking your guitar amplifier. It's also interesting to split your guitar signal and record the direct signal along with your miked guitar amp. That way you can blend the sound of the amp sim with the real amp when mixing.
Chapter 22 - MIDI Setup

We’re going to move on to MIDI recording and editing in this and the next few chapters. The first step is to set up a MIDI keyboard so that you can play notes into Tracktion. If you don’t have a MIDI keyboard, you can enter notes manually into the MIDI editor, or you can use the computer keyboard as a virtual MIDI device.

The setup is quite simple. I am using an USB external keyboard controller but the setup works much the same for other types of controllers. Specifically I’m using a CME Xkey³⁶ keyboard for this walkthrough.

MIDI Drivers

Before you dive in here, you might need drivers for your controller. Check the manufacturer’s website for drivers for the controller model and your operating system. With Tracktion closed, download and install the drivers. Once you’ve done that, the rest is easy.

Set Up the MIDI Inputs

Go to the Settings tab, MIDI devices page. You will see a list of all available MIDI inputs and outputs that are connected to your system. In this example I have four of them. To enable the MIDI inputs and outputs, click to toggle between Enabled and Disabled next to each entry.

Tip: If you don’t see your devices listed, make sure the controller is connected and has power. If that checks out, then make sure the latest drivers are installed. At any time you can click Refresh. Refresh initiates a scan for connected MIDI devices.

³⁶http://www.cme-pro.com/xkey-tour/
Naming MIDI Inputs/Outputs

From the Settings tab, MIDI Devices page, click on a MIDI input or output in the MIDI devices list. Notice that in Properties, there is an Alias value. Edit that to give your MIDI input or output a friendly name. I often make this match the name of the controller that is connected.

Tip: You can customize Alias for a specific Edit, by selecting the input in the Edit tab and changing it in Properties. Changing Alias on the Edit tab takes precedence over the Alias property in the Settings tab.

Disabling Unused MIDI Inputs

Your audio interface might also include MIDI in and out hardware connections. Those allow connecting legacy controllers that don’t support USB. If you don’t plan to use the hardware MIDI in and out connections, you can leave them disabled. In this example I have disabled.

This hides those from the selection list when setting up a track.

Configuring the Track

Back in your Edit, choose a blank track or create a new one.

1. Click on an input and select the MIDI input that matches the controller you just configured.
1. Play some notes on your keyboard. You will see the meter registering the MIDI activity on that track.

With this done, MIDI events come into the track from your keyboard and the pass through to the virtual instrument that we’re going to setup next.

**Insert a Synth Plugin**

To hear what you play, you will need to insert a virtual instrument. Use the *Browser Search* tab to locate a synth plugin. In this example I’m using the Tracktion FM Synth.
1. Insert your synth plugin ahead of the *Volume & Pan* plugin. By ahead, I mean ahead in the signal path. So in this example, I dropped *FM Synth* to the left of *Volume & Pan*.

1. Play some notes on your keyboard and at this point you should hear synth notes.

**Note:** There is no difference between a MIDI track and an audio track in Tracktion. To configure a MIDI track, just set a MIDI input and insert a virtual instrument plugin as a sound generating source. Then, as you record your performance, you’ll create a MIDI clip instead of an audio clip like we did in the previous examples.

### Using a Virtual Keyboard

If you don’t have a physical MIDI keyboard, you can use your computer qwerty keyboard to play notes. Here is how to set it up:

1. Go to the Settings tab, MIDI Devices page
2. Click *Create New Virtual MIDI Input*
Create New Virtual MIDI Input

1. Enter a name such as ‘Qwerty Piano’ into the Virtual MIDI device dialog box

Name the Virtual MIDI Device

1. Back in your Edit create a track
2. Choose Qwerty Piano as the input

Select the Virtual Device as the Input
1. Notice the piano keyboard along the bottom of the screen. To play the keyboard first click on any key with the mouse then use keys A,S,D,F,G,H,J,K,L as white keys. Use W, E,T,Y,U,O,P as black keys. This virtual keyboard lets you play notes in the range from C4 to E5.

Tip: Click the ‘lock’ icon in the upper left corner Properties. This locks the Tracktion keyboard to the Virtual MIDI Piano feature. Also, when attempting to record, it helps to start recording using a keyboard shortcut. If you click record, the qwerty piano loses focus until you click a key on the virtual keyboard.

Note: When you are finished using the virtual keyboard, unlock Properties by clicking on the lock icon again. It will stay stuck on the virtual keyboard until you do that.

Moving On

In the next chapter, you’ll learn how to record a MIDI performance onto the track!
Chapter 23 - MIDI Recording

In this chapter you’ll learn how to record a MIDI performance from your controller. Your controller could be a keyboard or any other sort of instrument that you can use to generate MIDI note data. We covered how to set up a MIDI controller in the previous chapter.

In this chapter, we’ll go further and cover the details of how to record your MIDI performance. You will also learn about the various MIDI recording modes. The MIDI implementation in Tracktion is fairly comprehensive while also being quite easy to use. Let’s get started.

Setting up a Track

There isn’t a special type of MIDI track in Tracktion. Any track can be used for audio, MIDI, or Step Clips. To record MIDI, pick any unused track or create a new track. On the track, set up the input by selecting your MIDI controller. Play a few notes on your MIDI controller to see if you have MIDI activity.

To hear any sound you’ll need to insert a virtual instrument. Do that by dragging the plugin object to the mixer section, or search for the synth plugin in the Search tab on the Browser. When you find it, drag it over to the mixer section of your track. I usually drop it to the left of the Volume & Pan plugin. As soon as you drop it, the user interface will open up for the instrument plugin. Choose a suitable preset for the part.

We covered all this in the previous chapter. If when you play notes on your controller you don’t hear anything, go back to Chapter 22 and make sure the MIDI input is set up correctly.

Recording a MIDI Performance

Recording MIDI is very much like recording audio:

1. Enable the track for recording by clicking the red R on the track input
1. In the Transport, click the red *Record* button to start recording. You can also do this using the keyboard shortcut R.

1. Record your MIDI performance

1. To stop, either press R again or just hit the space bar.

Tip: To record your MIDI performance with a metronome click, configure and enable *Click* using the procedure outlined in Chapter 15.

**Playing Back a MIDI Performance**

If everything went according to plan, you’ll have created a MIDI clip. Notice, the MIDI notes on the clip. If you zoom the track vertically, the MIDI clip will at one point flip to the MIDI editor mode. In this mode, you can edit MIDI notes which we cover in *Chapter 25 - MIDI Editing*.

Position the cursor before the newly recorded MIDI clip and hit spacebar again to playback. You should be able to hear the exact performance.
Tip: If you don’t like what you recorded, simply select the MIDI clip and press backspace to delete it.

Piano Roll View

As I mentioned above, as you expand the track vertically, you’ll notice that at a certain point MIDI clips will switch to edit mode. The Tracktion MIDI editor is what is commonly called a piano roll view (PRV). In this view, you can clearly see the notes along with a vertical piano graphic located along the left.

Note: The PRV in Tracktion allows you to see the timing of notes as they relate to the timeline, and the pitch of notes as they relate to a piano keyboard. The graphic length of a note represents how long that note is held in musical time.

The MIDI editor PRV includes everything you need to edit MIDI data. You can add notes, delete notes, copy notes, and duplicate them. You can also work with velocity and other controller values. We’ll get into the details later when we go deeper into MIDI editing.

MIDI Record Modes - The Action Property

Select a MIDI input and look in Properties at the item labeled Action. The drop down menu for Action gives you a variety of record modes.
Merge Mode

By default, Action is set to Merge newly recorded MIDI into any existing clips. If you rewind and record in some more notes, you will find that they’re merged into the MIDI clip that you created in the first pass. It doesn’t replace notes that you recorded before; it just adds new notes and merges them with the original MIDI clip.

If you mess up an otherwise good performance in merge mode, undo the new notes by pressing Cmd + Z / Ctrl + Z.

Tip: I find merge mode is very helpful if you’re building up a part pass by pass - particularly when layering a drum part and adding additional drum hits in each pass.

Replace Mode

If you wanted to replace what you played previously, change Action in Properties for the input to Replace existing clips with newly recorded MIDI clips. Now when you start to record, the new recording will create an entirely new MIDI clip and it will gradually overwrite what you had before. It doesn’t exactly erase the original clip. If any portion of the clip is still visible, you can trim the edges of it and expose the original data. Of course, Undo will get you back to where you started from if things don’t go well.

Note: You can envision replace mode as being similar to tape recording. As you record something new onto tape, you are erasing the section you are recording over.

Overlay Mode

In overlay mode, as you record you’ll get a new MIDI clip stacked on top of the original clip. After you have record this way you’ll hear the output from both clips mixed together. Personally, I don’t really like to ever have my clips overlapping.

Tip: In practice, I leave Action set to Merge newly recorded MIDI into any existing clips and I manage the clips myself.

During playback you hear the overlapping MIDI clips merged together. At least for me, I think that’s confusing and don’t like to use this mode.
MIDI Input Quantize

To find MIDI Input Quantize, click on the input and locate the Quantize property. The drop down menu for Quantize offers a wide variety of beat subdivisions.

Notice how this works - you are selecting a subdividing the beat (not the bar). For example, if you want to quantize your input to the nearest eighth note, you don’t select 1/8 beat from this list, you select 1/2 beat - because an eighth note is half of a quarter note (in 4/4 time).

As you record, you’re going to hear the notes however you play them in, but on playback all of your notes will be snapped to the value you set in Quantize.

The downside of this is that often the result is rather unnatural. That’s because this approach quantizes both the note start and the note ending. Notes get stretched out and tend to sound mechanical. In general, input quantize is more useful for drum programming than playing something like a piano part.

Note: Input quantizing does not happen in real time. You hear the result during playback.

There are other ways (Apply Groove) to quantize after the fact. We’ll be getting into that in Chapter 26 - Quantizing MIDI Notes.

Moving On

That’s an introduction to MIDI recording. You learned the essential options to set up a MIDI input. You learned about the MIDI record modes. We also took quick look at input quantizing. Next up, loop recording with MIDI!
Chapter 24 - MIDI Loop Recording

In this chapter you’ll learn about loop recording and MIDI. When you loop record in merge mode it’s useful for layering up a drum part or maybe building a chord over a couple of passes through the loop.

Tracktion also supports MIDI loop recording to layers, which gives you the capability to build a composite MIDI performance in the same way you can do with audio. This is a really cool feature of Tracktion.

Loop Recording in Merge Mode

In the last chapter you learned about MIDI merge mode. Here are the steps again.

1. To put your track into MIDI merge mode, click on the track input, then in Properties set Action to Merge newly recorded MIDI into any existing clip.

   ![](MIDI_Merge_Mode.png)

   MIDI Merge Mode

1. To prepare for loop recording, set the In-marker and the Out-marker over the area you want to loop.

   ![](Set_the_In-marker__Out-marker.png)

   Set the In-marker & Out-marker

1. Toggle the Loop button to until it’s enabled.
1. As Tracktion cycles through the loop, you’ll immediately hear the results of what you played in previous passes. Keep adding passes until you’re happy with the part.

2. To stop recording, either click Record again or hit Spacebar.

Following loop recording, you’ll have a single MIDI clip containing the part you built up over successive recording passes.

This technique is particularly useful for programming drum parts - especially if drumming is not your main skill. For example, on the first pass play in the high hat. Then, on the second pass add the kick and snare. Finally, strategically add a crash on the downbeat.

### Recording to Prepare for MIDI Comping

Compiling is usually associated with audio recording and editing. With compiling you record multiple takes of a part then use simple editing tools to select the best phases from the various takes.

To prepare to compile with a MIDI recording, leave everything set up the same way as for merge mode, but change the Action parameter to Overlay new clips containing newly recorded MIDI.

Set the In-marker and Out-marker and turn Loop on. Hit Record and record a performance during each cycle through the loop.

When you hit Stop you’ll have separate takes in the MIDI clip for each loop pass - just like in audio loop recording.
Comping MIDI Takes

To see the takes, click the plus icon in the lower right corner of the MIDI clip. You’ll see a list of all your takes. From here, you could just simply choose the best take from the list and that will make it active.

You can also expand the view to show all the takes below the track. Click the plus icon and select, Show takes.

Not only does this show the takes, but it puts you in comping mode. Swipe over the phrases you want to keep and build a composite from the best parts of each take.
Comping the Takes

Flattening the Composite to a Single Clip

Once you have the composite assembled, you can convert it to a single MIDI clip. Click the plus icon and select *Flatten current comp*. You will need to press *Delete* on the *Delete Unused Takes* dialog box to proceed.

*Note:* When you select *Flatten current comp* Tracktion asks if you want to delete the unused takes. If you want to flatten the takes to a single MIDI clip you need to accept this. It’s not a big problem. Unlike audio comps, you can use *Undo* following this action.
Moving On

Loop recording and comping are really powerful tools for MIDI composition just as they are when working with audio. Next up, learn how to edit MIDI clips and MIDI notes.
Chapter 25 - MIDI Editing

In this chapter you will learn MIDI editing. There are two aspects to MIDI editing. You can, of course, edit individual MIDI notes but you can also edit the MIDI clip. Editing a MIDI clip is similar to editing an Audio clip with a few key differences. We will go over both in this chapter.

Many of the tools for working with clips work much like they work with Audio clips. Each MIDI clip header has several drag handles. Let’s take a look at how they work.

Trimming MIDI Clips

To trim a MIDI clip, drag one of the trim handles left or right. The trim handles are the hollow arrows at the left and right of the MIDI clip header.

Note: One difference between Audio clips and MIDI clips is that the MIDI clips don’t have fade handles.

Moving MIDI Clips

To move a MIDI clip forward or backward in time, drag from the header area. Don’t drag starting from any of the icons but rather from the blank space in the header area.
Moving a MIDI Clip Track-to-Track

To move a MIDI clip track-to-track, grab the header area and drag it up or down. To move track-to-track without affecting the timing hold down Shift as you drag to constrain the timing.

Slip Editing MIDI Clips

The three solid color handles are used for slip editing - left arrow, right arrow, and the box. The essential tool for slip editing is the solid box in the center of the header. Grab the solid box and drag to slip edit the notes within the frame of the window.

Tip: I use slip editing much less for MIDI clips than for Audio clips. When I do, I always use the middle solid box slip handle.
Reframing a MIDI Clip

The hollow box tool in the center of a MIDI clip allows you to reframe the entire window of the clip leaving the notes in their original place. This is done by dragging the hollow box left or right. This is not something I have found particularly useful.

Splitting a MIDI Clip

To split a MIDI clip, select it then position the cursor at the time you want to make the split. Press the slash key (/). This is the exact same workflow you use for splitting Audio clips.

You can also split using the Split Clips actions at the right side of Properties. The various actions give you more control over splitting.

Note: As you split MIDI clips, any notes that are sustained across the split area are separated into two notes.

You can even split a mixture of Audio clips and MIDI clips across multiple tracks by selecting a combination of them at once.

The MIDI Note Editor

As you increase the vertical size of a track holding MIDI clips, you’ll see that there’s a point at where it switches to the inline MIDI note editor. This gives you a comprehensive view of the notes contained within the MIDI clip. This type of view is commonly called a piano roll view (PRV).
Another way to see the MIDI note editor is to double-click on the MIDI clip header to toggle track height.

**Note:** Clip header double-click behavior is dependent on a global setting. Go to the Settings tab, General behavior page and find the Track Resizing property. You can choose a number of options based on how you would like that resizing to occur when you double-click. This setting also holds for audio tracks. I like to leave it set to toggle between the small and medium height.

### Setting the Number of Octaves & Note Height

You can adjust how many octaves you see on the MIDI editor in the Options menu. By default Options > Default MIDI editor vertical scale is set to 2 octaves. I think that’s a reasonable starting point. If you want you can set this to show more or fewer octaves.
To fine tune the vertical size of MIDI notes, drag the arrows above and below the piano graphic.

Mouse Wheel Options for MIDI Editing

You can use your mouse wheel to scroll vertically within the MIDI editor. During mixing you might prefer to disable that. When you are not working on MIDI editing it’s slightly annoying to start scrolling within the MIDI clips unintentionally.
I find it’s generally helpful to have MIDI scrolling on during MIDI editing. You’ll find this setting in the menu under Options > Mouse wheel action > Mouse wheel scrolls MIDI grid.

**Basic MIDI Editing - Pitch**

Next, let’s look at the tools for editing the actual MIDI notes. These are pretty straightforward. In general, editing works by selecting notes and then doing an action.

The most basic edit? Click a note to select it. Drag it up or down to change the pitch.

**Per Note Automation**

Normally, I would introduce controller editing a bit later, but as you start to drag MIDI notes around, you will immediately see the per-note controller editing area appear above or below selected notes.
Drawing Per Note Automation

If you don’t see the per-note automation editing area, you can turn it on and off in Properties.

To start, select any single note. The automation editing area will appear for the full length of the note. By default you will be editing Volume (controller 7). Select the pencil tool and draw in the desired automation curve by click-dragging over the editing area.

⚠️ **Note:** You need to select the pencil tool to draw in the per-note automation.

The curve will appear as steps based on the current snap resolution. The snap resolution is set by the zoom level, so to draw in a more detailed curve, zoom in more.

Selecting the Controller Type for Per Note Automation

You can select any other control by clicking the *Type* button on the MIDI editor toolbar. This type of editing gives you tremendous control over performance details and articulations.
Note: Not all virtual instruments respond to this type of data.

Nudging Notes

Nudging works much like it does for Audio clips and MIDI clips. You hold down Shift and use the arrow keys. Shift-up and Shift-down change the pitch. Shift-left and Shift-right change the timing. Nudging is particularly helpful when changing the pitch because there’s no chance of altering the timing of the note.

Tip: Cmd + Z / Ctrl + Z works as undo for most editing operations.

Note Length

You can trim the length of a note by grabbing the right edge and dragging it left or right.

![Trimming a MIDI Note](image)

Snapping During Note Editing

Many of these editing operations will snap to the grid as long as you have Snap enabled. To edit freely, disable Snap. The keyboard shortcut Q enables or disables snapping.

![Note Editing Will Snap if Snap is On](image)

Copying and Duplicating Notes

To copy a note, hold down Cmd / Ctrl and drag the note to create a copy. Another way to do this is with the Duplicate keyboard shortcut. First select the note that you would like to copy, make sure the cursor is where you’d like the copy placed and then hit the keyboard shortcut D.
Adjusting Pitch and Velocity in Properties

Another way to adjust pitch and velocity is to select the note and then edit the values directly in Properties. Both Pitch and Velocity can easily be edited this way.

Note Start, Length, & End

You can also make very precise adjustments to the Length, Start Time, and End Time by editing the values directly in Properties for the selected note.

The Pencil Tool

The pencil tool is used to draw in notes. Simply select the pencil tool and then start painting in notes where you’d like them to appear on the piano roll.
The Eraser Tool

Use the eraser tool to swipe over any series of notes that you would like to erase.

![The Eraser Tool](image)

The Line Tool

There’s also a line tool. I usually use this for drawing in controllers but it is possible to use it for notes as well. Draw a line to create a stepped series of notes.

![Draw a Series of Notes with the Line Tool](image)
Note Colors

The color selection along the top edge of the MIDI editor allows you to select set a note color. Select a group of notes, click on a color and then it will change those notes to that color. It doesn’t affect playback, but it gives you a way to visually organize a sequence. For example, when programming drums you could make snares, hi-hats, and kick drum all different colors.

Selecting Multiple Notes

Selecting multiple notes is easy. Use the arrow tool and drag a selection around any group of notes that you’d like to select together.

You can also add or remove notes from a multiple selection by holding down Shift (or Cmd / Ctrl) then clicking additional notes you’d like to toggle in and out of the selection.

To select an entire row of notes that are the same pitch, hold down Cmd / Ctrl and click on the PRV keyboard key corresponding to that row of notes. That selects the full row of notes.
Selecting a Row of Notes with Cmd / Ctrl

Once you have a multiple selection, move all the notes in time or by pitch by dragging with the arrow tool. Or, you can change values in Properties that will apply to all notes in the selection. Nudge also works on well on a multiple selection of notes (Shift plus the arrow keys).

Editing the Note Velocity

To quickly change the velocity of a note, select the note and then select a value from the Velocity drop down menu. This gives you a variety of preset values at popular levels.

If you choose Other, from the velocity drop down, you can type in whatever value you want from 0 to 127.
**Tip:** Here’s another trick way to adjust velocity. Select a note then hold Shift as you drag up and down over the note. Notice the *Velocity* value changing in Properties as you drag.

### Step Entry Mode

When the *Step* button is toggled on, the MIDI clip goes into step entry mode. In this mode, any notes you play to the track will be entered at the cursor position. Then, the cursor will advance to the next step based on the Snap grid resolution. You can adjust that based on the level of zoom.

![Step Entry Mode](image)

### Hearing Notes While Editing

You have the option to trigger notes that are being moved so you can hear the pitch. You can enable or disable this using the speaker icon at the far right at the top of the MIDI editor tool bar.

![Enable Speaker Button to Trigger Notes During Editing](image)

### The Velocity Editor

You can edit MIDI note velocity from the velocity area below the PRV. Click the *Velocity* button at the left of the MIDI editor toolbar to expose the velocity editor. For the selected note, grab the stalk which represents the velocity and drag it up or down. You will notice the *Velocity* parameter moving in Properties for that note as you drag.
The Velocity Editor

You can also edit multiple velocities together by first selecting several velocities. Say we want to edit the velocity of all the C4s. Hold down Cmd / Ctrl and select all the C4s, then, just grab one of them and they will all adjust together.

**Editing other Controller Data**

You can use a view similar to the velocity editor with any kind of controller. Click the *Control* button and then click *Type* to choose which controller to edit.

Example editing aftertouch: In the MIDI editor click *Control > Type > Channel Pressure*. Now the channel pressure data will appear in the same way velocity appears.

**Moving On**

Those are the fundamentals of MIDI editing. We’re going to get into quantizing MIDI notes in the next chapter.
Chapter 26 - Quantizing MIDI Notes

The idea of quantizing is to correct the timing your MIDI performances. At a basic level, quantizing snaps each note to the nearest correct note on a virtual grid defined by the bars and beats of your song. Tracktion gives you tools to define that grid in musical increments like quarter note, eighth note, but it does so using divisions of a beat. I’ll get to that in a bit.

Tracktion takes quantizing further with groove templates. Groove templates allow you to quantize in a way that’s not completely perfectly aligned to straight timing. An important use of this is to introduce swing to the timing. You have all the tools needed to impart the desired feel into your performance.

How to Quantize

Within a MIDI clip, select all the notes you want to quantize. If you want to quantize all of them you can use select all (Cmd + A / Ctrl + A). The quantize actions are available by clicking Quantize in Properties.

There are four different quantize actions available as shown above. The most common option is the first one - Quantize note start times. To complete the action, you pick which beat division to use.

The beat division selection can be a little confusing. Musical divisions in Tracktion are represented as fractions of one beat. For example, if you want to quantize to eighth notes and you’re in 4/4 time,
then you select *To nearest 1/2*. One half of one beat would be an eighth note. If you want to quantize to sixteenth notes, then select *To nearest 1/4 beat* from this menu.

You’ll will notice right away that quantizing perfectly tightens up the performance. It will snap the notes to the nearest increment of the division that you selected.

*Note:* If you’re playing was so far off that it actually snaps it to the wrong note, then you might need to do some MIDI editing to clean that up!

*Tip:* Some styles of music are based on perfectly quantized timing while other styles aren’t. To get a more natural feel but also fix timing errors, you can always edit timing note-by-note manually with *Snap* turned off. Groove quantizing also gives you other options for “quantizing with feel”. More on that later.

**Quantizing Note Lengths**

If you choose the option to quantize the note lengths you’ll see that the notes become the full length of that particular note value.
With something like a piano part this can lead to a choppy, unnatural feel. You could try to quantize the note lengths to 1/4 beat (sixteenth note) if the playing is that inconsistent.

In most cases, it’s not really important to quantize the note lengths. I use this more quantize the note lengths on drum parts, because it helps play out the full attack and decay of a drum hit.

**Quantizing with Groove**

Next let’s look at how to quantize with groove. This feature can be as simple as choosing a preset or as complex as finely programming a groove template. Groove can be applied to both MIDI clips and Step clips which we will cover in the next chapter.

First lets look at the basics:

Select the notes to quantize and click *Apply Groove* in Properties.

You get this big menu of groove presets. These are custom templates that allow you to apply fine adjustments to the timing.
To cut to the chase, the most common scenario is to apply swing. That means delaying the eighth notes that follow the four primary beats in a bar. To locate the groove templates for standard swing, look at those starting with Swing 1/2. Swing 1/2 as in half beat. In normal musical terms that’s eighth note swing. To apply a nice groovy swing, try Swing 1/2 60%.
**Note**: In 4/4 music, eighth note timing is counted 1 & 2 & 3 & 4 &. In swing timing, the “&” beats are delayed. The swing presets in Tracktion let you pick how much delay as a percentage from subtle (10%) to dramatic (90%).

After you apply swing, you’ll see it lays back all of the “and” notes to be a little late - groovy! Tracktion will also adjust the note lengths appropriately as shown above.
Defining Groove Templates

To take groove to the next level, you can build grooves to your own definition using the Groove Template Editor. At the bottom of the Apply Groove menu, you’ll find Edit groove templates. This is also available in the Menu section under Snapping > Edit Groove Templates.

Select that to open the groove template editor. Click on any of the presets to see how the logic works.

In the image above I selected the Swing 1/4 60% template I used for the examples in this chapter. A groove template consists of a pattern length, note subdivision, and the timing for each note. For each step of the pattern you choose the amount that that note falls ‘early’ or ‘late’ relative to perfect timing.
Swing 1/2 60% Template Example

The example in the figure shown above is the setup for a basic swing beat with each ‘and’ eighth-note delayed. You can adjust the intensity of the swing feel by how much delay you put on the eighth notes.

Complex Groove Templates

Since you can create groove templates with as many steps as you want, you can dial in exactly the feel you want. For example if you want to vary the swing within the bar of music you could create a template with eight notes with each swing element slightly different.

Groove Template with Variable Swing

Or, you can create a groove that pushes the timing over two bars to give excitement and tension like the FastSlow2 preset.
Tip: It can also be useful to create a ‘No Groove’ template to help you remove the effect of groove. This is particularly useful when applying groove templates to Step clips - more on that in the next chapter!

Managing Groove Templates

Tracktion gives you all the tools you need to create new groove templates, rename them, and import and export them. Exported templates have the .trkgroove file extension. This allows you to share them with other Tracktion users or installations.

While editing a groove template, you may reset it. This removes the late/early timing for the pattern but doesn’t change the length or note division settings.
Resetting a Groove Template

Any groove template that you don’t need you can delete using *Delete Template*.

Deleting a Groove Template

**Moving On**

Now you should have a pretty good understanding of MIDI, MIDI recording, MIDI editing, and even quantizing with MIDI. But there is one more thing - Step clips. And that is up next!
Chapter 27 - Step Clips

Step clips originated in T5, but they’ve been refined and enhanced since then to be more powerful, useful, and easier to program. On the surface, a Step clip is a simple MIDI step sequencer allowing you to turn notes on and off. But they go much deeper than that.

In this chapter, you’ll learn all about Step clips and how to use them to create drumbeats, synth lines, or bass lines. This is one of my favorite Tracktion features - let’s get started.

Step Clips Overview

Step clips act like a special type of MIDI clip. However, the notes are represented on a grid where each column is a ‘step’ indicating a musical increment. By default, there are 16 steps in a pattern to match popular drum machines and step sequencers. That means in 4/4 timing, there are four steps per beat. You can change this to other values, but this is usually a good starting point for programming drumbeats.

Here is a breakdown of the key concepts you need to work with Step clips:

Step Clip

Step clips are similar to MIDI clips at a high level. You can add, delete, and copy them. They are always in loop mode so you can drag the right trim handle to roll out repetitions. Step clips need a synth plugin in order to make sound just like MIDI clips.
Header
Click the Step clip header to select it. With the clip selected, have access to a wide variety of settings and actions in Properties. Drag the Step clip by the header to move it forward or backward in time or track-to-track.

Footer
Click the Step clip footer for access to a drop down menu and additional actions and values in Properties. These properties are related to working with patterns and sections.

Pattern
A pattern is the grid of notes that you program to do something musical. Each column is a ‘step’ and each row is a ‘channel.’ A Step clip can hold any number of patterns. Patterns and sections are easily confused so keep in mind that they are not the same thing.

Step
A pattern is defined by how many steps it has and what each step represents musically. By default a new pattern will have 16 steps with a step length of 1/4 beat. A step is one column of the grid that makes up a pattern.

Channel
Each row on a Step clip is a channel. A channel is assigned to a single MIDI note. Channels live at the clip level of each Step clip. Channel assignments are the same for all patterns within the clip. It is possible to assign channels within one Step clip to different virtual instruments. More on that later.

Note
A note is the cell formed at the intersection of steps and channels. You program patterns by clicking notes to toggle them on or off.

Section
By default a Step clip has a single section which is assigned to one active pattern. You can create longer Step clips by adding more sections. Each section is then assigned to a pattern.

Pattern Number
Patterns are numbered local to each Step clip. The pattern number for any section is shown on the footer. While this might be confusing to read, it’s really quite simple once you start to work with sections.
A Step Clip with Four Sections

Tip: You can think about Step clips like this. Step clips hold a series of sections. Each section is assigned to a pattern. You can assign the same pattern to more than one section if you want.

Note: Patterns can exist in a Step clip that are not assigned to any section.

Inserting a Step Clip Into the Edit

There are four ways to insert Step clips onto a track:

Insert Using the Clip Object
Like all the other kinds of clips, you can drag the Clip object to a track and then choose Insert new Step Clip from the menu.

Insert from the Track Header
Another way is to select the track where you’d like the Step clip to go, position the cursor where you’d like it to start, then right-click on the track header and select “Insert Step Clip”.
Insert from Track Properties
Select a track by clicking on the track name. In Properties, click “Insert New Clip > Insert New Step Clip.”

Inserting a Step Clip Preset
Since you can save Step clip setups as presets, a great way to get a starting point is to drag in a preset. You can find any existing Step clip presets in the Browser Presets tab. Filter by Step clips or enter a search term if you know the name.
Programming a Drum Beat with a Step Clip

If you create a Step clip by dragging the Clip object to a track, the channels will be pre-assigned to General MIDI drum notes. This makes it really fast to get started programming beats.

Here are the basic steps to programming a drum beat using a Step clip:

1. Insert a drum instrument onto a track and select a preset.
2. Insert a Step clip on the track.
3. Set the In-marker and Out-marker over the Step clip and turn Loop on.
4. Start playback, and turn notes on and off by clicking on the individual note cells within the pattern.
Programming a Step Clip

As you toggle notes you will hear the result. You are programming a Step clip pattern! Easy. Fun.

Video Clip: This video overview is a great way to get a better understanding of how all this works. While the video was created using T6, the workflow is almost identical in this version.

Step Clip Properties

A Step clip has a header that is similar to that of MIDI clips and Audio clips. Click the header to reveal all the actions and settings in Properties. The following properties are the most important when working with Step clips:

Name
Give your Step clip a descriptive Name. This will be particularly helpful when you go to save a Step clip as a preset. The Step clip name is used as the basis for presets.

37https://w-edstrom.wistia.com/medias/pjf2cdmm4t
Color
Use the color selection to give your Step clip a unique color.

Clear All Patterns
Clear All Patterns removes all the notes from all patterns contained within the clip. Since patterns act like layers, you might not be able to see all the patterns while you’re working on a Step clip.

Warning: Clear All Patterns clears all patterns whether you can see them or not, so really be careful when using this feature. Fortunately, you can click Undo (Cmd + Z / Ctrl + Z) if you change your mind right after zeroing out all your patterns!

Delete All Unused Patterns
With Step clips, you can string together a series of patterns by adding additional sections. Delete All Unused Patterns means that you’re going to remove all the patterns that aren’t assigned to play in any section. While you don’t need to use this feature, it’s a way to clean up unused patterns after you’re happy with what you have playing.

Add Channel
Add Channel will add another row of notes at the bottom the Step clip. You can also insert a channel from Properties for any selected channel. This inserts the new channel just above the selected one.

Render Clip
Use any of the Render Clip options to convert a Step clip to an Audio clip.

Note In the Render dialogue box, make sure you have Pass Through Plugins selected. If you don’t, then Tracktion won’t produce any sound and will not be able to render the Step clip to audio.

Standard Clip Operations
Step clip properties also includes Select Clip, Set Edit Tempo, Split Clips, and Move Clip. These are standard operations shared by all the other kinds of clips.

Render to MIDI Clip
Render to MIDI Clip is an important feature of Step clips. This will convert any selected Step clips to a MIDI clip. This allows you to continue working on Step clips in the MIDI editor using the piano roll view.
Create Preset

Create Preset gives you tools to create presets of a Step clips. This is an extremely useful feature that allows you to set up templates of grid patterns and channel assignments for specific drum instruments or even create a library of popular drum patterns that you’d like to reuse in other songs. We’ll get into that more later in the chapter.

Delete

Delete allows you to delete the selected Step clip. Alternatively, just select the Step clip, press Delete, Backspace, or Cmd + X / Ctrl + X. Any of these will delete a clip.

Tip Just like any other clip, Step clips can be copied (Cmd + C / Ctrl + C), pasted (Cmd + V / Ctrl + V), duplicated (D).

The Step Clip Footer

When you click on the Step clip footer, you select the section and whichever pattern is actively showing. With the footer selected, you are selecting both the section and the active pattern. You can tell which pattern is active by the small number indicated on the footer.

Step Clip Footer Shows Pattern & Section Properties

In Properties, the first two columns of controls are related to the pattern. The last column is related to sections. Let’s go through what these options are all about.

Note: The section and pattern numbers are shown in the title line of Properties when a footer is selected. For example, “Section 1 (Pattern 8).”

If you have more than one section in a Step clip, you select a specific section by clicking its footer. Right-click a footer (or click the footer if the clip’s already selected) and you’ll get a menu of actions
related to that section. All of the actions also appear in Properties. They are available from the
right-click menu as a convenience.

Pattern Options

Set Active Pattern
If you have more than one pattern available in your Step clip, you can choose which one is
active from the list. This is also available from with a right-click on the section footer.

Step Length
By default, step length is one-quarter beat. This means each beat is divided into four steps.
If you change this to some other value, it will change it for the active pattern but not for the
entire Step clip.

Number of Steps
Number of Steps is the number of steps in the pattern. By default, this is 16. With a step length
of one-quarter beat and the Number of Steps set to 16, each beat in 4/4 timing is divided into
four steps. This is the most common setup for a step sequencer. This also gives you one bar of
music.
Common Length Setups

Common Length Setups gives you some preset combinations of Step Length and Number of Steps to create one or two bar patterns.

![Common Length Setups in Properties](image)

Step Clip Pattern Actions

![Pattern Actions in Properties](image)

New Pattern

New Pattern simply creates a new blank pattern and makes it active for the section. You’ll notice that the pattern number is automatically assigned. It will be the next available unused pattern number.

Copy to New Pattern

If you want to quickly make a variation on a pattern that you really like, click Copy to New Pattern. This copies the active pattern to a new pattern so you can program a variation.

Clear All Notes

Clear All Notes clears all steps of any notes that have been turned on. This is a simple way to erase the active pattern and start over with some new programming.

Randomize Each Step

The Randomize Each Step button randomly turns on and off notes throughout the entire pattern. This might give you some creative inspiration or just simply serve as a quick way to test creating a new pattern.
Video Clip: *Step Clips Randomize Each Step*³⁸

Tip: Randomize worked differently back in T5. In T5 *Randomize Notes* gave you a cacophony of overlapping sound. Starting with T6, this was refined to trigger a single note per step. This is much more musically useful. If you skipped over this features in the past, give it a try!

Note: Keep in mind you can also randomize a channel of notes. We’ll get to that shortly.

Apply Common Groove

*Apply Common Groove* is usually used to impart a swing feel to your programmed pattern. This button applies groove to all the channels in the pattern. There is a way to apply groove individually to separate channels and we’ll cover that a bit later as well.

**Step Clip Section Actions**

*Insert Duplicate Section*

*Insert Duplicate Section* makes a copy of the selected section and inserts it pushing any existing sections to the right.

Tip: If you insert or duplicate a section but don’t see it, grab the right trim handle and pull it to the right to expose any hidden sections.

³⁸https://w-edstrom.wistia.com/medias/ztgsqpw2y5
Append Duplicate Section

*Append Duplicate Section* puts a copy of the current section at the end of any existing sections.

**Note:** To be clear, *Append Duplicate Section* doesn’t simply insert a copy of the section to the right of the current section. It puts it all the way at the end of any existing sections.

**Tip:** Keep in mind that after you append or duplicate sections, you can quickly assign them to play whatever pattern you like. Right-click the footer and select which pattern you want it play.

Remove Section

To remove a section, select it then click *Remove Section* from the menu or Properties. This doesn’t remove any patterns; they’re still there and can be assigned to other sections.
Step Clip Channel Properties

In Step clip terminology, each row of the grid is a channel. Each channel has a note assignment, a name, and a variety of actions you can use to manipulate the notes on that channel. Channels can even be set to a destination. This allows you to route individual channels to different virtual instruments which is a really cool feature. We’ll be covering that shortly.

Assign a Note Value

If you know the MIDI note value you’d like the channel to play, then you can set it with the Note property. Alternatively, drag the yellow arrow along the virtual keyboard at the bottom of Properties and set it to the desired note there. As you drag the arrow, you’ll hear the notes play.

Velocity

Velocity sets maximum MIDI velocity for the channel. Using the Step clip V/G editor (more on that shortly), you can set each note to a percentage of this value. The default Velocity value is 96.

MIDI Channel

MIDI Channel sets the output MIDI channel number. If you’re playing into a multi-timbral virtual instrument, then this would set which instrument is being played from this Step clip channel.

Note On Every

The Note On Every parameter is followed by a series of buttons. Those buttons complete the sentence “Note on every (blank) steps.” Your selection fills in the black. For example, click 2 to mean “Note on every 2 steps.”

Groove

Earlier, I explained how you can set the groove for an entire pattern by selecting the pattern and choosing Apply Common Groove. You can set the groove for an individual channel by
selecting the channel and then choosing *Groove* in the groove drop-down list. Also, if groove has been applied to the pattern through pattern properties, that groove setting will show up here in the channel groove property. In reality, groove is set at the channel level. When you apply it at the pattern level, it just applies the groove to all the channels.

**Note:** Normally, groove is used to apply swing. In real mathematical terms, that means slightly delaying off-beat eighth notes assuming a 4/4 time signature. Applying different groove per channel would be an advanced programming technique and I wouldn’t recommend it unless you really know what you’re doing. More on groove a bit later.

**Video Clip:** Step Clip Groove³⁹

**Name**

_Name_ is the Step clip channel name. As you hover the mouse pointer over a Step clip, you’ll see the channel names appear along the left. If you want to set a unique name for a channel, then select the channel and update _Name_ in Properties.

**Step Clip Channel Actions**

![Step Clip Channel Actions in Properties](https://w-edstrom.wistia.com/medias/ad5zrq9oux)

**Insert New Channel**

To insert a channel into your Step clip, select a channel and then click *Insert New Channel*. This will put a new channel row above whichever channel you started from. Channels are always numbered from the top down, so if you insert a channel, all of the following channels get renumbered.

**Clear Channel**

The *Clear Channel* button simply erases any notes that have been programmed in to that channel. This gives you a blank channel to start over with a new idea for that note.

³⁹https://w-edstrom.wistia.com/medias/ad5zrq9oux
Randomized Channel
This just randomly selects an on or off state for all of the notes on that channel. If your Step clip has multiple sections, it will randomize the channel across the active patterns on all of the sections.

Shift Notes
The left and right arrow buttons following Shift Notes does exactly that. It shifts the series of notes in each step one increment left or one increment right per click.

Set Destination
Set Destination opens up one of the coolest features of Step clips. It allows you to choose which, of many, virtual instruments you assign that particular channel. For example, you could have your bass drum being played by EZdrummer while your high hat is played by MDrummer. Then, you can set up a hand clap being played by the Tracktion Sampler.

Note: For this feature to function, Tracktion automatically wraps the virtual instruments you drag into the track in a plugin rack. For the most part, Tracktion handles the details automatically when you apply Set Destination.

Video Clip: Route Step Clips to Different Synths Video

Deleting a Channel
Select any channel in your Step clip, click Delete Channel and that removes that channel. All the following channel numbers are then re-sequenced to keep them in numerical order.

Tip: When programming Step clips, there’s really no reason to have all eight default channels taking up space on your screen. Use Delete Channel to simplify your Step clips. I commonly program fundamental beats for my song using only three channels – kick, snare, and high hat. It’s easy to add another channel – say, open high hat – at any time using Insert New Channel.

https://w-edstrom.wistia.com/medias/vncjr2ilh9
Velocity Gate Editor

Take your Step clip programming to the next level using the Velocity Gate editor. When you click V/G in the upper left corner of any Step clip, the V/G view appears below the patterns. This gives you a quick graphical view of the velocity per note for the selected channel.

Here is how to use it:

1. Click V/G at the upper corner of the Step clip to toggle the V/G view. If you don’t see it, expand the vertical height of the track a bit until it appears.
2. Select one of the channels in your Step clip by clicking its name. The V/G editor shows the velocity of each note in a bar graph format. Click or drag within one of the velocity bars to adjust its percentage.
Adjusting a Velocity Bar in the V/G Editor

Note: The V/G setting is a percentage of the velocity value set in Properties for the channel. By default it starts at 100%. If you want the notes to hit harder, then increase the channel Velocity and adjust the V/G percentage to taste.

1. To adjust the velocity for a series of notes, hold down Shift and drag across the bars. This allows you to paint in velocities for an entire sequence of notes. This is really useful for channels with lots of notes like high-hats or snares.

1. You can also gate the length of notes by dragging the right side of any velocity bar to narrow it. This give you freedom to get gated, glitchy notes if you want, or just to tighten up the hits.
Looping Step Clips

MIDI Clips and Audio clips have a loop mode that allow you to roll out repetitions by dragging the right trim handle. Step clips are always in loop mode. Grab right trim handle at any time to loop it over part or all over you song.

By default, Step Clips loop only the last section. I find it much more useful 99% of the time to loop the entire Step clip. Fortunately, there is an option for that in Properties - Repeat Whole Sequence. I always enable that before rolling out repeats for Step clips.

Video Clip: Step Clip Velocity/Gate⁴¹

---

⁴¹https://w-edstrom.wistia.com/medias/mz2dg3v98s
Render a Step Clip to MIDI

When you get to a point where you want to do more detailed ending on your Step clip sequence, convert it to a MIDI clip and use the MIDI editor. Here’s how. Select a Step clip and then choose Render to MIDI Clip in Properties. A new MIDI Clip will be created right on top of the Step Clip. From there you can move it around or delete the underlying Step clip.

Step Clip Presets

Tracktion includes the ability to save presets of your Step clips. This is incredibly powerful for creating a library of beats and other elements for use in future productions. I like to create presets and use them as templates holding my preferred starting points for Step clip channel assignments and names.

Always use Create Preset > Include patterns

To save a preset, select the Step clip by clicking the header. Then click Create Preset > Include patterns in Properties. You can name and tag your preset. Later to find it, use the Browser Presets tab and filter by Step Clips.
Preset Details Dialog Box for a Step Clip

Tip: I suggest you always use Create Preset > Include patterns. Create Preset > Exclude Patterns is also available but that will always have the default 16 step blank pattern since the save doesn’t include any patterns. If you use this option, you will be disappointed that presets don’t appear to save correctly. If you want a blank preset, clear all the notes then save it using Create Preset > Include patterns.

Moving On

Step clips are an incredibly powerful and fun way to work with MIDI data and virtual instruments. They are also unique to Tracktion. They are one of the key things that makes Tracktion special and can be used as a secret weapon for creating cool and expressive beats!

Video Clips: I created a series of videos you should find helpful when learning to use Step clips:

Step Clips Overview
Step Clips Velocity/Gate
Step Clips Randomize Each Step

https://w-edstrom.wistia.com/medias/pjf2cdmmv4
https://w-edstrom.wistia.com/medias/mz2dg3v98s
https://w-edstrom.wistia.com/medias/ztgsqpw2y5
Step Clips Groove\textsuperscript{45}

Step Clips Route Channels to Different Synths\textsuperscript{46}

\textsuperscript{45}https://w-edstrom.wistia.com/medias/m22dg3v98s
\textsuperscript{46}https://w-edstrom.wistia.com/medias/vncjr2izh0
Chapter 28 - Scanning Plugins

In this chapter, you’ll learn how to get Tracktion to recognize your third-party plugins. This is essential to do before using third party effects and virtual instrument. The next few chapters are all about using plugins, so this step is essential before moving on.

Scanning Plugins

All scanning action happens on the Settings tab, Plugins page. If you previously scanned plugins, you’ll see a list of all the plugins on your system. If not, the list will be blank.

Setting Tab > Plugins, Plugins List

To scan your system, click Scanning and Sorting. If you’re on a PC, you can scan for VST or VST3 plugin. If you’re on a Mac, you can scan for AudioUnits, VST, or VST3 plugins.

Scanning and Sorting Menu

If you are just getting started with Tracktion and the plugin list is blank, run scans for each type of plugin. You will also do this each time you install new third party plugins.

To reset your list of plugins, choose Clear List. That will reset the list, removing all the plugins. Remove any plugins who’s file no longer exist is also useful to cleanup the list especially if you have been trying and deleting a lot of plugin demos.
When you run a scan, Tracktion increments through all plugins on your system. This might take several minutes or it might take just a few seconds depending on how many plugins you have.

**Note:** If Tracktion can’t load a plugin correctly you’ll see a message indicating that the plugin was deactivated. This will often abort the scan. Whenever I get a message like this I re-run the scan for that type of plugin. Tracktion skips plugins that are deactivated during successive scans.

**Tip:** When you have trouble loading a plugin, first make sure both Tracktion and the plugin are on the latest version. Also, report any plugin issues to Tracktion Software so they can work with the manufacture to establish compatibility.

### 64-Bit Versus 32-Bit Plugins

Keep in mind that 64-bit Tracktion will only load 64-bit plugins. If you rely on 32-bit plugins, then you need to run the 32-bit version.

### Sorting the Plugins List

Once your plugins are all loaded they appear in alphabetical order. You can sort the plugins List clicking any of the column headers. I often sort this list by manufacturer or format.

![Sorting Plugins List by Clicking the Headers](image)

Once sorted by a column, clicking that header again toggles the sort order between ascending and descending alphabetical order.
Setting the Style of the Plugin Object

To insert an effect into an Edit, grab the plugin object in the upper right corner and drag it to the mixer section of any track.

As you drop it, you’ll see the selector menu. Pick the plugin you want from this menu. There are numerous ways to have the selector menu displayed based on the Plugin Selector and Selector Sorting options at the bottom of the Settings tab, Plugins page.

Plugin Selector

The default for this is Popup menu but you can choose a Popup tree view instead. You can optionally organize a fully custom configured menu as described here shortly. The custom popup can also be in tree or menu format. If those options aren’t already enough, you can optionally tag all your plugins and select a view based on the tags. Super flexible!

Selector Sorting

The Selector Sorting property allows you set the sort order of the selector menu or tree. I typically leave this set Sort by manufacturer when using the standard popup menu, however Sort by category and Sort by disk location are available options.
Building a Custom Plugin Selector

If you set Plugin Selector to Custom popup menu or Custom popup tree, you can organize the menu however you like in the Custom Plugin List. To do that, drag plugins from the main list and drop them on the Custom Plugin List pane on the right.

Note: If you don’t see the Custom Plugin List, then enable Show Custom Menu Editor below the plugin list.
To further organize your menu, create groups to hold collections of plugins like ‘Favorites’ or ‘Compressors.’ To create a group, click the ‘plus’ icon at the lower right. This adds a *New Group* folder to the bottom the Custom Plugin List. Right-click the group to rename it or remove it. Drag it to the desired position and then drag some plugins to the group.

![Click to Add a Group to the Custom Plugin List](image)

**Opening Plugin Windows**

Settings tab > Plugins has a property named *Opening Plugin Windows*. Here, you can choose whether you want to single-click or double-click to open plugin windows. This means when you have a plugin inserted in the mixer section on any track whether you single-click it or double-click it to see its UI.

![Single-click or Double-click to Open Plugins](image)

I found this to work inconsistently. If you set it to *Single-click*, many plugins still require a double-click. You might want to experiment with this to see how it works with your plugins.

**Pinning Plugin Windows**

You can make any plugin window stick on the screen using the push pin icon in the upper right corner. By default, plugin windows are not pinned unless you specifically click that icon to pin them. But you can change that behavior on the Settings tab, Plugins page. Changing the property *Pinning Plugin Windows*.

![Open Plugins Pinned, or Not](image)

Plugins can be pinned or unpinned when open. Test this by opening a plugin and make sure it is unpinned. Now, open another plugin and notice that the first one closes. Next repeat this with the plugin pinned. The pinned plugin stays visible as you open additional plugins.
Setting Tags

You can add tags to your plugins if you want. You can then use these tags in the Browser Search tab to filter for specific kinds of plugins. You can also use tags to organize the Plugin Selector menu as described above.

Settings tab, Plugins page has a drag and drop approach to set tags. Select some plugins from the list and drag them to the Add Tag button at the lower right. This gives you options to choose any exiting tag or create a new one.

To remove tags, drag a selection of plugins from the list to the Remove Tag button and choose which tag to remove.

Tip: You can also set tags directly in the Browser from a right-click menu whenever you see a plugin in the search results.

Moving On

Once you have your plugins scanned and recognized, you are ready to use them in Tracktion... and that’s what’s coming in the next chapter!
Chapter 29 - Using Plugins

In this chapter, I want to show you how to apply effects plugins using the flexible Mixer section. In the previous chapter we covered how to scan for plugins and how to insert them into your project.

Note: In earlier versions, Tracktion used to called effects and synth plugins ‘filters.’ Tracktion has moved away from this nomenclature to the more industry standard term - 'plugins.' You might still run into the old terminology in the onscreen help, older tutorials, and in conversation with long term Tracktioneers!

The Mixer

The Mixer section resides along the right side of the Edit and completes the left-to-right signal flow on each track. You can open and close the Mixer using the open/close icon at the upper right or keyboard shortcut M.

Whenever you create a new track, it will automatically have a Volume & Pan plugin and a Level Meter plugin inserted. These behave just like any other plugin. You can change the order, remove them, or even add additional instances of them on the same track.
For example, you might want a level meter before and after a compressor. Of course, you can add other plugins both built-in and third party to the Mixer section, and that is the topic of this chapter.

**Tip:** Each Mixer channel is stereo. If the track contains mono clips you still typically want to choose stereo versions of plugins for the Mixer. Mono plugins will only effect the left side of the signal.

### Adjusting the Size of the Mixer Section

Try moving the mouse pointer from the arrangement slowly to the Mixer section. As your pointer crosses over from the arrangement to the Mixer notice the vertical highlight line.
Drag the highlight line to the left to expand the Mixer section. If you drag it right, then you can make the Mixer section smaller. All of the plugins on the Mixer are dynamically resized.

Tip: If you accidentally delete, change, or move a plugin or simply change your mind, click Undo on the Menu (Ctrl + Z / Cmd + Z) to restore it.

**Working with Plugins**

You can fully customize the mixer for each track by inserting a chain of plugins. This is one of the most compelling features of Tracktion. There is no need to switch between a horizontal track view and a vertical console view.

Here are the essentials for working with plugins in the Mixer:

**Inserting Plugins**

To insert additional Tracktion plugins or third-party plugins, drag the Plugin Object to a track and then select the plugin that you would like from the list.

For third-party plugins, the UI window will pop up. Apart from the core built-in plugins, each has its own graphical user interface.

**Right-click to Insert**

Right-click on any existing plugin and select *Add new plugin*. This pulls up the plugin selector menu and you may pick any plugin to add. It will be added to the left of plugin you started from.

Note: If you don’t see some of your plugins, review the previous chapter that details how to scan your system for all available plugins.
Plugin Properties
To select a plugin, click on it. When selected, Properties shows a wide variety of settings and actions related to that plugin. Most of the built-in plugins have the entire user interface in Properties.

![Select a Plugin to See its Properties](image)

Duplicating Plugins
To duplicate a plugin, select it and press D. This gives you a new instance of the plugin to drag to a different position or to another track.

![Duplicate Plugins by Pressing D](image)

Deleting Plugins
To delete a plugin, simply select the plugin and hit Delete or Backspace. You may alternatively click the red **Delete Plugin** button in Properties.

Moving Plugins
To move a plugin from one track to another track, simply grab the plugin and drag it wherever you would like to put it - even to a different track. As you drag, a red insert illumination will appear showing where the plugin will be after you drop it.
Moving a Plugin

Copying Plugins
To copy a plugin, hold down Opt / Alt and drag it to where you want the copy. Alternatively, press D to duplicate it then drag the duplicate to the target location.

Bypassing a Plugin
To bypass a plugin, select the plugin then turn off Enabled in Properties. Or, simply select the plugin and press the keyboard shortcut F. A bypassed plugin appears with a red X through it on the Mixer.

Tip: You can bypass several plugins at once, by first selecting them and then pressing F.

Assigning a Quick Control Parameter
You can assign a quick control parameter to any instance of a plugin. This allows you immediate access to tweak one parameter without mousing back to Properties or opening the UI for the plugin. For example, I often set the mix control for delay plugins as quick control.
Delay Mix Set as a Quick Control Parameter

To set up a quick control parameter, right-click the plugin and choose *Select quick control parameter*. Next, choose which parameter to use.

Tracktion Delay has only two parameters but many third-party have dozens of them to choose from.

**Third-Party Plugins**

Third-party plugins are inserted in the same way as built-in plugins. One difference is that the UI does not appear in Properties. Each plugin has its own UI window. Some editions of Tracktion come with optional Tracktion plugins like Master Mix that open in separate windows.
Sonimus SonEQ, an Example 3rd Party Plugin

To open the UI for a third-party plugin, double-click the plugin in the Mixer.

**Note:** You can change to a single-click to open plugin windows the Settings Tab, Plugins page. The parameter is *Opening Plugin Windows*.

### Searching for Plugins

The Tracktion Browser includes a Search tab. This allows you to search for plugins. When you find one you want to use, drag it to your Edit. This has become my preferred way of working with plugins. Here are the steps:

1. Open the Browser and click the Search tab
2. Type in a few characters of the name of the plugin
3. From the search results, drag the plugin from the Browser to the Mixer.
The search uses an index that includes plugin names, tags, and manufacturer. I covered how to set tags in the previous chapter.

Tip: It often helps to disable the options for Loops and Presets when searching for a specific plugin. This gives you more targeted results.

Using Master Plugins

To apply processing to the full stereo mix, add plugins to the Master section. The drop target says *Drop Master Plugins Here.*

Typically, I put a bus compressor, a limiter, and maybe an EQ on the master. Another great option is Tracktion’s own Final Mix plugin that combines all of those in to one package expressly designed for use on a full mix.
Tip: You can right click the Drop Master Plugins Here area then choose Add new plugin to open the plugin selector menu. I find this a bit faster than dragging the plugin object down there!

Moving On

That there is no separate console view in Tracktion feels refreshing when working with Tracktion. You build whatever signal chain you need from the built-in plugins and your third party plugin collection. You never really have to change your thought process between track view and a Mixer view.
Chapter 30 - Built-in Effects Plugins

The Tracktion built-in effects are really quite simple. They act as plugins you can combine to build up more complex effects chains in the mixer or within plugin racks. While I won’t touch on every single effect here, I will go over the essential ones. Let’s get started.

Tracktion Effects

Drag the plugin object to the mixer and select Tracktion Plugins. You’ll see the list of built-in effects.

In this chapter, I am going to go into more detail about the plugins hightailed in the image above. The other effects provide specialized functions or are not typical audio effects. We’ll get into some of those in later chapters; some are outside the scope of this book.

Volume & Pan Plugin

Whenever you create a track, you will see a Volume & Pan plugin at the right in the mixer section. This gives you basic level and pan controls like you’d expect to find on any mixer channel. Since the Tracktion mixer is made up of plugins, the Volume & Pan plugin can be moved before other plugins or deleted entirely. You can even add another Volume & Pan and use it as a trim control for gain staging.
Adjusting Volume

To control volume, click and drag the volume slider up and down. A large volume slider appears as drag giving you nice readable dB markings for fine level adjustment. The numeric value for Volume setting appears in Properties.

Adjusting Panning

The pan adjustment works similarly. Click the panner graphic then drag left or right to adjust left to right stereo positioning.

Resetting Controls

To reset either Volume or Pan to their default position, hold down Opt / Alt as you click the control.

Properties

With a Volume & Pan plugin selected its values and actions appear in Properties.
Volume & Pan Plugin Properties

The Volume slider is repeated in Properties along with buttons for Reset and Mute. Pan is repeated in Properties along with a Centre Panning button that resets panning.

Pan Law
Properties also holds a setting for Pan Law. By default this is set to Linear but you can change it to other popular formats. For example, many DAWs use a -3 dB pan law so that as you pan to the center it lowers the volume slightly to make it easier to keep a track in balance as you adjusting panning.

Tip: To apply a velocity offset to notes going into a virtual instruments, insert a Volume & Pan plugin before it and enable Apply to MIDI velocities. Adjust the fader to offset MIDI velocity to increase or reduce the velocity. This is a quick way make your MIDI drums hit harder - much easier than going back to editing the MIDI data. This only works if you insert Volume & Pan ahead (to the left) of the virtual instrument.

Level Meter

The Level Meter plugin is also at the right end of the mixer for every track by default. Level Meter is stereo and shows what the left and right levels are doing.

Tip: To apply a velocity offset to notes going into a virtual instruments, insert a Volume & Pan plugin before it and enable Apply to MIDI velocities. Adjust the fader to offset MIDI velocity to increase or reduce the velocity. This is a quick way make your MIDI drums hit harder - much easier than going back to editing the MIDI data. This only works if you insert Volume & Pan ahead (to the left) of the virtual instrument.

When you select a Level Meter, Properties displays a large horizontal version of the meter that includes dB markings.
The meter indicates signal overload with a red indicator at the top of the meter. You can reset that by clicking the red overload indicator.

Tip: To clear all overload indicators in the Edit, right-click any level meter and choose Reset all overload indicators (Backslash).

By default the Level Meter is set to peak mode. This is typical of the metering in most DAWs. You may change the meter mode in Properties or from the right-click menu. Here is an explanation of each of the modes.

**Peak Mode**
Peak mode shows the digital peak. This is the normal mode for Tracktion and most other DAWs. From a technical point of view you want to keep this out of the red to prevent ugly digital clipping.

**RMS Mode**
To get a sense of the overall perceived volume your signal you might want to try RMS mode. This mode emulates the response of legacy VU meters. It gives you a better indication of how loud one track is perceived compared to others.

**Sum & Difference Mode**
*Sum & difference* is a specialized mode that gives you a visual representation of both the level and the stereo spread. The left part of the meter shows the level of sum of left plus right. This represents the combined level of the stereo signal.

The right side of the meter shows the difference between left and right. The more difference you see the wider the stereo spread between the two channels. This gives you a visual indication of stereo spread. If both channels are playing exactly the same thing then left minus right will cancel to zero and the right side of the meter will show no activity - a mono signal.

Tip: The level meter will also indicate MIDI activity if you enable Show MIDI activity in Properties. This can be a very useful diagnostic if you ever wonder why a virtual instrument is not triggering.
The 4-Band Equalizer

The 4-band Equalizer has a graphical interface that shows up in Properties. You’ll immediately notice that there are four bands which correspond to four movable nodes on the frequency response plot. The high band and the low band are shelving filters, the middle two bands are peaking filters.

To adjust the gain of any of the bands, grab the node directly in the middle by the small square and drag up or down. To set the frequency of any band, drag the node left or right. To adjust the width (or Q) of the filter drag within the perimeter of the node clockwise to make the band narrower or counterclockwise to make it broader.

On the shelving bands, drag clockwise to make the slope increase or drag counterclockwise to make the slope shallower. As you adjust these values you’ll see the actual numeric values over to the right for Frequency, Gain, and Q.

Just under the frequency plot notice the Reset button. Click Reset to return all four bands back to their default values giving you a flat frequency response plot.

Also, the notice the controls for saving and loading presets. Using these you can create a library of common presets to use in your mixing projects. The 4-band Equalizer is very simple and the graphic adjustment makes it very quick to sweep through the frequencies to quickly locate your cuts and boosts.

Reverb

Tracktion Reverb doesn’t have a fancy user interface. You get just a few simple sliders. It is however a really effective, low-CPU way to add some depth to a track. It’s refreshing to have a very straightforward set of controls. That is all you need to get a nice variety of reverb sounds.
Chapter 30 - Built-in Effects Plugins

Tip: I find it speeds up mixing to assign *Wet Mix* (Wet Level) as the quick control parameter when using *Reverb*. Mixing with a little reverb on a track gives you another dimension to mix with in addition to level and panning. More reverb pushes the track further back, less reverb sounds closer. Combine that with left and right placement from panning for more spacious mixes.

**Reverb, Wet Level as the Quick Control Parameter**

### Delay

The Tracktion *Delay* is an extremely simplified mono delay effect with delay times up to one second. You control *Length* with a slider, allowing you to enter delay times between zero and 1000 milliseconds. You can also adjust the *Feedback* amount with the *Feedback* slider from no feedback all the way up to 0 dB, which is essentially full feedback. The *Amount* parameter is a mix control. It allows you to set the percentage of the effected signal to pass through.

The *Delay* plugins also has a *Tempo* parameter. It is not really a host sync but rather just helps you calculate delay times based on musical divisions of the beat at the current tempo.
For example, if you want to get an eighth note delay, click Tempo and select Set delay length to 1/2 beat and it calculates that delay time and sets the value in Length. It is a one time calculation. If you change the Edit tempo, then you need to set it again.

**Chorus**

The *Chorus* plugin gives you the classic chorusing effect. It works as a type of doubling effect but it provides a shimmery, smooth quality. It can be used on just about any source but is common on guitars, pads, electric pianos, bass, and vocals.

To get the classic chorus effect, the plugin modulates the delay time. By modulate, I mean the delay time is gradually changing - getting longer and shorter. The amount of variation is controlled by the *Depth* parameter. The *Speed* slider controls the quickness of modulation to get results from warbling to smooth. The *Width* slider adjusts how far apart the dry signal and the wet signal are panned to give you a wide stereo effect or a narrow doubling. Finally, *Amount* controls the overall mix of the original signal with the chorus effect.
The Phaser

Phase shifter pedals became popular in the late ‘60’s and during the ‘70’s. It gives you an intense swirling impression you will instantly recognize. While a phaser ia most commonly used as a guitar effect, it is also frequently used on synths or any track that needs some movement.

The Phaser Plugin

The Speed parameter controls the speed of the LFO that modulates the phase shifting effect. Depth controls the number of octaves the phase shift will sweep through. Feedback lets you adjust resonance which makes the phasing more or less intense. The Tempo parameter allows you to set the Speed of the LFO to a musically useful division of a beat based on the current tempo.

Tip: As you work with effects you can easily change the order of effects on any track by grabbing the plugin and dragging it left or right. As you drag, a red drop target will glow in the spot where the effect will be inserted when you drop it.

The Compressor/Limiter

Tracktion’s Compressor/Limiter is a very basic compressor that includes most of the common parameters you expect to find in a compressor - Threshold, Ratio, Attack, Release, and make-up gain (Output).

The Compressor/Limiter Plugin

As the signal goes above Threshold the compressor reduces the output signal by the amount set by Ratio. So, if you set Ratio to 4:1, Attack sets how long it takes for the 4:1 ratio to fully kick in. Release
is the amount of time it takes for the compressor to recover after the signal goes back below the threshold.

You can set **Threshold** and the **Ratio** by dragging the appropriate nodes on the frequency response transfer plot.

**Compressor/Limiter** functions as a limiter when you set the **Ratio** to the maximum of 20:1. When used as a limiter you also want to set a very fast attack time. In this mode it really clamps down on transients.

![Compressor/Limiter Configured as a Limiter]

**Note:** The disadvantage of the built-in **Compressor/Limiter** is the lack of metering. You can insert a **Level Meter** before and after the compressor and look at the difference between the two meters get an idea of gain reduction. Because of the lack of metering, I actually rarely use this compressor. Instead, I usually opt for a third-party compressor that shows signal and gain reduction graphically.

### Pitch Shifter

The **Pitch Shifter** plugin uses DSP processing to change the pitch of the signal in real time change. For audio tracks, this uses the **Elastique Pro** or whichever algorithm you select in the **Type** parameter.

![The Tracktion Pitch Shifter Plugin]

**Pitch Shifter** is set in semi-tones so if you want to go up an octave, set **Pitch** to 12. If you want to go down one octave set it to -12. To reset back to the original pitch, select **Pitch** and type in zero.
Tip: I find it’s usually a lot easier to control the Pitch value by typing in the digits than it is to use the slider.

Note: If you insert Pitch Shifter ahead of a MIDI instrument, it works on the MIDI data stream to transpose notes up or down by the value you set in the Pitch parameter.

The Low/High-Pass Filter

I actually use this plugin frequently because of its simplicity. Drag the Low/High-Pass Filter to any track and then in Properties choose if you want it to be Low-pass or High-pass.
High/Low-Pass Filter Properties

Once you’ve made that selection, drag the Frequency slider or type in the frequency. For example, if you want to just create a common rumble filter to apply to a vocal, Choose High-pass and set Frequency to 100 Hz.

Tip: A quick way to create a low-fi effect on any track is to insert two of these filters, one set to High-pass and one set to Low-pass. For example, set the high-pass frequency to about 300 and set the low-pass frequency to about 3,000. That will give you a nice starting point for a low-fi sound.

Text Plugin

The text plugin is a convenient tool to keep your Edit organized as you record, edit, and mix. Drag Text it to a track, give it a Name and then type in a Description.

Tip: You can enable or disable several plugins at once by simply selecting all of them and using the keyboard shortcut F.
Saving Presets

Most of the built-in plugins allow you to load, save, and delete presets. Once you have your favorite presets saved, you can search for presets on the Presets tab or the Search tab of the Browser.

As you create presets you can also add tags to make it quick to filter to exactly what you are looking for - Vocal EQ, Guitar Focus, Bass Boost for example.

Moving On

Now we’ve touched on most of the built-in plugins in Tracktion. The built-in effects along with third-party plugins give you tremendous creative potential when composing or mixing in Tracktion.
Chapter 31 - Effects Bus Tracks

In this chapter, you’ll learn how to set up an effects bus track in Tracktion. A bus track is configured to be shared by multiple tracks within your Edit. Sometimes this is called a master effects bus. This is an extremely common production technique that originated when recording was done using large mixing consoles. When mixing with a console, effects like reverb and delay are created using outboard hardware. In the early days, studios only had a limited number of reverbs and chambers to use. The solution was to use a common bus for the effect and then send the desired amount of each track over to the effect bus.

It works the same way in Tracktion. You dedicate a track to the effect and then use a special Aux Send plugin to send part of the signal from your instrument, vocal, or drum tracks to over to the effects bus track.

Create the Bus Track

To get started create a new track. The fastest way is select any track and hit T. That creates a new blank track right after the one that you started with. You can drag the new track anywhere you’d like. I typically start by putting bus tracks at the top of the Edit.

Next, click on the track name, and rename the track by editing Name in Properties. In this example I used a reverb effect so I named it “Master Reverb.”

![New, Blank Track](image)

Adding the Effect Plugin

The next step is to insert an effect plugin on the bus track. In this example we’re using Tracktion Reverb.
Insert the Reverb Plugin

Check that the Dry Mix fader is turned all the way down. You want only the wet signal to go through Reverb. You can tweak the other parameters later after you get some sound going through it.

Tip: If the plugin you’re using has a mix control, make sure it’s turned to the 100 % wet position. The critical thing here is you don’t want any dry signal being mixed back in through a different, parallel path.

Aux Return Plugin

So this seems like a pretty ordinary track. How do you make this track behave like a bus? It’s by inserting the Aux Return plugin. This is one of the built-in plugins in Tracktion. It pairs up with the Aux Send plugin for just this purpose.

Insert the Tracktion Aux Return plugin to the left of Reverb.

Notice that it is labeled Aux Return #1 in Properties. Also, you can see it is automatically assigned to the next available bus - in this case *Bus #1.
Automatic Bus Assignment for Aux Return

It’s optional but, I type in something descriptive for the Bus Name property. In this case Verb 1.

Adding a Descriptive Bus Name

The descriptive name appears right on the plugin thumbnail in the mixer making things much clearer. This will help even more when you have several effects buses configured.

How the Bus Name Appears in the Mixer

Adding Aux Sends to the Channels

Now that your effects bus track is set up, all you need to do is insert an Aux Send plugin on each track where you would like to apply this effect.

Insert Aux Send on a Track

This is important. Insert Aux Send after the Volume & Pan plugin. This way as you adjust the track volume, you’re also adjusting the amount sent to the bus track proportionally. Even if you lower the volume all the way down, you won’t hear a ghosting of the effects bus from that track playing in your mix.
Note: On a conventional mixing console, this position is called “post fader.” Hardware consoles will have a special switch or maybe even a special knob that allows you to send post fader. In Traktions you do this in a very direct way - rearrange the order of the fader so that it comes before the Aux Send plugin. Really cool!

### Adjusting the Send Level

Now that it’s all set up, as you play back, adjust the send level by clicking on the Aux Send plugin, and adjusting the Send level slider that pops up.

![Adjust the Aux Send Level](image)

Alternatively, you can just click on the Aux Send plugin and adjust Send in the Properties section. The more you turn it up the more effect you’ll get. As you turn it down, you get less and less of the effect.

### Assigning the Aux Bus

You can create as many effects bus tracks as you need for your mix. You might want a reverb for drums, a different reverb for vocals, a delay for vocals, and other delay for guitars. The steps to set up the additional buses are the same as outlined above. You just need to make sure your Aux Sends and Aux Returns are assigned to the correct bus numbers.

![Setup with Three Bus Effects Tracks](image)

When we set up Verb 1, we used Bus #1. For DLY1 I used Bus #2 and gave it a unique name.
Assigning Buses to the Aux Returns

As you insert the Aux Send plugin onto each track, select which effect you want to use by choosing the correct bus.

Tip: Feel free to assign more than one Aux Send to the same track.

Your effects tracks aren’t limited to a single plugin. You can create an entire effects chain, for example combining compression, EQ, reverb, or delay on a single bus track.

Solo Isolate

There’s a special solo mode that you to want to use on bus tracks called Solo isolate. Here is how that works. Right-click the Solo button on one of your bus tracks and choose the option Solo isolate.
Notice is that the Solo button changes from “S” to “SI.” With Solo isolate enabled, if you solo any track, this track will also be soloed. Why do you want that? Because when you solo a track you usually want to hear it along with its send effects. If you don’t use Solo isolate on your bus tracks the effects get muted when you solo a track.

Tip: Tracktion includes a track tagging feature that allows you to quickly view any tracks that share a tag. I like to tag all of my effects buses with the tag “FX.” This makes it really easy to pull up a view of all of my effects bus tracks using the Tracks tab in the Browser. Take organization one step further by giving your bus tracks a specific color.

**Effects Bus Track Presets**

If you commonly use a similar set of send effects, you can create some presets for your bus tracks. You can then recall them for your next project. To do that, right-click the track name and select **Save preset > whole track**.

In the *Preset Details* dialogue box, put in an appropriate name for your preset such as “Master Reverb.” In the tags area, the tag *Track* will automatically be entered. I like to add another tag - *Effects Bus*. 
Remember to separate tags with a comma. Click OK, then the next time you want to create a very similar effects bus track, go to the Presets tab in the Browser and filter by Effects Bus. Drag the preset onto any track to instantly configure your favorite master effects set up.

Moving On

In a full mix, I often have four or more effects buses. Usually I have at least two reverb and two delays - drum reverb, vocal reverb, stereo delay, and a mono slap back delay.

One key is to group the bus tracks together. I usually put them at the top of the Edit. Also, make them a unique color, tag, and label them appropriately.

Once you get a hang of the set up, using effects bus tracks in Tracktion is very straight forward. Compared to other DAWs, the signal flow is obvious.
Chapter 32 - Clip Effects

In Chapters 29 through 31 I covered using effects plugins in a variety of ways. Now, I want to show you how to apply plugins to individual Audio clips. It’s really quite simple. Let’s get started.

Inserting Plugins on Clips

To insert a plugin on an Audio clip, drag the plugin from the Browser or the plugin object and drop it onto the Audio clip. You’ll notice that plugin thumbnail appears in the lower right corner of the clip. You can add as many plugins as you’d like and create a chain of effects all operating on that one clip.

![Plugins Using Clip Effects](image)

**Note:** Clip effects work with Audio clips but not MIDI clips or Step clips.

The rest of the operation is pretty much the same as using plugins in the mixer. Select a plugin and hit F to enable or disable it. You can also enable or disable the effect with the Enabled button in Properties.

For third-party plugins, clicking or double clicking on the plugin opens its user interface.

**Tip:** How plugins open, depends on a setting in the Settings tab Plugins page - *Opening Plugin Windows*. It can be set to either *Single-click on a plugin to open its GUI window* or *Double-click on a plugin to open its GUI window*.

Removing Clip Plugins

To remove a plugin, simply click on the plugin and press Delete or Backspace. You can also select multiple plugins by holding down Cmd / Ctrl to select multiples, and then press Delete to remove them.
Creative Uses

One of the reasons to use clip effects is if you want to put an effect on just part of a track, even a single word or a single phrase. Without using clip effects, you’d need to move a piece of the clip to another track to apply a different type of an effect. This is really useful for something like an echo throw where you’re applying an echo effect to a single word, or if you want to process one phrase of a vocal line in lo-fi. Just separate the phrase or word to its own clip and apply the effect only to that short clip.

Echo Throw Example

An echo throw is taking one word, usually the last word of a phrase and then applying an echo to it. Here are the steps:

1. First, separate the final word of the phrase from the rest of the phrase. To do that position the cursor where you’d like to make the split and hit the slash (/) key.
2. Now that clip is separated into its own clip, drag in the Delay plugin.
3. Dial in the Delay parameter so it echoes out in a musically useful way - maybe on eighth notes or quarter notes. Add a little bit of Feedback so you get some echoes that die out over time.
4. Playback and tweak the Delay parameters until you get the echo throw effect that you like.

Moving On

The same technique is great for lo-fi effects as well. Apply a high pass and a low pass filter in order to cut the highs and the lows, or even apply chorusing to a few words in a vocal line. Clip effects are super easy to use in Tracktion and they unlock all kinds of creative options!
Chapter 33 – Folder Tracks

With Folder Tracks, you collect a group of tracks into a folder allowing to you work with them together as unit. The obvious advantage is to collapse the view so that related tracks, like your drum tracks, can be viewed as a single entity.

Folder Tracks also give you a convenient way to apply volume automation so that you can do a fade across a number of tracks at the same time. Folder Tracks allow you to solo every track that is contained within it with a single click. You can also do basic editing across the included. Let’s take a closer look.

Creating a Folder Track

To create a Folder Track, right-click the track name for any existing track and select Create a new Folder Track. The Folder Track appears below the original track.

![New Empty Folder Track](image)

Alternatively, right click on the background of the Track section and choose Create a new Folder Track.

Either of these ways will give a new empty Folder Track. There are easy ways to create a Folder Track containing existing tracks and we will cover that shortly.

Working with Folder Tracks

Putting Tracks into a Folder Track

To put a track into a Folder Track, simply grab the track by the track name, drag it, and drop it on the folder. Just before you drop it, the Folder Track will glow, usually with a red color indicating it’s ready to receive your track.

![Folder Track after Dropping in One Track](image)
If you already have some tracks in the folder you can drag it over the folder and then down and you’ll notice a red glowing insertion point and you can put your track between other tracks to get the order you would like.

**Naming a Folder Track**

Naming a Folder Track works exactly like any other track. Click on the header part of the track where the name is, and then edit *Name* in Properties. By default, it will have a name similar to *Folder 1* or *Folder 2*.

![Naming a Folder Track](image)

**Tip:** One of the most common uses of Folder Tracks is to organize all of your drum parts into a single folder. In this case, you might want to name it ‘Drums’ or ‘Drums Folder.’

**Reorder Tracks within a Folder Track**

To reorder the tracks within your Folder Track, grab any track and drag it to the correct position. The red insertion line shows the target so you know exactly where the track is going to go. When you drag a track directly onto the Folder Track and drop it, that track goes to the topmost position.

![Reordering Tracks within a Folder](image)

**Collapsing and Expanding a Folder Track**

Click the small triangle to the left of the Folder Track name to expand or collapse the folder. When the folder is collapsed it doesn’t affect playback. All the tracks that are contained within the folder still play and respond as normal.
Soloing/Muting a Folder Track

Folder Tracks have *Solo* and *Mute* buttons just like any other track. However, they operate on all of the tracks that are contained in the folder. So if you have a Folder Track set up for your drums and you click *Solo*, you will solo all of your drum tracks. Likewise, *Mute* mutes all the tracks with in the folder.

**Note:** When you solo a Folder Track the contained tracks are soloed with a blinking *Solo* button. This indicates that the track is being soloed by the Folder Track and not directly. If you click the blinking *Solo* it will change to the standard solo state with a steady indicator.

The *Solo* and *Mute* functions are really good reasons to set up Folder Tracks for the different instrument types. I like to set up Folder Tracks for drums, for guitars, for keyboards, and another for vocals.

The Folder Track VCA

VCA stands for “voltage controlled amplifier.” For those of you with experience with analog gear that name with related to a similar feature on automated mixing consoles. In essence the VCA on the Folder Track remotely controls the level of all the included tracks proportionally. This gives you level control for the everything in the folder.
Folder Track VCA

Keep in mind that no audio passes through the Folder Track itself. The VCA acts as a remote control, proportionally controlling the volume of all of the individual Volume & Pan plugins of the tracks contained within the Folder Track. It’s a super convenient way to add top level mixing to your groups of instruments without going through the complexity of adding numerous additional bus.

Note: You can’t insert plugins on Folder Tracks since no audio actually passes through the track. To do that you would need to create a Submix Track which we’ll cover in the next chapter. ## Creating a Folder Track with Existing Tracks

With multi-track drums you often have 10, 12, or 13 tracks that you need to put into a Folder Track. Rather than drag each track individually, there is a quick way to pack the, all into a Folder Track at once.

Here’s how:

1. Select the first track by clicking on the track name. Hold down Shift and click on the last track. All of the drum tracks should be highlighted.
2. Next, right-click on the track name for any of the tracks and choose the option Create new folder track containing. This instantly creates a Folder Track containing all of your drum tracks.
3. Finally, select on the Folder Track and give it a descriptive name in Properties.
Tip: This isn’t limited to drum tracks. Create new folder track containing is my favorite way of creating Folder Tracks for any related selection of instruments or vocals.

Editing With Folder Tracks

Folder Tracks get even cooler when you discover the editing possibilities. Here is a rundown of what’s possible:

Splitting Contained Clips
To split clips across all of the contained tracks by simply selecting the Folder Track clip, position the cursor, then press Slash.

Split All Clips Within a Folder Track

Rearranging
After splitting the Folder Track clip, you can rearrange everything within the folder by dragging the Folder Track clips to any order. You can use this rearrange a song or just swap verse 1 and verse 2. If you put all your tracks in to a Folder Track you can use this for block arrangement.
Trimming
The beginnings and the endings of the Folder Track clips have trim handles. Drag to trim all the included clips.

Deleting
In addition to moving and splitting clips, you can delete entire sections of the contained tracks by separating out a section, selecting it, and pressing Delete or Backspace.

Automating a Fade within a Folder Track
You can automate the VCA fader to create fade-outs or fade-ins on Folder Tracks. We’ll get into more detail about automation in a later chapter, but here is a step by step recipe for creating fade-outs:

1. Grab the little “A” icon. That is the automation icon for the track. Drag it and drop it on the VCA fader. A red line appears on the Folder Track. That is the automation curve for the VCA fader.

1. Double-click on automation curve add points. Add two points - one before and one after the section you would like to fade.
Add Automation Points to the VCA Curve

1. Drag the last point all the way down to the bottom of the clip to draw in your fade-out.
2. Between the two points you added, notice an additional point was automatically added. This is a curvature point. Drag the curvature point to adjust the shape of the fade.

Customizing the Fade with Curvature

You can further adjust the speed of the fade by dragging all these points until it sounds like what you want. The automation points snap to the current snap increment. Turn Snap off for finer adjustment. This technique is really a time-saver because you don’t have to go in and edit each individual clip in order to do a fade-out.

Moving On

Folder Tracks are a powerful feature in Tracktion. You may have seen this concept in other digital audio workstations. Once you get the hang of how it works in Tracktion, you will be amazed at the creative things you can do with Folder Tracks.
Chapter 34 - Submix Tracks

In professional mixing, it is common to submix drums to a stereo bus to add compression, EQ, and limiting before mixing it with other other tracks. Actually, it is common to submix other things like vocals, guitars, or instruments. T6 debuts Submix Tracks that resemble Folder Tracks but with a twist - you can process a submix with plugins.

Like earlier versions, you still have the option to use any track as submix. This still works and has certain advantages. I will show you how to configure that later in the chapter.

Creating a Submix Track

Creating a Submix Track in T6 is super easy:

1. First, select all the tracks you want to include.

1. Right-click any of the tracks and choose Create submix track containing. The same action is also available in Properties as Create Submix Containing.
A Submix Track

The result looks very similar to a Folder Track. It differs in that the audio actually passes through the Submix Track. You can use the Volume & Pan plug and add any additional plugins you want.

**Working with Submix Tracks**

**Adding Tracks**
To add a track to a Submix, just drag and drop it on the Submix folder. You also drag tracks up or down within the Submix Track to re-order them. This works exactly like it does for Folder Tracks.

**Removing Tracks**
To remove a track from a Submix, simple grab it by the track name and drag it back out.

**Tip:** When dragging tracks, grab them by the track name.

**Open/Close a Submix**
A Submix works just a like Track Folder in that you can open and close it with triangular control at the far left of the header.

**Adding Effects**
You can add any built-in or third-party effect you want (accept for the Tracktion Freeze Point) to Submix Tracks. Just drag them to the mixer like any other track.

**Muting**
*Mute* works like you would expect, muting everything within the Submix Track.

**Soloing**
Okay, soloing does not work as you might expect. When you click Solo on the Submix, it mutes all other tracks including the ones contained within the Submix Track. This means that you can’t really use it. You need to mute your other submixes instead.
Note: As of the time of writing, soloing on Submix Tracks didn’t work in useful way. Maybe it will change but if not, you need to work around this by muting your other Submixes instead of using Solo. If you don’t need to add plugins to a submix, just use a Folder Track instead. Or, check out the old school submix method as described below.

Creating an Old School Submix Track

The old way to setup a submix was to use a track. I will review how that is done. You might encounter older Projects that use this method.

1. Create a track in the normal way.

![Creating an Old School Submix Track](image)

1. Name the track appropriately. In this example, I named it Drums Submix.
2. Select all the tracks you want to route to the submix.
3. In Properties, click Track Destination. Select your the Drums Submix track. This effectively routes the output of each selected track through to the drum submix track.

![Set the Track Destination on the Source Tracks](image)

Now, you can use the Volume & Pan control on your Drum Submix track to control the volume of all the tracks that you just routed to it. You can also add any plugins you want to the new Submix Track. In this example, I inserted a tape simulator and a third party bus compressor.
Submix Using Third Party Plugins

Of course, you can use any processing that you like. That depends largely on which kind of tracks and the style of music.

**Tip:** I find the soloing behavior of the old school submix technique more predictable. If soloing is important to your workflow, give it a try. The setup takes a couple more clicks and you can’t collapse the tracks. Apart from that, it’s still an effective way to set up your submix groups.

**Moving On**

I often mix to four submixes. Usually these are a combination of Submix Tracks and Folder Tracks. My standard set include Drums, Instruments, Vocals, and FX. That is a good starting point but you can submix anything that makes sense for your recordings and productions.
Chapter 35 - Automation

This chapter is an introduction to the automation features in Tracktion T6. Automation allows you to program changes to many of the parameters that exist within a track. You can easily program changes to volume, pan, and plugin parameters. You can program automation using external hardware like controllers that have knobs and faders. Or, you can program automation by adding points and changing the shape of the graphic automation curve that appears as a line on or below the track.

T6 has excellent features to keep all of your automation nicely organized. For example, you can add Automation Tracks that nest under your track. You can open them when you’re working on automation changes and edits, and then close them when you move onto other parts of your project.

In this chapter, we’re going to focus on Volume & Pan automation and then offer an example of how to extend automation to parameters within other plugins.

Activating Automation on a Track

The keys to automation are the A icon and the ‘plus’ icon that reside at the far right of each track.

The first step is to click the plus sign to add an Automation Track. You’ll instantly see the Automation Track appear below your original track. The Automation Track will have minus, A, and plus icons.

The minus icon will remove the Automation Track, the A icon allows you to set up the track, and the plus icon will add yet another Automation Track below this one.
Choosing What to Automate

For this example, we’re going to automate volume on the track. To do that, click the A icon. Then select the menu item, *Automatable parameters for this track > Volume & Pan Plugin > Volume.*

![Select the Parameter to Automate](image)

You’ll see an automation line appear. The line is labelled with the name of the parameter and the value of the parameter is listed over on the right. This line is the “automation curve.” There’s no literal curve to it yet because it’s just a line. As you will see shortly, it’s easy to draw curves, steps, and ramps.

![The Automation Curve Line](image)

Click the curve to select it and check out the Properties for it. You can change the *Name* or choose from several actions. Those make more sense once you have some automation points on the curve.

![Automation Curve Properties](image)

**Tip:** A fast way to set the automation parameter for the track is to grab the A icon and just drop it on the thing you would like to automate. Then choose the parameter from the list. So, to audio automate panning, drag the A and drop it on the *Volume & Pan* plugin and then choose *Pan* from the list. This also works for third party plugins.
Adding Points to the Automation Curve

To give your Automation Curve some shape, you need to some points on it. Add points with either double-click or Opt-click / Alt-click. Here is how to work with the automation points:

Creating a Ramp
To draw a ramp add two points and the drag one of them up or down. This adjust the steepness of the ramp. Drag the points left or right to adjust the start and ending of the ramp.

Drawing an Automation Ramp

Shaping with Curvature
To shape the line segment between points you can use the Curvature the point. A Curvature point is automatically inserted midway between two automation points. Adjust Curvature by dragging diagonally.

Adjusting a Curvature Point

Tip: The automation point can also be adjusted in Properties using the Value parameter slider. You will also find a slider for Curvature in Properties.
Drawing an Automation Step

Insert two points that define the position of the step. Hold down Cmd / Ctrl and drag the line segment between the points up or down. You’ll see that the line segment moves separately from the overall automation curve. This makes it really easy to draw in a step shape on your automation. If you don’t hold down Cmd / Ctrl, then the entire automation curve moves.

Automating Fade-ins and Fade-outs

To program a fade shape with automation, add a point where you’d like the fade to start, then add another point where you’d like the fade to end. Drag the second point all the way down until the value reads zero. Adjust the speed of the fade by dragging point down to the left for a quicker fade or up to the right for a more gradual fade. Dragging the Curvature point to adjust the shape of the fade ramp. Of course, you always have the option to adjust that parameters directly in Properties.

As we discussed in a Chapter 33, if you program an automation curve for a track folder, you can apply a fade across all the tracks together.

Converting a Clip Fade-in or Fade-out to Automation

As you’ve already learned you can easily apply fade-ins or fade-outs to Audio Clips with the fade handles on the upper left and right corners of the clip. If, for some reason, you’d like more control over the fade shape you can convert a clip level fade to and an automation curve.

To convert a clip fade to automation, first select the clip and then click Copy Fade To Automation > Transfer Fade-in to Automation, Transfer Fade-out to Automation in Properties.
Copy Fade to Automation

That will redraw the automation curve in the shape of the fade and remove the clip fade from the clip. Now you can apply additional points and shaping using the automation tools.

Result of Copy Fade to Automation

**Reading Automation**

Once you’ve drawn automation like this, T6 performs the automation dynamically during playback. That is provided you have *Automation Read* enabled on the Transport.

As you playback watch the controls changing in real time as the cursor moves through the Edit. If you go back about three decades that feature would cost you about a million bucks!

**Automation Curve Properties**

The automation curve has several of its own properties. Click on the curve to selected it and look at Properties. Here is a rundown of the controls:
Curve
The Curve property is the name that appears above the automation curve. This is here for reference only. You can’t change it directly. It is made up of the track name, the plugin name, and the parameter.

Displace Curve
Displace Curve allows you to drag left or right which offsets the curve up or down. It basically takes the entire programmed curve and set of points, and moves them down if you drag left or up if you drag right. This is very useful to make minor mix changes after the automation is already programmed.

Scale Curve
Think of Scale Curve to function like an intensity control. As you drag to the left, it proportionately lowers all of the points on the curve - squashing the shape of the curve. Dragging to the right expands the curve, scaling it upward.

Only Displace/Scale the Marked Region
This parameter works along with Displace Curve and Scale Curve. When enabled, any scaling or displacing, only occurs between the In-marker and the Out-marker.

Simplify
If your automation curve becomes very complex with lots and lots of points, you use Simplify to thin out the points. I usually choose Simplify the entire curve and the pick from Light, Medium, and Strong. The Light option does the least thinning where Strong thins the most. This particularly useful if you recorded automation from a hardware controller that added hundreds of points.

You also have the option to Simplify only in marked region. I use this if I want to simply just a section that was recorded from hardware leaving the rest of the curve unchanged.
Delete Points from Curve
This set of options allows you to completely reset the automation curve. If you delete all points from the curve, you’ve basically taken it back to a flat line. Sometimes this results in the automation value being set very low, so you might need to drag the curve line back to a good starting position.

You can also Delete points within the marked region which means you’ll delete all the points between the In-marker and the Out-marker. You can do the same thing and “close the gap,” means to take out the time within the marked region.

Copy the Marked Region to the Clipboard
Set the In-marker and the Out-marker over a region of automation and click Copy Marked Region to the Clipboard to copy that region of the curve. Then, position the cursor to the destination and select Paste From Clipboard > Paste Curves at Cursor Position and that pastes the automation. This makes it fast to create repeating patterns of automation.

This is also useful if you’ve created a very specific effect using automation and want to reproduce that effect in a later part of the song.

Paste from Clipboard has two options. Most of the time I would use Paste curves at cursor position. You can alternatively do that with Cmd + V / Ctrl + V.

Alternatively, choose Paste curves to fit between the in/out markers. That allows targeting the destination only within the merged region. Normally you paste at the cursor position.

Tip: You don’t need to manually copy automation when moving or duplicating clips on a track. Enable Auto Lock in the Master section and the automation follows along as you move or duplicate clips.

How to Find Out What Automation is Active for a Track
It’s pretty easy to program a lot of automation, but sometimes you don’t have all of the automation curves visible. To see which ones are available click the A icon and select Active Parameter Curves for This Track. This shows all automation curves for the track and you can choose which one to make visible.
This is particularly helpful if you don’t have each parameter on a separate Automation track.

**Remap on Tempo Change**

Each plugin has a *Remap on Tempo Change* setting in Properties. With that enabled, as you change the tempo of the song, the automation will track the tempo changes. That means it will get smaller if you speed up the tempo or it will get longer in order to match the clips in your Edit. This is a great feature but is not enabled by default. Also you need to turn it on for each plugin.

**Tip:** I suggest you turn *Remap on Tempo Change* on as a global option for all new Edits. To do that, enable *Timecode > Default remapping options > Remap plugin automation* from the Menu section.
Make Remap the Default

Note: Remap Plugin Automation is not set as the default or turned on by default to maintain compatibility with older projects. This setting and the new default option were new for T6.

Writing Automation on the Fly

During playback, you can adjust a parameter in real time and have T6 record it as automation. You can do this with a MIDI controller or just by manipulating plugin controls on-screen during playback. All you need to do is set up your automation track and enable Automation Write mode.

To go into write mode, enable the Automation Write button on the Transport. Now, during playback, Tracktion will record any dynamic changes you make to the parameter.
Note: You don’t need to be in Record mode to record automation changes. All you need is to have automation write turned on during playback.

Tip: When you’ve written automation this way, it’s often a good idea to use Simplify to thin out the automation points. I get good results with the Medium option.

Automation Lock

Notice in the Master section, there is an Auto Lock button. By default that button is not engaged. If you move a clip around on a track, the automation will not follow it to the new position.

With Auto Lock engaged, automation will follow as you drag the clip to a different place in time. It’s a great feature, assuming that’s what you want to do.
Moving On

There is a lot more you can do with automation because you can automate almost any parameter. You can automate sends to effects. You can even automate your Master plugins. Just create a separate track and drag the A icon from that track over to the Master section plugins to automate those.
Chapter 36 - Mixing Down

In this chapter we’re going to go over the steps required to mix down your Edit to a WAV file or MP3 file.

Master Section Processing

Before you mix down, you might want to add some Master effects so the entire stereo mix is processed. Master plugins often include a compressor and a limiter to give the final mix a professional sound.

I’m not going to get into the details about exactly what you’d apply there. The Tracktion Master Mix plugin is a nice choice. It’s a multi-band compressor, EQ, and limiter all in one. It is available in the Tracktion Marketplace or as part of some of the Tracktion bundles.

Regardless, make sure that the metering for the Master section is not going into the red before you export the mix. Exactly how you process the mix depends on what you plan to do with the file after it’s mixed down.
If you’re having professional mastering done, then you probably don’t want to put any plugins on there, except maybe just a tiny amount of limiting. But if you are immediately going to upload to your website or SoundCloud, you will want to put some mastering effects on to make your mix into a finished product.

**Exporting to a WAV File**

Here are the steps to export your song as a WAV file:

1. Set the In-marker exactly at the beginning of the song. This defines the start of the export. Adjust the position of the In-marker to skip any extra bars or count-in at the beginning of the Edit.

1. Set the Out-marker right after the end of the song. This allows you to control the exact length of the exported file. I usually leave a couple of extra milliseconds after the final fade.

1. Select *Export > Render to a file* from the Menu section. The *Render* dialog box appears.
The above example shows the most common settings for exporting a WAV file. You can customize the file location and name if you want. Also, make sure to select *Only Render Marked Region* so that the In-marker and Out-markers are used to define the export region.

1. Click *Render* and the export happens. Tracktion starts processing in the background as you adjust the settings. Much of the time export is already done as soon as you click *Render!*

**Locating the Exported File**

Unless you change the file path, the file saves to the project folder. You can find the file either on the Projects tab or from the Browser.

**Locating the Export on the Projects Tab**

Click the Projects tab and look at the *Exported Audio/MIDI* list at the right. Unless you changed the filename, your exported file will be there with the word “Export” and an export number appended.

To locate the file in Finder or File Explorer on your computer, select the exported file and look at Properties. In Properties, click the ... button to the right of *File* and choose *Open the folder containing this file.* That opens the folder on your system giving you direct access to the file.
Locating the Export in the Browser

Open the Browser and go to the Files tab. Click the folder icon and select *Project folder*.

![Project folder in the Browser](image1)

Locate the Project folder from the Browser

Double-click the folder named *Exported* and you will see your file. To locate it in Finder or File Explorer, right-click and choose *Open the folder containing this file*.

![Exported Folder in the Browser](image2)

Exporting to an MP3 File

The steps to create an MP3 file are almost identical. Follow the same steps above except when you get to the *Render* dialog box select MP3 for *Format*. That selection gives you a few extra options for Rendering.

Add ID3/Vorbis Info

With MP3 exports you can select this option to add metadata to the file.
Add ID3/Vorbis Info

To enter the metadata, click *Edit* to the right of the option. That gives you the *ID3/Vorbis Info* dialog box. Fill in any information you want to include in your MP3 and click *OK*.

ID3/Vorbis Info Dialog Box

This information is not required. So, if you don’t care to include the info, leave the *Add ID3/Vorbis Info* deselected.

Quality

You can choose from common MP3 quality settings. VBR stands for “Variable Bit Rate” and helps optimize the file size in exchange for a bit more complicated decoding. CBR stand for “Constant Bit-rate” and gives you slightly larger files that are encoded consistently.
I normally choose 192, 256, or 320 KB/s CBR. Those will give you good sounding MP3 files to upload to various sites or use in your own player.

**Additional Render Properties**

The *Render* dialog box has numerous settings. Often you can skip looking at all of this stuff and just hit *Render* and of course you will get an output file. However, it is a helpful to know what the other properties do. Here is a rundown:

**File Name and Location**

The first line is the file name and the location of the output file. You can edit that to name the file with the song name. You can also update the destination folder location on your system. By default it will be export to an “Exported” folder location in the project folder.

**Format**

While exporting to WAV and MP3 files are the most common choices, Tracktion supports several other file types:
Stereo
For music it is most common to export to stereo files. If you deselect Stereo the file is exported as mono. I frequently use mono exports for various types of voice over submissions.

Remove Silence at Start/End
This does, as it says. If there is excess silence before the song or if there is a long silence at the end, Tracktion will take that out. I normally don’t use that. I like to be in control of the start and the end myself, so I usually leave that option turned off and define exactly what I want to export using the In-marker and Out-marker.

Dithering Enabled
If you don’t know anything about dithering, then just leave this enabled and move on. If you do know about dithering then you can turn this off and add a third-party plugin in the Master section and configure it to dither as you please.

Only render the marked region.
Whenever Tracktion indicates “marked region”, it means the range between the In-marker and the Out-marker. When enabled, the exported file only includes the audio between the In-marker and the Out-marker. I almost always use this. That’s why I carefully place the In-marker and the Out-marker in the step-by-step export guide above.
Render Each Track to a Separate File
If someone else is going to mix your song in a different digital audio workstation then you might want to export every single track in a way that can be imported into another system. If that’s the case, then turn this option on and you’ll wind up with a whole collection of files - one for each track of your project. For a normal stereo export, leave this turned off.

Render at 1X Play-Speed
If you are using the Insert plugin to mix through some external hardware effect then turn this on when exporting your mix. Normally, you leave this option turned off. When enabled the Edit will render in real time, meaning, it will mix it down in exactly the same amount of time it would take to play back once. Some feel they get the best sound quality rendering at 1X. For that reason, some Tracktion users enable 1X rendering for the final master exports. For the vast majority of projects I work on in, I leave this turned off.

Normalize
Normalize adjusts the overall gain of the file so that the highest peak fills up the available bit depth. Most of the time you will leave this turned off. In some very specialized situations you might need to normalize, and even if you did, I wouldn’t do it right here.

Adjust Level Based on RMS
Adjusting the level based on RMS is a way to set the output to match a perceived volume level. Modern broadcast standards require your files not to exceed standards based on the country and use. I probably wouldn’t use this feature and instead use a plugin like Nugen ISL 2⁴⁷ instead. There are many other options for broadcast level limiting and metering.

Render Automatically
This is kind of a cool feature of Tracktion. In the background, as soon as you open the Render dialog box it starts mixing down. It even shows you the progress on the lower waveform display. If you don’t make any changes to the settings, as soon as you hit Render it’s done instantly. Tracktion already created the file in the background. It’s sort of like working ahead. If you do make changes it will start re-rendering right away. If you have a slower computer or you just find this behavior annoying you can turn Render Automatically off.

⁴⁷http://bit.ly/1M47HfS
Add to Library
Add to library means you will add what you are mixing down to your loop library so that you can search for it and use it in another project. It’s kind of a cool idea if you are mixing a lot of things to add to your library to build it up. I would say that I never use this feature and I always leave that turned off.

Moving On

We have gone all the way from installing the program, to recording, editing, adding virtual instruments, using guitar amp sims, mixing, and mixing down. There’s still a lot more that you can learn and explore about Tracktion and your own music. Have fun, and make a lot of music.
Chapter 37 - Macros

Tracktion includes not only programmable shortcuts, but also a full macro programming environment. You can develop keyboard shortcuts that combine actions in new ways to streamline your workflow. If the standard keyboard shortcuts don’t meet your needs, you can create custom macros and assign keyboard shortcuts to them.

While you might think of macros as keyboard macros, you don’t have to assign them to keyboard shortcuts. You can always launch them from the Run Script button in the Menu section. I like this because you don’t have to remember the shortcut to macros you only use occasionally.

Script Editor

To open the Script Editor go to the Settings tab, and select the Keyboard Shortcuts page. Enable Show Script Editor at the bottom right of the Keyboard Shortcuts page. The Script Editor will open.

![The Script Editor](image)

You can resize the height of the Script Editor by dragging the line that separates it from the keyboard shortcuts list. The Script Editor is a basic text editor that you use to enter and edit macro scripts.

Tip: With the Script Editor open try clicking on some of the existing keyboard shortcuts. The Script Editor will show you the underlying code. I use this to get familiar the syntax of the actions triggered by each shortcut.

Creating a Macro

To create a new macro, click Add a new macro on the Script Editor. This adds a new macro named “Untitled Macro” to the bottom of the keyboard shortcuts list under the Macros section.
As soon as the new macro is created the name defaults to *Untitled Macro* and is selected. Start typing to give it a suitable name.

In the body of the macro, you can type in a list of actions to create the script. The easiest way is to build your macros using the right-click menu - more on that in a bit! Actions are separated by semicolons.

**Deleting a Macro**

While you can’t delete the built-in keyboard shortcuts, you can delete any custom macros you create. To do that, select the macro to delete in the keyboard shortcuts list, and click *Delete macro* in the Script Editor.

**Programming a Macro**

The simplest macro is made up of a single action. You can pick any available action by right-clicking the Script Editor and navigating through the three collections of actions. When you find an action you want to use, select it and the appropriate code will be inserted into the script.
Selecting Actions from the Script Editor Right-click Menu

- **Actions > Standard Shortcuts** includes all the built-in keyboard shortcuts shown on the Keyboard Shortcuts page.
- **Actions > Basic Actions** includes available actions that are not necessarily available as pre-assigned shortcuts.
- **Actions > Advanced actions** includes actions that allow you to manipulate selected objects and even display messages on the screen. Advanced actions are provided as tools for more advanced script programming.

### Running a Macro

There are several ways to run a macro:

1. Assign it to a keyboard shortcut. Keyboard shortcuts are assigned to macros in the very same way as the built-in shortcuts. Find the macro in the list and click the “+” to the far right and enter the desired key combination.
2. Click **Run Script > User Macros** from the Menu section of the Edit tab. All your custom macros appear there automatically. Select the one you want to run.
1. Add macros to the Custom Menu. At the bottom of the Keyboard Shortcuts page, click to enable *Show Script Tree Editor*. Then drag your macros (or any built-in actions) to the tree editor. Arrange it using drag and drop, add groups, and rename groups. Access the Custom Menu from the menu in the Edit - *Run Script > Custom Menu*.

**Javascript Programming**

Beyond creating simple step-by-step lists of actions, you can take macro programming to the next level using the power of Javascript. The Script Editor allows you to program loops and conditions using Javascript syntax. It even provides color coding for the elements of the script.
Note: Tracktion actions are exposed as methods using ‘dot’ notation. By that I mean that they start with the word Tracktion, then a dot, then the method. Following the method you can provide one or more parameter in parenthesis.

Hover Tooltip

If you hover over an action in the script editor for a second or two, you will see a tooltip bubble explaining what parameters the action takes. If the action returns values you will see the syntax of that. These tooltips give you key information when programming macros. Tracktion developers use this to give you meaningful clues about how each of the actions work.

In the above example the the tooltip shows that the zoom action takes two double precision numeric parameters. The first is the x-proportion (the amount of vertical zoom) and the second is the y-proportion (the amount of horizontal zoom).
RTZ Macro Example

By default Tracktion doesn’t have a true return-to-zero (RTZ) keyboard shortcut. The built-in command stops first if it encounters the In-mark so you need to hit it twice to really get back to zero. However, you can create a macro that just does the action twice - always returning the cursor to the start of the Edit.

![True Return-to-Zero Macro Example](image)

I assign the RTZ macro to the Home key because I prefer this action over the default.

Merge Clips Macro Example

Another feature that I use often is *Merge Clips*. Normally you use this by selecting a few clips on a track that you want to combine to a single clip. Then you select *Render Clips > Merge the Selected Clips* from Properties. I do this so frequently, I want to do it with a single keyboard shortcut. On my systems, I assign it to Cmd + G / Ctrl + G.

![Merge Clips Macro Assigned](image)

Importing and Exporting Macros

Macros are actually just simple text. You can easily copy and paste the text directly in and out of the script editor. In addition, Tracktion has dedicated buttons to import and export macro scripts as XML files with a .tracktionscript extension.

![Script Input and Export Buttons](image)

TSC Code Samples

Dave Rowland at Tracktion has kindly supplied code samples of several macro scripts to get you started:
// Rename Clips From Track
var tracks = Tracktion.getSelectedEditElements ('track');

for (var i = 0; i < tracks.length; ++i)
{
    var track = tracks[i];
    var trackName = Tracktion.getName (track);
    var clips = Tracktion.getClipsFromTracks (track);
    for (var c = 0; c < clips.length; ++c)
    {
        var clipName = trackName + " " + (c + 1);
        Tracktion.setName (clips[c], clipName);
    }
}

// Reset Tracks Solo/Mute
var tracks = Tracktion.getEditElements ('track');
Tracktion.setSolo (tracks, false);
Tracktion.setSoloIsolate (tracks, false);
Tracktion.setMute (tracks, false);

// Next Active Automation Parameter
var track = Tracktion.getTrackFromSelectedObject();
Tracktion.changeActiveAutomationParameter (track, 1);

// Insert Plugin with Preset
var track = Tracktion.getTrackFromSelectedObject();
var plugin = Tracktion.insertPlugin (track, "Massive", 0, "AudioUnit");
var preset = Tracktion.getPresetFromLibrary ("Massive All Souls");
Tracktion.setPluginPreset (plugin, preset);

// Jump to tab 2
var index = Tracktion.getWindowTabIndex();
var delta = 2 - index;
Tracktion.changeWindowTabIndex (delta);
// Rename Selected Tracks
var tracks = Tracktion.getSelectedEditElements ('track');
Tracktion.setName (tracks[0], 'Kick');
Tracktion.setName (tracks[1], 'Snare');
Tracktion.setName (tracks[2], 'Hats');
// etc.

// Save Selected Plugins as Preset
var plugins = Tracktion.getSelectedEditElements ('plugin');
Tracktion.saveObjectsAsPreset (plugins);

My Code Samples

/* Park the In-Marker & Out-Markers
Parks the In-marker and Out-marker at Zero then Restores Cursor Position. I wrot\ne this macro to help a KVR forum member find a quick way to hide the In-marker a\nnd Out-marker.
*/
var SavePosition = Tracktion.getPosition ('cursor');
Tracktion.moveTransportToStart();
Tracktion.moveTransportToStart();
Tracktion.markIn();
Tracktion.markOut();
Tracktion.setPosition ('cursor', SavePosition);

/* Search Plugins
Opens the Browser to the Search tab, enables the Plugin searching while disablin\ng searching for Presets and Loops.
*/
Tracktion.showSidePanel ('search'); // Opens Browser to the Search tab
Tracktion.enableSearchLibrary ('plugin', true);
Tracktion.enableSearchLibrary ('preset', false);
Tracktion.enableSearchLibrary ('loop', false);
Tracktion.setSearchPanelText (''); // loads blank text so you can start typing \nthe search term right away
// Rename selected clips to 'Drums'
var clips = Tracktion.getSelectedEditElements ('clip');
for (var i = 0; i < clips.length; ++i)
    Tracktion.setName (clips[i], 'Drums');

// Rename selected tracks to 'Drums'
var tracks = Tracktion.getSelectedEditElements ('track');
for (var i = 0; i < tracks.length; ++i)
    Tracktion.setName (tracks[i], 'Drums');

Moving On

These are fairly simple examples. Tracktioneers are only just starting to explore the powerful capabilities of macro programming in Tracktion.
Chapter 38 - New in Tracktion T7

Tracktion T7 comes with a host of new features and workflow tweaks. Learn about all what’s been added and changed in this chapter!

Tip: If you want to further explore the new features as video tutorials, check out my series Tracktion T7 Update Explained available at Groove3.com.

New Interface Look

Tracktion T7 debuts a new look with bolder clip colors and a choice of a light or dark background. The UI features a modern design, new text style, and subtle shading.

There are two new options in the Settings tab, General Behaviour page:

![Tracktion T7’s Bold New Look](https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained)
Use Light Color Scheme & Low Detail Options

**Use Low-Contrast Interface**
Enable *Use Light Colour Scheme* for a bright and clean look for the background, timeline, and controls.

**Use Low-Detail Interface**
Enable *Use Low-Detail Interface* to eliminated gradient effects on clips and other interface objects. Personally, I like the look better with this option enabled.

*Note:* Apart from these two options, the new color scheme can’t be changed. The color editor feature has been retired. The good news is that you won’t waste time tweaking the colors so you can spend more time recording!
Compact Toolbar

To save space while recording, Traction offers an alternative to the traditional Controls Panel. The new compact Toolbar does most everything the standard Controls Panel does while taking up a fraction of the screen space. Not only that, you can switch back and forth between the Toolbar and Controls Panel easily.

The New Compact Toolbar

To open the full Controls Panel from the Toolbar, click the open icon at the far left.

Click the Open Icon

To shrink the Controls Panel down to the compact Toolbar, click the close icon at the top right of the Menu Section.

Click the Close Icon

The left side of the Toolbar includes icons to open and close the Menu and Properties sections along with dedicated Undo and Redo buttons. Also, all of the buttons from the Master section appear as icons on the Toolbar.

The Toolbar Icons
Tip: Hover your mouse pointer over any icon on the Toolbar and look at the rollover help in the upper right corner of the Tracktion window to see what it does.

**Working with Properties in Compact Mode**

In Tracktion, you often need access to Properties. With the compact Toolbar, the pop-out Properties panel closes every time you select a different object - clip, track, automation curve, or plugin.

To keep Properties open you can lock it using the push-pin icon at the upper right. With it pinned, Properties will only close when you click its icon on the Toolbar. I leave it pinned all the time and open and close Properties manually.

Tip: There is a macro action in the script editor to enable the Properties lock push-pin under Basic Actions > Editing > Lock properties panel.

```javascript
// Lock Properties Panel
Tracktion.lockPropertiesPanel();
```

**Keyboard Shortcut to Toggle the Toolbar**

If you want to easily switch back and forth between the Toolbar and the standard Controls Panel, there is a new macro action to do that. Here is how to set it up:
1. Go to the Settings tab, Keyboard Shortcuts page.
2. Open the Script Editor at the bottom of the page.
3. Click Add a new macro.
4. Fill in a name such as “Toggle Controls Panel Size.”
5. Right-click the editor and navigate to Basic Actions > Zooming > Toggle between full and minimal controls panel.

Selecting the Toolbar Toggle Action

1. That’s all there is to the macro. Now, assign it to a keyboard shortcut - I used F11.

The Completed Toggle Controls Panel Size Macro

Note: In the alternative key-mapping used in this book, F11 is assigned to Show/Hide Controls Panel. I find that toggling between the Toolbar and the Controls Panel is a much better use of F11 so now I change this on all my Tracktion installations.

Browser Position

If you ever wished the Browser were over on the right instead of being stuck on the left, you are in luck. You can move it! Not only that, you can move it to the top of the screen if you want. There are two ways to set the Browser position left, right, or top.

Drag the Browser

With the Browser open, drag the Browser open/close button to the top edge, right edge, or left edge of the screen and drop it.
From the Settings Tab

Alternatively, you can configure Browser position as global preference. Go to the Settings tab, General Behaviour page. Locate the Side Panel Position option and choose from Left, Right, or Top.

Multiple Browser Panes

It’s now possible and easy to have multiple views into the Browser at the same time. To add a Browser pane, click the tiny + icon at the top right.

When you have multiple panes, each pane has a drop-down menu at the top to choose the Browser view - Files, Tracks, Search, Notification, Markers, or Clipboard.
Choosing the View

You can open as many Browser panes as you want. I like to have one pane showing my Files and another set to Search by plugins.

My Setup With Two Pains

The above image above shows the Browser at the top but I normally keep it over on the right. To close a Browser pane, click the small X in the upper right.

Click X to Close a Browser Pane

Synchronized Previews

If you have multiple Browser views open and focused on loop files, you can audition the loops against your song synced to the Edit tempo.
Multiple Browser Preview

Since Tracktion allows multiple Browser panes, you can start previews for several loops at the same time. The Browser preview options have been updated with this in mind. Click the preview options button to open the selections.

Play All
This is a new option to start the preview of all selected loops across all open Browser panes.

Stop All
This stops all preview playback in all Browser panes.

Re-trigger on play
Whenever you start playing back a new loop, all Browser panes that have loops playing will re-start from the beginning. You will want to enable Re-trigger on play for each open Browser pane for synced auditioning.

Auto-play
With Auto-Play enabled, each time you click a loop or select a new loop in a Browser, preview playback will start.

Loop
With Loop on, preview playback will keep repeating until you stop it. With Loop disable, the preview plays a single time then stops.

Tip: Enabling Re-trigger on play is essential to have multiple Browser panes preview in-sync.
When you find a set of loops that work well together using multiple Browser panes, you probably want to drag them to your Edit. You can do this in a single operation by dragging one loop while holding Shift. The Shift modifier caus all the loops to be included in the drag. Next, drop the all the loops and you are presented with a list of options. Select how you would like the clips to be added to the Edit.

![Multiple Clip Shift-drag Options](image)

**Video Clip:** This video tutorial\(^4\) demonstrates this feature but was created before the Options menu was implemented.

## Zoom Tool

Tracktion T7 offers a new fast and efficient new way to zoom in and out. Hold down Shift-Opt / Shift-Alt and drag a selection over the arrangement. As you drag, a magnifier loop icon appears. When you let go, you are zoomed in on that area of the screen.

![Dragging a Selection with the Zoom Tool](image)

The zoom tool is multilevel. Zoom in several times then again hold Shift-Opt / Shift-Alt and click to zoom back out. Each click steps you back one zoom level.

---

\(^{4}\)https://youtu.be/KEVGBgm9U28
Tip: There are also new keyboard macro actions that you can assign to the keyboard to undo and redo the action of the zoom tool. The actions are found at Basic Actions > Zooming > undo mouse select+zoom and Basic Actions > Zooming > redo mouse select+zoom from the Script Editor.

```
1  // Undo Zoom
2  Tracktion.undoSelectZoom();

1  // Redo Zoom
2  Tracktion.redoSelectZoom();
```

**Project Tab - Three Column View**

The Projects tab now has a three column view. These columns represent the Edit list, assets pool, and exported files. You can choose which columns to have on-screen using the View Options selector at the top right.
If you prefer the long single list from earlier version of Tracktion, choose *View as single list* from the *View Options* selector.

**Tip:** I like the keep the assets pool column turned off. Usually, you don’t need to look at them and probably should not mess with them anyway!

**Project Tab - Edit Previews**

The Project tab Edit list now includes a playable thumbnail preview of the mix of each Edit. Tracktion renders this preview in the background during idle time when an Edit is open and updates it periodically. You don’t need to do anything at all. Click the thumbnail to play the preview and drag the play cursor around to hear different parts of the song.
The *Share* button to the right of the preview thumbnail gives you two ways to share the Edit.

![Share Button Options](image)

*Preview Share Button Options*

*Share as archive of this edit* takes you directly to the *Create Archive* dialog box. From here you can export the Edit as a project bundled with all necessary assets to load back in to Tracktion on another computer.

![Create Archive Dialog Box](image)

*Create Archive Dialog Box*

The other option on the *Share* button is *Share a preview of this edit*. This simply locates the preview audio file on your file system. From here you can do what you want with it. It's in the Ogg Vorbis format.

![Share Preview Option](image)

*Share Preview Option*

**Note:** Don’t drag, move, or erase the preview file. You need to leave it in this location for the preview to work on the Project page. If you want to use it somewhere else, copy it first.
Project Tab - Get Demo Songs

The Menu at the lower left of the Project tab includes a new button - Get Demo Songs. Click that for a quick way to download some Tracktion demo Projects. For a full description of this feature refer to Chapter 3 - Installing the Demo Projects.

Drag to Set In-marker & Out-marker

Users of other DAWs are used to dragging along the timeline to draw in the loop range. With Tracktion the loop range is defined by the In-marker and Out-marker. In the past you always needed to set both separately. Tracktion now offers a fast way to “draw” in the range between the In-marker and Out-marker.

1. Double-click to set In-marker

2. Drag right to set Out-marker

Double-click Drag to Set In/Out Markers

Double-click on the Timeline and start dragging right. The double-click positions the In-marker at the starting point. As you drag right, the Out-marker drags along and is set when you lift the mouse button.

Video Clip: Here is a video tutorial\(^\text{50}\) demonstrating how to drag to set the In-marker and Out-marker.

Auto Show Panels

With the Browser, Mixer, or Controls Panel hidden, move the mouse pointer to the appropriate edge of the window and the panel will slide open. When you move your pointer off the panel, it will be hidden away again.

\(^{50}\)https://youtu.be/zaFg0dp4pe4
Give it a try and notice the animation of the new UI as the panels slide in and out. There is nothing to configure. The auto show feature is available anytime you have a panel hidden.

**Note:** The auto show feature also works for the new compact Toolbar.

**Tip:** To turn off the auto show panels action, deselect *Automatically hide and show panels* in the Settings tab, General Behaviour page.

![Turning off Auto Show Panels](image)

### Visual Plugin Selector

The Plugin object has a new right-click option to open the Visual Plugin Selector. Once open, you can drag a plugin thumbnail to the mixer in the normal way. See Chapter 39 - Visual Plugin Selector for a complete explanation of this feature.

### Group Clips

With Group Clips, you can combine clips on a track into a single grouped clip without rendering. The advantage of this is that you can ungroup at anytime for access to the individual clips.

To create a Group Clip, select the clips you want to group on a track. It doesn’t have to be a contiguous selection, but the clips do need to reside on the same track.
Next, click *Create Group Clip* in Properties.

![Click Create Group Clip in Properties](image)

Notice that the resulting clip has a “Group” label and icon on the lower left which indicates the number of clips it contains. It also has a simplified header.

![A Group Clip](image)

To ungroup the clip back to the original state, select it and click *Ungroup* in Properties.

![Click Ungroup in Properties](image)

If you like, you can create a macro and assign *Group Clips* and *Ungroup* to keyboard shortcuts. In the Script Editor, locate the actions under *Basic Actions > Editing > Group selected clips* and *Basic Actions > Editing > Ungroup selected clips*.

Here is the code:

```javascript
// Group Clips Macro
1 Tracktion.groupSelectedClips();

// Ungroup Clips Macro
1 Tracktion.ungroupSelectedClips();
```

I find Group Clips to be useful when working with beats created from sliced up audio. You can treat the Group Clip as a single single clip making move and duplicate operations straightforward. At any point you can ungroup it to modify the various parts.
Linked Clips

You can also easily create linked copies of clips that reference the same underlying audio file or MIDI data. Changes to the original clip then are reflected to any of the linked copies. This works for Audio clips, MIDI clips and Step clips.

To create a linked clip, drag the *Linked Clip* handle from the clip header. As you drag, you are dragging a copy referenced back to the source clip.

In the following image, I dragged over a linked copy of an audio file. Notice that the lower left of each clip shows a “link” icon indicating that this is a linked clip.

To test the link, I reversed the audio on the first clip. Since this changes the underlying file, the second clip is also reversed.

Non-destructive edits like splits and fades don’t affect the linked copy. However, anything that affects the underlying file will. For other examples of this type of edit select and audio clip then in Properties
open View Source Info > Edit Audio File > Basic Editing Operations.

![Basic Audio Editing Operations](image1)

From this dialog you can perform several kinds of edits to the underlying file. These operations will affect all linked copies as well as the original.

Linked clips might be even more useful for MIDI clips. Any changes made to one of the linked clips are reflected to all the copies. This can be useful when creating a beat that is used many places in a song. If you update one linked copy, they all get revised.

![Linked MIDI Clips on Separate Tracks](image2)

While you could so something similar with looped clips, looped clips are a series of continuous repeats on a single track. Linked clips appear as separate clips and can even be placed on separate tracks.
Step clips can also be copied using the *Linked Clips* handle.

**Tip:** It’s a bit more difficult to identify linked Step Clips because they don’t have clip names along with the link icon. You can identify linked Step Clips because the *Linked Clip* handle in the header turns green whenever there are linked copies present. This holds true for linked Audio clips and MIDI clips as well.

### Automation Patterns

Tracktion lets you quickly create repeated automation patterns between the In-marker and the Out-marker using a new feature located in Properties.

1. To get started, create an automation curve for a parameter you would like to modulate. In this example I am using a simple volume curve.
2. Then, set the In-marker and Out-marker over the range to which you want to apply the pattern.
1. Select the automation curve, then in Properties click *Create Pattern Between the Marked Region*.

![Create Pattern Between the Marked Region](image1)

1. Next, choose from the various pattern shape options. For this example I chose *Triangle*.

![Select the Pattern Shape](image2)

1. Choose a note division for the pattern or number of repeats. In typical Tracktion fashion, I chose 1/2 beat in order to repeat the pattern every 1/8th note.
Select Beat Division or Repetitions

Here is the resulting automation.

1. Adjust the curve using the *Displace Curve* and *Scale Curve* drag controls or by editing the automation points in the usual way.
Displace and Scale Curve Controls

Here are examples of the other automation pattern shapes:

- **Sine Wave**
- **Square Wave**
- **Ramp Up**
Automation Ramps

As a companion to automation patterns, Tracktion allows you to ramp patterns up or down in a very simple and effective way. This works in conjunction with patterns to allow you to increase or decrease the intensity of a pattern over time. The two *Ramp* options work as modifiers to the existing *Displace* and *Scale* tools.

Automation Ramps are best explained with an example:

1. Set the In-marker and Out-marker over a segment of automation you would like to ramp in.
1. Click on the automation curve to select it.

2. In Properties, click *Ramp from the start of Marked Region* to enable the ramp behavior.

---

1. In Properties, manipulate the *Displace Curve* and *Scale Curve* sliders. Notice how these affect the left side of the curve allowing you to fade in the automation pattern.
The companion *Ramp from the end of the Marked Region* allows you to taper automation down.

These new features are easy to miss at first glance, but they provide tremendous creative potential when programming automation.

**Tip:** The automation ramp features are also available when working the *Volume & Pan Clip Layer* effect which is explained in Chapter 41 - *Clip Layer Effects*.

**Video Clip:** Here is a video clip⁵¹ that demonstrates the automation ramp modifiers.

### Plugin Sidechains

In previous version of Tracktion, you needed to configure a Plugin Rack to use a sidechain input on plugins that support a sidechain. Since T7 this has been greatly simplified.

Plugins that support a sidechain input will now have a side chain assignment list at the upper left in the plugin header. Simply pick which track you want to route to the sidechain.

---

⁵¹[https://youtu.be/koDUoO3XD-0](https://youtu.be/koDUoO3XD-0)
Selecting a Sidechain Input

In the above example, I routing the kick track to the sidechain input of a gate on the bass track. It’s a common trick to lock the bass to the kick.

Video Clip: Here is a video tutorial\(^2\) demonstrating how to use the new plugin sidechain feature.

First Run Setup Progress

When you run Tracktion for the first time, you will see the First Run Setup Progress panel over on the left. As you click each item, it takes you directly to the page and feature on the Setup tab needed to complete the task. The tasks are to streamline setup and get new users configured and running quickly.

\(^{2}\)https://youtu.be/PEan2nhPCOA
First Run Setup Progress Panel

If you close the panel and wonder how to get it back. Navigate to Help > Show First Run Setup.

Turning First Run Setup On

**Scroll Behaviour**

Starting with T7 scroll behaviour options are consolidated on the Options menu into a new submenu - Scroll Behaviour.
The Scroll Behaviour menu features the new default option *Scroll with playback*. Here is a rundown of what each option does:

**Scroll with playback (default)**
During playback the cursor stays on screen. As the cursor goes past the right edge, the tracks page over keeping the cursor in view. I recommend you always leave this selected.

**Scroll smoothly**
During playback, when the cursor arrives at a fixed position near the center of the screen, the tracks scroll under the cursor. This is a matter of personal preference. If you decide to use this option, I recommend also selecting *Scroll with playback*.

**Keep cursor on screen**
During playback the cursor will stay on the screen. Even while editing or manually panning, the cursor always stays on screen. As you pan over right the cursor stays at the left edge of the screen. This is the old default behaviour. I suggest always leaving this off.

**No options selected**
During playback the cursor will move past the right edge of the screen and out of site.

Tip: For most users I suggest leaving *Scroll with playback* enabled and the other two options off.

**Track LFOs**

Starting with T7, Tracktion offers a way to modulate plugin parameters without drawing in automation curves. This done using *Track LFOs*. Track LFOs can be assigned to one or more plugin parameters. Track LFOs can also be beat synced to the Edit. Chapter 40 has a full explanation of Track LFOs.

**Clip Layer Effects**

Clip Layer effects are an interesting way to apply common audio manipulations using layers. Clip Layer effects are accessed from the *FX* icon that appears on the header of Audio clips. Learn all about this powerful new feature in Chapter 41 - Clip Layer Effects.
Updated Plugin Racks

The use of Plugin racks is a huge topic and I just don’t have the room to cover that in this book. Instead, I produced a full video series at Groove 3 called Tracktion Plugin Racks Explained\(^{53}\). The series covers all the essentials of creating effects chains as well as using racks to route multi-output virtual instruments to different tracks.

The Groove 3 series was produced before Tracktion T7 was released. While the basic operation remains the same T7 debuted left and right side panels that directly show the routing of the rack to and from channels.

I covered that in the Groove 3 series Tracktion T7 Update Explained\(^{54}\). Those two resources should get you well on your way to understanding how to use racks in your projects.

---

\(^{53}\)https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-Plugin-Racks-Explained

\(^{54}\)https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained?itemid=10016
Mastering with CloudBounce

CloudBounce\(^5\) is an automatic online mastering service that was developed as part of the Abbey Road Red incubator program. It does nice general purpose mastering at a very low price. A single track runs $4.90 USD but low monthly plans are also available.

Tracktion is directly integrated with CloudBounce making it super convenient to get quick masters done without doing it yourself or paying high fees for professional mastering. For many projects it’s all you really need.

To use CloudBounce, first export your Edit in the normal way using *Export > Render to a file*. With the export complete, switch over to the Projects tab and select the exported file from the *Exported Audio/MIDI* list.

![Select the Exported File on the Projects Tab](image)

With the file selected, you see the waveform and other controls in Properties. This is where you find the button *Master With CloudBounce*.

![In Properties, Click Master with CloudBounce](image)

Click *Master With CloudBounce* to upload the exported file to the service.  

\(^5\)[https://www.cloudbounce.com]
File Uploading to CloudBounce

When the upload is complete, CloudBounce immediately runs the file through its machine listening and mastering processors and creates a 45-second preview.
Audition the Mastered File

Click play to listen to the Preview. If you like the results, login or sign up and select a payment option or subscription plan. You can also access options to tweak the processing and then download the finished file.

CloudBounce is fast, effective, and low cost. Would you use it for your most critical projects? Probably not. But if your budget, time, or mastering skills are limited, it might be exactly what you need.

Moving on

This chapter was a summary of new feature that were incorporated in the T7 release of Tracktion. There were hundreds of other changes and tweaks and most of those have been incorporated in to the text of this book as well. The following chapters go into full detail on the major new additions.
Chapter 39 - Visual Plugin Selector

Starting with T7, the Plugin object has a new option. Right-click it to open the Visual Plugin selector. This chapter walks through a full explanation on how to use the Visual Plugin selector.

Using the Visual Plugin Selector

To open the window into the Visual Plugin selector, right-click on the Plugin object. You will see all your plugins represented by thumbnail images along with the name.

Note: If all you see are a lot of question marks, then read on. I will explain how to scan your plugins to capture thumbnails in a bit.
Visual Plugin Selector

From here you can scroll through all your plugins. When you find one you want to use, drag it and the window will close but continue dragging. Now drop it on a track in the normal way.

The Visual Plugin selector window offers just few controls to make finding the right plugin simpler.

1. After opening the Visual Plugin selector, start typing in search characters to filter the list.
2. Adjust the size of the thumbnail images using the slider at the right.
3. If you decide not to pick a plugin, click the X at the upper left or press ESC to close the window.
4. As you drag a plugin, the window will close and you’ll be dragging a transparent image of the plugin which you can drop wherever you want to use it.

**Dragging a Plugin**

**Determining Plugin Technology**

As you over the mouse pointer over a thumbnail, an icon will appear in the upper left corner. This indicates which interface technology is used by that plugin - AU, VST, or VST3. This helps you pick from plugin thumbnails that otherwise look the same.

**Audio Units Icon**

**VST Icon**
These are the same icons used in the Browser Search tab to differentiate the plugin technology.

**Customizing the Thumbnail Image**

Open any plugin in Tracktion and notice the new camera icon in the upper right corner. Click that camera to take a snapshot of the plugin window and update the thumbnail image. If want more interesting thumbnails use this to capture the plugin in action with the meters moving or with an interesting EQ curve.

**Scanning to Capture Thumbnails**

When you first start using Tracktion, the Visual Plugin selector thumbnails appear as blank question marks. When you open a plugin for the first time, Tracktion grabs the thumbnail image. Over time the thumbnails start to fill in.

If you are like me, you want all of them populated with images right away. You can! Locate the Scan for plugin thumbnails options on the Settings tab, Plugins page.
There are three options: You can scan all plugins, scan for new plugins (those without thumbnails), or scan from a selection in the list of installed plugins. When you first start with a new Tracktion installation you probably want to use Scan for all plugins.

Opening Visual Plugin Selector with a Shortcut

There is a new macro action to open the Visual Plugin selector. To use it create a new macro then right-click on the script editor on the Settings tab, Keyboard Shortcuts page. Navigate to Advanced Actions > Plugins > Show or hide the plugin selector page.

That adds the necessary code to the macro.

Assign a keyboard combination that makes sense. In this example, I used Option + F11 / Alt + F11.

Moving On

When I first tried the Visual Plugin selector, I didn’t really see the benefit. However, the more I used it the more I like how fast it is to find the plugins I need. The key for me is to launch it from a
keyboard shortcut then immediately start typing in characters to filter the results.
Chapter 40 - Track LFOs

Track LFOs allow you to quickly provide movement to any automatable plugin parameter. In this chapter, learn how to use the Track LFO feature.

Inserting a Track LFO

Assign a track LFO to a track by dragging the LFO Creator object to the mixer section of any track. You either drag it to the top of the track then assign it to a parameter later or drag it directly to any plugin and choose the parameter to modulate right away.

![Track LFO Creator Object](image)

You can assign as many LFOs to a track as you want. The LFO objects appear above the plugins for the track. The shape of the LFO is indicated on the object and you can choose from several colors in Properties.

![Track LFOs on a Track](image)

Track LFO Properties

To control how a track LFO behaves and looks, select the LFO then adjust the parameters in Properties. Properties also lists what parameters are being modulated.
To choose and LFO shape, select the LFO then click *Wave* in Properties and choose one of the five shapes: Sine, Triangle, Saw Up, Saw Down, or Square. The shape will be represented in Properties and on the thumbnail image on the LFO object.

With the shape selected you can choose how to control the modulation speed by clicking *Sync* and then choosing *Time* or *Beat*. If you choose time adjust the speed by dragging the *Frequency* slider left or right, or double click *Frequency* and type in a value in Hz.

If you choose Beat, then the Beat divisions menu appears. Click it and select one of the musical divisions.
In addition to the speed you can adjust the *Intensity*, *Phase*, and *Offset* using additional parameters. Also of the are useful but I find *Intensity* to be the most essential.

Other Properties

Properties for track LFOs contain several other useful controls. Here is an explanation of what these do:

**Enabled**

*Enabled* turns the LFO on or off. If you want to suspend the operation of the LFO without deleting it, turn *Enabled* off.

**Remap on Tempo Change**

If you choose Beat synced frequency the value is calculated at the time of the selection. If you want to recalculate the value anytime tempo changes, then leave *Remap on Tempo Change* enabled. Normally you will want to leave this on.

**Highlight Controlled Plugins**

With *Highlight Controlled Plugins* enabled it does exactly that. It draws a unique color outline around any plugin that has a parameter tied to the LFO.
Color
Select one of the nine colors to use for the track LFO object. This is useful if you have several of them on the same track.

Tip: The LFO is also used for the highlight color if you have *Highlight Controlled Plugins* enabled.

Learn
Click *Learn* then move any plugin parameter and it will be added to a temporary list. The click the check symbol to confirm the assignments. This is a great way to assign numerous parameters to the same LPO.

Removing LFO Assignments
When you select a track LFO, all assigned parameters are shown in the list at the right side of Properties. To remove any assignment, click the “X” at the right of the assignment in the list.
Track LFO Assignment List

Tip: To remove a track LFO entirely, simply select it then click Delete LFO in Properties.

**Video Tutorial**

TSC published this video tutorial\(^56\) explaining Track LFOs. It shows a few examples of using them with a virtual instrument.

**Moving On**

Track LFOs are a great way to add movement to effects or virtual instruments. They can also be used to add subtle dynamic panning or aggressive tremolo. The best part is that they are super simple to use.

---

\(^{56}\)https://youtu.be/9UVEAJAvFZ0
Chapter 41 - Clip Layer Effects

Clip Layer effects were introduced with T7. They offer quick offline rendering of many common audio processes but arranged as layers. You can add or remove layers at will and the effects are rendered in quickly. You can even rearrange the layers. Effects are applied from the top down through the layers.

I find Clip Layer effects to be most useful for things like applying clip based volume automation, conversion to mono, and normalizing. However, those are just a few example of Clip Layer effects capabilities.

Example Clip Layers

To use Clip Layer effects, click on new FX icon in the header for any Audio clip.
From there, select from any of effects. More details on each of these options follows.
The Clip Layer will appear. As you hover your mouse over it, a set of controls appears to the right. The following diagram illustrates the available options.
Volume - Volume

Adding a volume layer is the Tracktion way to do clip based volume automation. I have started to use this instead of track automation when it comes to automating volume.

When you click the “gear” icon for a volume layer, you will see the Volume & Pan control values in Properties.
Volume Clip Layer Properties

While somewhat useful, you are probably more interested in working with the volume automation curve itself. To do that, click on the volume curve (which initially shows up as a line) and then you have access to the Properties for the that.

Tip: See Chapter 35 for more on editing the automation curve. Everything about editing automation curves for tracks applies to volume Clip Layers as well.

Volume - Fade

Fade-ins and fade-outs are also available as layers. After creating the fade layer, drag the left or right fade handles to create the fade in or fade out.

Tip: Right click a fade handle to set the fade shape.
**Volume - Step**

Add a step volume layer to rhythmically gate the clip.

With the step Clip Layer in place, click the gear icon at the right of the layer and then work with all the Properties to set the step size and divisions. You can then click on the steps to turn them on or for unlimited synced gating options.

**Time/Pitch - Pitch Shift**

Add a pitch shift Clip Layer to get access to an automation curve for pitch. Add points and automate like any other effect to apply anything from simple pitch offsets to dramatic pitch sweeps.

When you select the pitch curve on the clip, Properties gives you access to the normal range of controls for automation curves.
Pitch Curve Properties

**Time/Pitch - Tape Stop/Start (Pitch Fade)**

You probably already know that you can right-click the fade handles on any Audio clip to apply pitch fades. Now you can do the same thing as a Clip Layer effect.

Right-click the fade handle to choose the shape for the curve.
**Time/Pitch - Warp Time**

Before Clip Layers, you had to go to Properties and then to the click the Loop Properties tab... then click *Warp Time* to get going. While that still works, it’s much easier now. Just add a warp time Clip Layer.

The header area of the Clip Layer will appears shaded. Click anywhere in the shaded area to add a warp marker.

Drag a warps points to time stetch audio between warp markers.

If you want to remove a warp marker, right-click and remove it or all markers.
I find this implementation of Warp Time much more convenient, especially if you want to align transients to things happening on other tracks in the Edit. With the old way, you couldn’t really see timing in relation to the rest of the Edit.

**Effects - Plugin Layer**

A plugin Clip Layer allows you to add any plugin including 3rd-party effects to a layer.

You will be prompted to select a plugin as you add the layer. The name of the plugin appears on the Clip Layer at the lower right when the layer is selected.

Here are the key things to know when working with the plugin CLip Layers:

1. Click the gear icon at the right to open the plugin UI. When you tweak parameters, a few second later the change is rendered in.

**Note:** Because of the way rendering works, it is a bit hard to audition changes to plugin parameters. I find plugin Clip Layers are best for applying known presets. If you want to do a lot of real time tweaking, then you will probably be better off to use a Clip effect or normal track plugin.
1. Click the A at the top right to show automation curves. Any exposed automation parameter can be selected which makes its curves visible. Use all your standard automation editing tools to draw in appropriate automation.

**Effects - Reverse Clip Layer**

Using the reverse Clip Layer is really easy. Add the layer and the audio within the clip will now play backwards.

![Reverse Layer](image)

**Mastering - Normalize Layer**

Those in America spell it 'Normalize' but however you spell it, normalize adjusts the gain of audio so that it fills the bit depth. The concept is analogous to zoom-to-fit in image editing software.

To use it, first add Normalize layer.

![Normalize Layer](image)

Then adjust the *Normalize* value to keep peaks where you want. In my voiceover work, many customers request the audio to be normalized to -3db.

![Normalize Property](image)

The normalize Clip Layer makes it much much easier to normalize than in the past where it the feature was buried many clicks deep in Properties.
Mastering - Mono Layer

To convert to mono, the mono Clip Layer is the ticket. It is much more convenient to use this than other approaches in Tracktion.

First add a mono Clip Layer:

The choose one of options for determine how to render to mono from stereo:

Note: Most of the time I select Average of all Channels. This mixes the left and right channels to create a mono version.

Mastering - Phase Invert Layer

The phase invert Clip layer is pretty straightforward. It flips the polarity of the wave.
Moving On

I think you will enjoy exploring and working with Clip Layers. It is really only from experimenting with this new approach that you will understand how it works. There are probably many new editing workflows that have yet to be discovered that leverage the power of Clip Layers.
Appendix A - Video Links

These are links to helpful Tracktion T6 videos. Most of these I created while writing the book. Many are now featured on the Tracktion website, YouTube, or my website. For a complete commercial video series on T7 new features, check out Tracktion T7 Update Explained⁵⁷ from Groove3.com.

⁵⁷https://www.groove3.com/Tracktion-Software-training-video-tutorials/Tracktion-T7-Update-Explained
Creating a Tempo Map

Punch In/Out on the fly

Tracktion Compressor Sidechain

Track Tags

Automation Improvements

Insert Plugin

Creating a Submix

Basic Audio Editing

Warp Time

Pitch Fade

Comp Groups

Merge Selected Clips

Step Clips Overview

Step Clips Velocity/Gate

Step Clips Randomize Each Step

Step Clips Groove

Step Clips Route Channels to Different Synths

Drag to Set the In-marker and Out-marker

Track LFOs Demonstration

Step Processing with Multiple Paths
Appendix B - Interview with Tracktion Creator Julian Storer

In April 2016, I interviewed Julian Storer while writing a feature on Tracktion for Recording Magazine. There wasn’t room in the magazine for the interview, but I thought Tracktioneers would find it interesting. Jules gave me permission to include the interview in this book.

In the transcript below BE is Bill Edstrom and JS is Julian (Jules) Storer.

BE: When you first started working on Tracktion, where you planning on creating a commercial product?

JS: I was certainly hoping to. When I was writing it, I had a job that I found pretty boring, and wanted to launch a product that would earn enough for me to do it full-time!

BE: Were you creating Tracktion for your own music recording and production or was it really meant to fill in a gap in the DAW software market?

JS: Originally, I think I wanted to get myself a DAW because I fancied doing a bit of recording, but quickly found that all the DAWs back then were either completely naff or ridiculously expensive. It felt like I might as well have a shot at building one myself. Of course, once I headed down that path I don’t think I ever really had time to go back and actually use it for much recording myself.

BE: Where did the name Tracktion come from?

JS: Vague recollections of pieces of paper with lists of audio-related words, and trying to pick a decent name that hadn’t already been taken.

A lesson I learned from this was that people don’t really pay attention to what a name actually means. I expected that everyone would immediately see that the name is Tracktion, as in a Track, so nobody could possibly spell it wrong, because hey, you spell it like an audio track, which is what it creates, right? Well apparently not. It seems that people inevitably go for “Traktion” or “Traction”, missing the point completely. Ah well.

BE: How long did you work on Tracktion from the initial idea until it was released as a product?

JS: This is mostly lost in the mists of time, I think, but it was pretty quick - maybe a year at most working part-time on it. I think V1 was just a Windows release, and was fairly minimal in terms of functionality. But still a pretty decent speed.

If someone was attempting to create a competitive DAW today they’d have a huge mountain to climb, even with a team of rock-star coders, simply because users expect such a vast amount of functionality from them now. Tracktion was lucky in terms of timing because when I started, the bar was a lot lower, and we had ten more years to gradually add more features.
BE: In the early days of coding Tracktion were you working alone or did you have other programmers and designers working with you?

JS: Just me doing the coding. A friend (Philip Meehan) helped with some of the initial UI design concepts, drew the logo, recorded the original demo songs, and was a general sanity-checker for the project.

BE: what point did you realize that you could spin off the foundational code as a cross-platform tool for creating other audio applications and plugins?

JS: I had been planning to do this from very early on, as I was working on a few other smaller projects which also shared the same library code. At that point it didn’t really have a name or identity. I think it was at the point where Mackie got involved that I realised I had to actually formalise the dividing line between the product itself and the library code, and that’s when I hurriedly came up with the name “JUCE” for it!

BE: Tracktion doesn’t make any attempt to look or act like traditional recording gear or consoles. Was this a choice or were you approaching digital without a background in mixer/console based production?

JS: A bit of both - I’d never spent time using a traditional mixing desk or old-school DAW, so hadn’t got myself stuck in that mindset. But I’ve always had that common software designer attitude of thinking I knew better, and trying to do things differently. And I’ve always disliked skeuomorphism, even before anyone was using that word! But actually, Tracktion’s not massively different from other DAWs. The main things about it that were novel were the right-to-left signal flow and the use of the properties panel. Apart from that a lot of the way it works is pretty familiar.

BE: Tracktion seems to be influenced by non-linear editing for video. For example, the in-marker and out-marker set using “I” and “O.” Also, there is the idea of a Project being an asset pool while an Edit is an arrangement of those assets. Were you influenced or inspired by NLE video editing perhaps more than other DAW software?

JS: Well actually my first job was for a video NLE company, so I guess I was influenced by that!

BE: Tracktion has an object oriented feel. What I mean is that the UI elements like clips, plugins, inputs, automation curves - just about anything you select reveals properties and actions in the Properties panel. Does this relate to the underlying model of how Tracktion works, or is it more of a UI design concept?

JS: Yes, it is pretty close to the way things are implemented internally! We have objects in the code for things that can be selected, like tracks, clips, etc, and those objects generate the content of their property panels. Interestingly (well, interesting from a software architecture standpoint, anyway) we’re currently rewriting that aspect of the codebase to create more separation between UI properties and the underlying object model, because as the codebase continues to grow, this will make it easier for us to keep developing more complex properties in the future.

BE: Tracktion features tracks that feed directly to mixer channels with a left to right flow - all in the same window. This is really a defining element of Tracktion. To me it seems, that the Tracktion
interface makes way more sense in 2016 when the typical computer screen is large and very wide. Did you ever imagine back in the early days that this configuration was ahead of its time?

JS: To be honest, I’ve always been surprised at how slowly monitor tech has developed. The fact that in 2016 most people are still buying small monitors, and monitors that aren’t high-DPI seems odd to me.

When I started all this back in 2000-ish, monitors tended to be a different shape: they were much more likely to be 4:3 than 16:9, so yes, the fact that since TVs became wide-screen and aspect ratios got wider has lent itself nicely to Tracktion’s layout!

BE: Was the decision to make Tracktion cross-platform part of the initial idea or did that requirement come from Mackie or the users?

JS: I think it was cross-platform pretty early on, before Mackie were involved. At the time, music was one of very few areas where Macs formed a big part of the user-base, and there was a lot of user demand for a Mac version. Luckily OS X was starting to replace OS9 at that time, which was much easier to port it to. I don’t think I’d have wanted to go through the pain of trying to make it run on OS9!

BE: Mackie halted development at T3 for several years I suppose due to their own financial priorities. How was it that you and your partners at TSC got the chance to bring Tracktion back as an independent product? Did you seek it out or did Mackie come to you?

JS: Yes, my impression is that they just decided that they weren’t really a software company.

Personally, I had moved on years ago and had lots of other things to do, so wasn’t seeking it out! Woody’s the person to blame for its resurrection - he had left Mackie but kept in touch with the guys there. He was looking for something interesting to do. I wasn’t there when he raised the idea with them, but I’d imagine beer was involved. Mackie were quite happy to let us take over all the moaning users who hadn’t been supported for a few years! Woody contacted me to ask whether I was interested in getting involved, and I tried to say no, but he’s a good salesman!

BE: From your perspective, why would a musician or recording enthusiast choose Tracktion T7? There are numerous capable options for DAW software available. What is unique or special about the Tracktion DAW?

JS: A big problem with selling a DAW is that people get really comfortable and familiar with what they know, and persuading them to change is incredibly hard. Even people who hate their current DAW often stick with it because of the hassle of changing. I guess that in that way DAWs are a bit like bank accounts or spouses.

Another problem with selling a DAW is that there’s a whole slew of competitors out there, which have all been around for a long time, and they’re all pretty good now. They’re also all incredibly complex and have different (but often subtle) strengths and weaknesses, so it’s hard to come up with a short, catchy slogan that summarizes why a particular one is better.

BE: What’s special about Tracktion?
JS: Well, it’s all the little things. I guess the main buzzword that our fans talk about is “workflow”, which we do think is a strength. Our single-page GUI approach doesn’t seem particularly innovative now that we’re surrounded by mobile apps. Historically, most other DAWs have involved dozens of little floating tool windows, and we’ve always done a good job of managing the information overload that’s all too easy in an app of this complexity.

- End -